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What is Internet? 
Different people define Internet differently. The Internet can be defined as a 
network of tens of thousands of computer networks consisting of over a 
million computer systems. It is a platform where millions of people 
communicate electronically to share ideas and information.  
 
Internet can also be thought of like a rapidly–growing global digital library built 
on a remarkably flexible communication technology. It offers a variety of 
services used to create, browse, access, search, view and communicate 
information on a diverse set of topics. It is a vast collection of information that 
can be searched and retrieved electronically.  The Internet is a network of 
networks, all freely exchanging information. 
 
How is Internet Different from Other Medium? 
The Internet is quite different from the other communication media. People of 
all ages, color, caste, and location can freely share ideas, data, opinion and 
other information available on Internet. 
 
One of the most important facts about the Internet is that anybody can access 
it making it probably the most open network in the world. 
People use the Internet for some of the following things: 

 Education 
 Research 
 Travel 
 Finding People 
 Finding business, products and services 
 Exchanging Messages 

 

One of the remarkable aspects of recent thinking on economic and social management 
is the recognition of the importance  of information as a key resource. The dawn of new 
millennium heralds revolution in Information Technology. IT is going through a paradigm 
shift. Paradigm shift means fundamentally new way of looking at some thing. It brings 
about fundamental challenges in almost every aspect of technology itself.  Such 
fundamental changes demand change in conceptualization and it will have substantial 
impact on society too. Phenomenal growth of Internet has revolutionized the life with its 
vast potential resources and it is not too late to get equipped with Net for your own 
needs. You are a Netizen (Net Citizen), and exist as a citizen of the world thanks to the 
global connectivity that the Net makes possible. You consider everyone as your 
compatriot.  This article gives some information about Internet and its popular tools.  
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History of the Internet 
In 1970’s the US Defense Department introduced a multiple network called 
ARPANET. (ARPA-Advanced Research Project Agency) The projects aimed 
at interconnecting WANs and LANs. The project and the prototype developed 
were known as Internet (internetwork) or network of networks. ARPANET 
became the backbone of the Internet. The ARPA group developed a set of 
network software. This integrated set of software are called Network 
protocols. The two groups of such software used for Internet are called TCP-
Transmission Control Protocol and IP – Internet Protocol respectively. IP 
provides basic communication while TCP provides additional facilities that an 
application needs. 
 
How Internet works? 
Computer networks do not usually dedicate a single wire to each pair of 
communicating computers. Instead, the network system arranges for multiple 
computers to share the underlying hardware facilities. In the similar way, 
various computers connected to the Internet share a single transmission path 
to reduce the cost. Sharing introduces delay.  It may cause other systems to 
wait for a long period of time when one has to transmit a long message. One 
solution to reduce the delay is to use multi-channel on a single wire using 
multiplexing. 
 
Internet uses “packet switching” to reduce the delay by sharing the line.  A 
long message is split up in to smaller groups called ‘packets’. The amount of 
data computer can transfer on each turn is limited by the packet size.  Hence 
no computer will hold the line for a long period. 
 
Each packet is labeled with the address of the sending and receiving stations. 
These are added at the beginning of each packet and is called ‘header’. 
 
A packet transmission is so fast that a user feels that the message is 
transmitted continuously. 
 
Internet Services 
i) Electronic Mail ( e-mail) 
 

It lets users communicate with other people electronically on the 
Internet. Electronic mail can be used to: 

 
• Send a message to either one recipient or multiple recipients 
• Send a message that includes text, graphics, images, voice or 

video.  
 

On most of the computers, when an incoming e-mail message arrives, 
e-mail software informs the recipient about the same as soon as the 
user logs in. 
 

ii) Usenet news or Net news: 
Provides the facility to exchange news among an interested group. It 
uses newsreader software to read and post messages. 
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iii) Telnet: 

Helps you to connect your terminal to a remote system and run your 
program in the remote system.  

 
iv) Anonymous FTP: 

Provides the facility to transfer files to your system from remote 
systems wherever such free transfer of file is permitted.  
 

v) Archie: 
Provides the side addresses of millions of files available to any one on 
the Internet using the service anonymous FTP 
 

vi) WAIS (Wide Area Information Server): 
Helps to search and retrieve tens form database stored anywhere on 
the Internet.  Search is made using one or more keywords. 
 

vii) Gopher: 
A popular software for maneuvering through the Internet.  Using 
appropriate menu you can get any information you want from the 
Internet.  
 

viii) WWW: World Wide Web: 
A hypertext Internet service developed at CERN in Switzerland. It is a 
uniform means of accessing different types of information on the 
Internet. WWW provides hypertext multimedia information retrieval 
system. It is emerging as another powerful content-oriented search and 
information retrieval mechanism. 

 
Ways to get Internet connection 
There are three different ways to get Internet connection: 
 
1. Dial-up connection using a modem and dialing up to some Internet Service 

Provider’s (ISP’s) computer via telephone lines. Your computer acts only 
as a terminal to a system, which is connected to the Internet. Under this 
dial-up connection, two types of Internet accounts are provided:  
- Shell Account (only text based services are available) Now it is rarely 

used 
- TCP/IP Account (Full Internet Connectivity).  
 

2. Using leased or dedicated line connection with a computer connected to 
the Internet. Your personal computer can be networked to the host 
computer through the modem. There are two software available to connect 
your personal computer to the Internet as a host machine through modem 
– SLIP (Serial Line Interface Protocol) and PPP (Point-to-point protocol). 
With SLIP or PPP your system can access all the facilities including 
graphical information. 
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3. VSAT connection using a satellite connection to some Internet machine: 
The system will be connected as a host to the Internet (TCP/IP 
connection).  All the Internet facilities ties are available. 

 
Indian ISP’s 
1. National Informatics Centre 

a. NICNET – used mainly for official communications between the state 
and central governments.  

b. REN – A Network of Indian Educational and Research 
Institutions/Organizations 

2. ERNET - Department of Electronics (DOE) maintains ERNET (Educational 
and Research Network).  

 
Both NIC and ERNET are Internet Access Providers providing connection to 
non-commercial organizations.  
 
3. VSNL (Videsh Sanchar Nigam Ltd.) maintains a backbone network called 

VSNLNET.  This was the only agency offering Internet Access for public in 
India till recently.  
VSNL provides three types of connections  
- Shell Account (Text based dial-up connection) 
- TCP/IP Account (dial-up and/or leased line connection) 
- ISDN dial-up access 

4. Many private agencies were also given permission to provide Internet 
Access to the public.  In Calicut, Satyam Online and ETH Dishnet are two 
such agencies apart from VSNL and BSNL to provide internet Connection.  

 
More About WWW 
The World Wide Web may well be the most democratic mass medium ever 
created; in that Web users can create as well as consume contents.  
 
The Web is a fastest growing system in human history. It's loaded with useful 
information. And, it's fun. Academics, in their professorial way, call it a global 
hypermedia system. For, you and me, it's an incredibly fun way that you can 
jump from one Internet computer to the next, just by clicking an underlined 
word or phrase called a hyperlink.  The Web is entertaining, useful, fun and 
increasingly indispensable. 
 
The WWW or Web, as it is more frequently referred to as, is a collection of 
‘pages’ of information connected to each other. Each page can be a 
combination of text, pictures, audio clips, video clips, animations and other 
stuff. What makes web pages interesting is that they contain links (actually 
called hyperlinks) to other web pages and when user selects/clicks on any link 
the Internet access software fetches the page the link points to. Each page 
the software fetches may have more links too. 
 
This system of inter-linked documents is known as hypertext.  Figure below 
shows a Web Page: 
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Each underlined phrase is a link (hyperlink) to another Web page. Hypertext is 
a way of connecting information in ways that makes it easy to find.  
 
Browsing/Surfing the Internet 
In order to find information on the Internet, one needs a browser, the software 
that goes and gets Web pages and displays them on the computer screen. A 
browser decodes the hidden symbols in Web documents, turning them into 
richly formatted documents replete with fonts and graphics. In addition, 
browser also originates messages that locate and retrieve documents every 
time you click a hyperlink. Microsoft Internet Explorer and Netscape Navigator 
are two very popular browsers. 
 
Microsoft Internet Explorer 4.0 comes bundled with WINDOWS 98 software 
and Netscape Navigator is a shareware available on CDs coming with various 
computer/IT magazines or can be downloaded from the Internet itself 
provided you have access to any other browser. 
 
Microsoft Internet Explorer can be downloaded from http://www.microsoft.com 
and Netscape Navigator can be downloaded from http://www.netscape.com 
sites. 
 
Surfing with Netscape Navigator 
As described above there are many browsers that can be used for surfing the 
Internet. I have, however, selected Netscape Navigator as our browser for the 
discussions to follow. 

 
Starting Netscape Navigator: 
You can use the Start button available on the Task Bar of Windows 95/98 to 
start any program. Similarly, to start Netscape Navigator: 
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1. Click the Start button. 
2. Point to Programs.  
3. Point to Netscape Communicator.  
4. Point to Netscape Navigator and click to start Netscape browser. 
 
A window similar to the following opens: 

 
 
When Netscape Navigator starts, you see the program's window. The 
program icon (the big N) displays animation, informing you that Netscape is 
downloading information. In about a minute, you will see the default start 
page, the page that appears when you start Netscape or click the Home 
button. 
 
Netscape Navigator's program window has following parts: 
 
Title bar: 
At the top of Netscape's window is the title bar, a standard Windows feature. 
Here, Netscape displays the title of the page you are currently viewing in 
addition to its own name. 
 
 
 
 

Title Bar 

Menu Bar 

Toolbar 

Status Bar 

Status 
Indicator 

Location 

Progress Bar 
Mail Icon 

Bookmarks 

Application 
Workspace 
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Menu Bar: 
Below the title bar is the menu bar. On the menu bar, you will find the titles of 
Netscape's menus, from which you can choose additional options. This 
contains menus such as File, Edit, View, Go, Communicator and Help. 
 
Tool Bar: 
The Toolbar contains buttons or tools that enable easy access to frequently 
used Netscape commands. Following are some important buttons: 
 
Back: Go back to the previous document in the history, which you 

have just visited. 
 
Forward: Return to the document you went back from or move forward to 

next document in the history. 
 
Reload: Retrieve the currently displayed document again. 
 
Home:  Go to the default home page. 
 
Print:  Print the document that Netscape is currently displaying. 
 
Stop:  Stop downloading the current document. 
 
Bookmarks: 
A bookmark is a saved document address that enables you to return to this 
document quickly, just by choosing it from the Bookmarks menu. 
 
Location: 
This box indicates the Web address (the URL) of the document you are 
currently viewing. An example of an URL is http://www.netscape.com. The 
first thing in a URL, the word before the colon (:), is the scheme, which 
describes the waya browser can get to the resource. The most common by far 
is http, the Hyper Text  Transmission Protocol that is the Web’s native transfer 
technique. Following the colon are two forward slashes and the name of the 
host computer on which the resource lives, in above example, netscape.com.  
 
Status Indicator: 
The big 'N' lets you know when Netscape is downloading a document from the 
Web-it plays an animation. When the document is finished downloading, you 
see 'Document Done' on the status bar at the bottom of the screen. 
 
Application Workspace: 
Here, Netscape displays the document you are currently viewing. You will see 
text, hyperlinks and in-line-images (graphics that appear along with the text). 
 
Status Bar and Progress Bar: 
Netscape uses the status bar to display messages about what the program is 
doing. Next to the status bar is a blank panel called the progress bar. When 
Netscape retrieves a document from the Internet, you will see a graphical 
display indicating how much of the document has been obtained. 
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Mail Icon: 
If Netscape is set up to read Internet mail, you will know when there is mail 
waiting for you: you will see a little envelope followed by an exclamation point 
on the status bar. To open a mail window, just double click this mail icon. 
 
Browsing/Going Places Using Netscape 
To visit any Web page you require to know its Address or (URL). Once you 
know the URL of the Web page you want to visit to, click in the Location box 
of the Netscape browser. Type the URL in the box (when you type a Web 
address into this box directly, it changes its name to Go To). Press Enter 
 
Following paragraphs briefly describe the procedure for performing some of 
the frequently needed tasks: 
 
View Pages within the Page 
Click highlighted words (coloured or underlined) in a page to bring another 
page of related information to your screen.  Click Back and Forward toolbar 
buttons to go back (or forward) to a page you have previously seen.  
 
To open URLs you have previously typed in and visited 
Choose an item from the location field pop-up menu. To display this pop-up 
menu, click the pop-up menu arrow located to the right of the location field. 
 
Bookmark 
To Bookmark the current page for easy access in future, click on  Bookmark 
button in the location toolbar display pages and click on Add Bookmark.  
 
Open a new Navigator window 
To open a new Navigator window click on the File menu, click on New, then 
Navigator Window.  The new window displays another copy of your home 
page on the screen in a fully functional and independent Navigator window.  
 
Opening Mail Box Window 
Click the Mailbox icon (the second icon from the left in the component bar) to 
display the mail Inbox folder and retrieve new messages.  
 
Composing New Mail 
To open window for composing new mail click on the File menu, click on New, 
and then click on Message. 
 
Searching and Finding 
Navigator software offers two distinct tools to help you locate information: 
Internet "search" tools and page "find" tools.  A search tool helps you locate 
information such as web pages and discussion group messages that resides 
on the Internet network.  A find tool locates particular words or phrases within 
the page that you're currently viewing.  
 
To search for information over the Internet click the Search button on the 
toolbar. This displays a page offering access to Internet search engines and 
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other search services. Follow the instructions on the search engine site. 
Typically, you'll type in search text, click a button, and then wait for the engine 
to locate occurrences of the text among a database of web pages.  
 
To find information in the current page, open the Edit menu and choose Find 
in Page. In the resulting dialog, type the text you want to find, then click Find 
Next. Located text is highlighted and, if necessary, the page scrolls to the 
text's position.  Click the Edit menu's Find Again item to search for more 
occurrences.  
 
Opening a HTML Page available on Local PC 
To view a HTML page available in the hard disk of the client PC, choose 
Open Page from the File menu. In the resulting dialog box, type the file name 
and its location or select a file using the Choose File button, if location of file 
not known. Click Open to display the page.  
 
Stop a page transfer in progress 
To stop a page transfer in progress, click the Stop button. Alternately, you can 
stop a link's action by choosing Stop Loading from the Go menu.  
 
Display the home page 
To display the default home page, click the Home button. The URL of your 
home page is designated in your preferences.  
 
Viewing Images 
To turn off automatic image loading, from the Edit menu, choose Preferences. 
Select the Advanced category. Deselect the Automatically load  images item. 
When this checkbox is 
unselected, the images in pages are replaced by small icons.  
 
Selecting a Home Page 
You can designate your own home page (the page Navigator first brings to 
the screen each time you open a new window) by supplying a URL as a 
preference panel item. The default home page, the page that Navigator is 
initially set to display, has this URL: http://home.netscape.com/index.html. (If 
you omit the pathname index.html, the file still loads by default). To change 
your home page, open the Edit menu and choose   Preferences. Select the 
Navigator category. Click the radio button Home page.  In the Location field, 
type the URL of the new home page you want. Alternatively, you can select 
the radio button Blank page if you want the home page to be empty of 
content.  
  
Saving a Page 
To save the contents of the current page in a file, click on File, click on Save 
As or Save Frame and type a valid file name in the Save Window and click on 
OK. 
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Save an Image 
To save an Image displayed in the current page, click the right-mouse button 
inside the image to display the pop-up menu. Choose Save Image As and 
type a name of the file in the Save As dialogue box. 
 
Close Current Navigator window 
To close current Navigator window click on File, click on Close. This closes 
the current Navigator window. 
 
Printing Internet Pages 
To print the contents of the current page from the File menu, choose Print, or 
click the Print button in the toolbar. A dialog box lets you select printing 
options and begin printing. On Windows, you can choose Print Preview from 
the File menu to see a screen display of a printed page.  
 
To print a frame 
When you view a page containing frames, in the File menu you'll see Print 
Frame in place of Print. The command lets you print only the page within a 
currently selected frame. The dialog box options for printing the page are 
unchanged.  
 
Page Layout 
When printing a page, Navigator formats content according to the size of the 
printed page rather than the size of the onscreen window. The Print command 
rearranges the page layout (text is word-wrapped and graphics are 
repositioned) in order to accommodate paper size.  
 
To set up the page for printing from the File menu, choose Page Setup. You 
can use this command to choose page layout options including header and 
footer information. 
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EMAIL 
  
Electronic mail is the fastest and cheapest way of communication today. Any 
type of files can be send to anybody through email. Computer networks are 
used to transmit electronic mails. Now people use the internet to send and 
receive emails. Following is a very brief discussion about the working of 
emails.                                                          
 
How Does E-Mail Reach its Destination? 
Let us assume that you are at home, writing an electronic mail message to 
your uncle, who works on the other side of the world.  You know that once you 
send your mail, it will somehow make itself to you uncle's computer.  How 
exactly does this happen? 
     
Step 1: Sending (uploading) mail 
To connect to the Internet, you must have an account with an Internet Service 
Provider (ISP), a company that connects people to the Internet.  Connection 
from your computer to the ISP's computers will probably be made through the 
phone, using a device called a modem.  The modem enables your computer 
to transmit digital data over the phone lines, which are analog. The data 
passed between the two computers is decoded using computer protocols.  In 
this case, various modem specific protocols (such as X.25) are used, as well 
as protocols from the Internet protocol suite (such as PPP and SLIP).  Your 
mail program sends your mail through the use of yet another protocol - the 
Simple Mail Transfer Protocol (SMTP). 
 
Step 2: At the ISP's 
The ISP's modem converts data from the phone line back to digital pulses, 
and it server interprets the information.  The server figures out the nature of 
your data, by decoding the SLIP/PPP data (in this case, the data is your e-
mail).   The ISP has a local area network (LAN) (or specifically, an Ethernet 
LAN).  The LAN connects computers in the ISP's office space.  Once the data 
is interpreted, the server’s first role is to figure out if the data you had just sent 
is destined for a computer in the ISP's LAN. Data not destined for a computer 
connected to the ISP's LAN, is forwarded to the Wide Area Network (WAN) - 
the Internet.  For security reasons, the ISP had installed a firewall, a device 
that keeps unwanted people from tampering with data on it LAN.  The firewall 
job is to receive all data going to/from the Internet, and filtering out it "bad" 
part.  
 
Step 3: The WAN 
Wide Area Network (WAN) is a general term that refers to a network that 
exceeds local boundaries.  A WAN usually includes many LANs in it, which 
together form a huge network.  The world's most famous WAN is the Internet. 
 
Step 4: At your uncle's office 
Your uncle's office has a local area network that's connected directly to the 
internet through a router.  A router is a device that serves as a kind of 
electronic "yellow-pages" of computers. Every computer on the internet has 
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an "address", and routers are the devices that know how to get data to each 
computer using this address.  
 
Email and your Browser 
As discussed earlier, email is a means of sending messages from one person 
to another using the Internet as the transmission mechanism, much like using 
the postal service as your carrier. 
 
How many times have you been surfing a web site and wanted to contact the 
author or webmaster and the only way to do so was via an email address? If 
you are like most people, your answer would be "Very often". So what do you 
do? You grab a piece of paper and write down the email address. Then you 
switch to your email program, enter the address, write your email and send it, 
then you return to your browser. Tedious to say the least.  
 
This chapter will cover setting up Navigator and Explorer for email and 
newsgroups. In order to provide a clear distinction between the two browsers, 
we have separate sections for each of the browsers.  
 
Email Addressing 
Like real mail, sending email requires that you know the address of the 
individual or company you wish to send email to. Unlike real mail, an email 
address is fairly simple, composed of only two parts. The first part of the email 
address is the user's account name that you are sending the email to. Some 
ISPs will allow the user to pick a user name, others will follow a set pattern, 
like the first name followed by the first letter of their last name, or perhaps 
even a number.  

eg.  ravi 
 ravi001 
 ravi_s 
 

You also need to know the name of the server. In Ravi's case he logs into the 
Internet via a server called yahoo.com. Since we can't just merge the two 
pieces together, we need something to keep them apart, we use the "@" 
character to separate the user name from the server name. Hence Ravi's 
address now becomes one of these;  

ravi@yahoo.com 
ravi001@yahoo.com   

      ravi_s@yahoo.com 
 

Server names can be longer and more complex but basically it's safe to say 
that anything to the right of the "at" sign is the server name and everything to 
the left is the user name.  
 
Setting up your browser for email 
Before you begin setting up your browser to handle email, there are certain 
questions which only you and your Internet Service Provider (ISP) must 
answer. You must have this information on hand before you begin, so talk to 
your ISP. The information you need is; 

 Your Email Directory.*  
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 Your News Directory. *  
 Your Email Address. *  
 Your POP User name.**  
 Your Outgoing Mail (SMTP) Server Name. **  
 Your Incoming Mail (POP) Server Name. **  
 Your News (NNTP) Server Name.** 
 
*You supply this information 
** Your ISP must supply this information 
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Search Engines 
 
These are softwares that help us to find our way around the billion or more 
pages that make up the Web. It is a service that indexes, organizes, and often 
rates and reviews web sites. There are significant differences in how search 
engines build their databases and rank sites.  Some rely on people to 
maintain a catalog of web sites or pages. They are called General Topical 
Search Engines.  Some use software called a spider or crawler to identify key 
information on sites across the Internet. They are known as Keyword Search 
Engines.  Some others combine both types of services. 

 
These differences make some search engines far more useful than others for 
searching science and technology websites.  Key features to look at in a web 
search engines database building and indexing strategies are free URL 
submission, full-text indexing, automated, comprehensive web crawling, a fast 
‘refresh’ rate and a sensible ranking strategy for results.   
 
AltaVista: You can search for keywords or type your query in the form of a 
question. Other features include a facility to translate sites in several 
languages; photo and media finder which searches for images; and family filter 
which helps you to limit the types of results produced by the search. 
 
Lycos: It is a search engine with a directory, organized by subject. 
 
Google: Google is one of the best search engines, which is extremely 
comprehensive.  Pages are ranked based on how many times they are linked 
from other pages.  Google catches copies of web pages, so pages can be 
accessible even if the server is offline.  It returns only pages that contain all the 
relevant search terms. 
 
HotBot: For a new user HotBot is probably the best search engine.  It is also 
relatively comprehensive, regularly updated and offers form-based query tools.   
 
Excite: A hybrid search engine. It has the traditional search capacity because 
of using a software program but also has a directory. 
 
Yahoo: This is actually a directory rather than a search engine, meaning 
human compile and categorize the sites it searches. 
 
If you are looking for a broad, common topic use a search engine that tends to 
give you fewer results of higher quality 9usually the type that relies on people 
to catalog sites) eg. Yahoo. 
 
If you are looking for a rare topic a site that may be less discriminating but 
yields more results (usually the type compiled by a software program) eg. 
Excite, Google. 
 
As scientists we should know how to structure a query to weed out the majority 
of the junk that will come up in a search.  Each search engine makes different 
default assumption when we enter a few keywords into its little box.  If your 
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first search doesn’t produce the results you want, try searching with at least 
one more search engine. Many search engines have a link that leads to 
detailed information about how it compiles and searches through information, 
and how to get the best results from it. Reading this page can save you a lot of 
time. 
 
Effective searching is done when most of the planning, analyzing and keyword 
refining is done away from the computer. In order to find information 
effectively, you should plan your search by creating word webs or concept 
maps or idea maps on the topic. Combine these concepts or ideas depending 
on the kind of search engine that you will be using. Include distinctive names, 
acronyms, and abbreviations within your strategies. Include synonyms and 
variant spellings within your strategies. 
 
Topical Search 
With this kind of search, you begin with a broad topic, then you narrow it down. 
Eg. Science-Biology-Molecular Biology. This search is used with topical search 
engines such as Yahoo.   
 
Keyword Search (boolean searching) 
In order to search effectively, you need to use Boolean logic, which is an 
extremely simple way of stating how a group of things should be divided or 
combined into sets.  Boolean queries restrict the results that are returned from 
a database by joining a series of search terms with the operators AND, OR 
and NOT; and mathematical signs + or -. The word and and the sign + will 
connect your concepts together by requiring that both of these words appear in 
the results.  The word or will allow either word to appear in the results.  The 
words and not and the minus sign (-) will exclude words to appear in the 
results.  The word adj means “adjacent” and will generate results showing 
where those two words are next to each other in any order.  The word near will 
generate results showing where those two words are close to each other.  
Quotation marks will generate results showing those web pages that show the 
exact phrasing contained within the quotation marks.  If you want to broaden 
your search or you are unsure of the spelling for a particular word, many 
search engines will allow by suffixing the word with signs like *, ? and $.   
 
Joining two keywords with AND finds documents that contain only keyword 1 
and keyword 2; using OR finds documents that contain either keyword 1 or 
keyword 2 (or both); and using NOT finds documents that contain keyword 1 
but not keyword 2.  However, search engines differ in how they interpret a 
space or an implied operator.  Some consider a space an OR, while others 
defaults to AND.  Therefore, find out how the search engine you are using 
works before you formulate your query.   
 
Boolean queries are read from left to right, just like text.  Parentheses can 
structure more complex boolean queries.  If you look for documents that 
contain keyword 1 and one of either keyword 2 or keyword 3, but not keyword 
4, the query should be like : (keyword 1 AND (keyword 2 OR keyword 3)) NOT 
keyword 4.  By using quotation marks you can specify a phrase in many 
search engines.   
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INTERNET RESOURCES IN BIOLOGICAL AND AGRICULTURAL SCIENCES 
 

M.G. Sreekumar 

Indian Institute of Management, 
Calicut 
 

Introduction 
 
The explosive growth of the Internet and the World Wide Web (WWW) in 
recent years have its impacts on almost every field of human activity, and 
Biological Sciences is no exception. The secret to understanding the Internet 
is that it is populated by two types of computer programs: servers and clients. 
Servers are programs that provide resources and Clients are programs that 
we use to access these resources. E-Mail, LISTSERV/Mail lists, 
USENET/Newsgroups, FTP, Telnet, Gopher, Archie, WWW (World Wide 
Web) etc., are among the prominent services of the Internet.  Each type of 
service in the Internet has its own client. For example, to access the WWW, 
we need to use a Web client such as "Netscape" or "Internet Explorer".  As 
already mentioned, Internet is a collection of networks covering the world. 
These networks contain many different types of computers and there should 
be a tool to hold the whole thing together and that is "TCP/IP", which stands 
for Transmission Control Protocol/Internet Protocol. A protocol is a set of rules 
describing, in technical terms, how something should be done. TCP/IP is the 
common name for a collection of more than 100 protocols used to connect 
computers and networks. 
 
The WWW is almost synonymous with the Net. It is a large system of servers 
which offers all kinds of information on the Net. The information can be in the 
form of regular text, as well as pictures, sounds, video clips, and other types 
of data. Invented in early 1990s by physicists under the leadership of Tim 
Berners-Lee, at the European Particle Physics Laboratory (CERN), 
Switzerland, the Web has rapidly become the Graphical User Interface (GUI) 
of the Net. In fact, the Web is just one Internet application, a way of using the 
vast interconnected network and view information from around the world. The 
main use of the Web is for information retrieval, whereby multi-media 
documents are copied over the Net for local viewing. It uses a protocol called 
HTTP (Hypertext Transfer Protocol). The Web is in fact a multi-media 
hypertext - any sort of digital data can be distributed inside a Web document, 
and each document contains links to other documents, as shown by 
highlighted or underlined text. Simply click on the word or the highlighted area 
(where the palm appears) and we can travel to the document in question. 
Web documents are written using a markup language called Hypertext 
Markup Language (HTML). HTML is independent of platforms. So it does not 
matter if you are using a Macintosh, a PC or a Sun workstation to access 
them. The Massachusetts Institute of Technology's  (MIT) World Wide Web 
Consortium (W3C) is the international standardising agency for HTML and 
HTML 4.0 is the latest standard. HTML has tags for providing references to 
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other Web pages, which can be on the same server or any other server on the 
Net irrespective of the geographical location. This facilitates hypertext links 
across the documents on the Net. Web pages can contain references of 
images (GIF and JPEG formats), audio files (AU and WAV formats) and video 
files (MPEG format) which thus adds the multi-media dimension to the 
information provided on the Web. The clients or browsers access the Web 
pages on the servers, renders and formats them according to the HTML tags 
to display on the client's system. When the user selects a hypertext link 
(indicated by an underscore) on a Web page, client can follow the link and 
fetch the referred document irrespective of the location of the document on 
the Net. Every Web document has a unique address, called the Uniform 
Resource Locator (URL). It is a simple way of describing almost any 
information resource, using a standard format for locating information on the 
Net as :  
 
<protocol>://<host.domain>:<port>/<protocol-specific> 
  
It is an Internet address which is unique to that resource. It consists of a protocol, a host 
name, a port (optional), a directory and a file name. That is, the URL consists of the computer 
on which the document is stored and a file name. For example, the URL of the Indian Institute 
of Management at Kozhikode, is:  "http://www.iimk.ac.in". Please note the file name is missing 
in the example, as it refers to the home page.   
 
The key to the Web is a browser program, which is used to retrieve and display Web 
documents. The browser (HTML viewer) is an Internet compatible program that runs on our 
local computer, whether it is a Macintosh, IBM PC, UNIX Workstation, and does three things 
for the Web documents : 1. it uses the Internet to retrieve documents from other computers, 
called servers; 2. it displays these documents on our screen, using the formatting specified in 
the document; and 3. it makes the displayed documents active, so that pointing and clicking 
on a cross-referenced item in a document will take us to the reference. There are two popular 
Web browsers, viz., the Navigator of Netscape and the Internet Explorer, from Microsoft . 
However, Netscape has become the de facto standard for browsers.  
 
Internet Information Infrastructure ( III ) 
Look closer, the Internet has three major tasks in the handling of information. There is no 
second opinion, it is pro publishing and it is a content publisher. It acts as a content holder 
too. The Internet presents itself as the most logical repository for content because the Internet 
is accessible to applications, laptop and desktop computers, Internet appliances, cellular 
telephones, and personal digital assistants. Fortunately, the Internet can provide the 
information infrastructure necessary to provide secure, collaborative communication and 
access. Hence it also acts as a content communicator, with its hosts of protocols and 
standards.  
 
The Internet Information Infrastructure can replace the basic functionality of a corporate 
extranet - minus an extranet's management cost and complexity. The Internet has become 
more than merely a platform for intercommunicating - the Internet with a set of federated 
services is the computer. The Internet Information Infrastructure provides the federated 
service set. With user devices acting as I3 nodes, the "Internet-computer" connects users and 
applications, replacing the extranet. On a global perspective, the Unicode could play 
wonderful role in taking the fruits of technology across platforms and languages. The 
emerging metadata standards and systems are again rays of hope towards resource 
discovery in the Net.    
 
Unicode is a lingua franca that enables a single software product or a single Website to be 
targeted across multiple platforms, languages, and countries without re-engineering, and for 
data to be transported through many different systems without corruption. Data processing 
industry leaders have adopted the Unicode standard. Unicode is required by modern 
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standards such as XML and Java, and is supported in many operating systems and all 
modern browsers. Incorporating Unicode into client/server or multi-tiered applications and 
Web sites offers significant cost savings over the use of legacy character sets. The Unicode 
Consortium operates with the International Standards Organization (ISO). 
 
Metadata - that is, data about data - is information that describes content. Metadata works like 
a card catalog in a library, an entry in a book catalog, or the information in an online index. 
Metadata allows a user or application program to identify precisely what it is that the 
associated data represents and show the relationships among different pieces of content, 
even accommodating changing relationships. The best metadata system would be extensible, 
so that metadata types that can be anticipated easily - e.g., author, version, size - can be 
defined as files are uploaded; moreover, new types of metadata can be added after file 
creation, as needs dictate. The W3C's (World Wide Web Consortium) DCMI (Dublin Core 
Metadata Initiative) is a major development in this front.  
 

Biological Literature 
Finding the vast amounts of biological data related to the management, study, and use of 
biological resources cached in hundreds of databases around the world is difficult at best. 
Mostly a major part of this information sits unused because of a lack of efficient means to 
retrieve and derive comprehensible information from it. A solution is in the midst of 
development: The National Biological Information Infrastructure, an initiative of the US 
Geological Survey's Biological Resources Division (BRD), will eventually allow researchers, 
land and natural resource managers, students, and the general public to locate these 
databases, query multiple databases simultaneously, and retrieve data.  
 
When NBII is completed, users will be able to draw from any number of databases to assess 
biological and environmental processes and conditions. NBII will also provide software to help 
users analyze these data. A "distributed electronic federation," NBII, in its current form 
(www.nbii.gov/index.html), has two components. The first is a set of links to a variety of 
government and nongovernment sites. Most of these sites do not provide direct access to 
biological information but instead direct the user to potential sources of information. 
 
The second component is a "metadata clearinghouse," in which research products such as 
databases, published papers, and technical reports are cataloged using a standard set of 
descriptors known as "metadata". These metadata describe the subject matter, taxonomic 
subject, time span and spatial limits of the research, how the data were collected, who 
collected the data, and where the research product can be found on the Internet or 
elsewhere. In essence, the clearinghouse is an electronic card catalogue that allows users to 
find information across a wide variety of sources. 
 
The Association of Systematic Collections (ASC) and the United States Geological Survey, 
Biological Resources Division (USGS-BRD), established a cooperative agreement to develop 
two resource databases. The databases were developed to support the National Biological 
Information Infrastructure (NBII), the electronic gateway to biological data and information, 
and the Integrated Taxonomic Information System (ITIS), a partnership dedicated to provide 
an on-line, scientifically credible list of biological names.  
 
The Taxonomic Resources and Expertise Database (TRED) lists taxonomic experts for North 
America, north of Mexico, with their taxonomic, geographic, and habitat expertise, along with 
address and related information. The second database, the Directory of Research Systematic 
Collections (DRSC) was developed via the Survey of Research Systematic Collections 
(SRSC). This database serves as a directory of research natural history collections and their 
databases. 
 
Bioinformatics 
Bioinformatics harnesses the power of computational and information technologies to 
organize and analyze biological data from research collections, experiments, remote sensing, 
modeling, database searches and instrumentation – and deliver them to users throughout the 
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world. Today, the Internet and World Wide Web are powerful tools for linking and utilizing the 
extraordinary assets of natural history and research institutions. In India, under the 
DBT, Bioinformatics Centres located in different parts of the country are 
catering to the needs of thousands of scientists in meeting their ever 
increasing information and computational needs.   
 
BIOSIS 
BIOSIS, established in 1926, is a not-for-profit organization whose mission is 
to foster the growth, communication and use of biological knowledge for the 
common good. By accumulating the world's largest collection of abstracts and 
bibliographic references to worldwide biological and medical literature and 
organizing this information for easy access, BIOSIS provides vital sources of 
information for life scientists.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
BIOSIS processes approximately 550,000 items each year, from primary research and review 
journals, books, monographs, and conference proceedings. The BIOSIS  
 
information system, a pool of material totaling over 13 million citations at the end of 1999, is 
available in several formats. These include Biological Abstracts® (BA), the  
leading reference database for life science information and Biological  
 
Abstracts/RRM®  
(Reports, Reviews, Meetings) (BA/RRM), the companion reference to Biological Abstracts. 
BIOSIS also publishes Zoological Record, supplying a comprehensive  
 
collection of references to zoological research articles worldwide, for which it processes an 
additional 72,000 items each year. The Zoological Record database includes approximately 
1.3 million records from 1978 to the present. BIOSIS' print products are also available in CD-
ROM and Web formats, along with BIOSIS Previews® on CD-ROM and Web. In addition to 
print, compact disc, and Web formats, BIOSIS' extensive database of citations can be 
accessed via an online service. Online products consist of BIOSIS Previews®, Zoological 
Record Online®, BasicBIOSIS®, and TOXLINE.  
 
Biological Abstracts (BA) 
The Biological Abstracts is the Key to the World’s Life Sciences Journals. 
Comprehensive coverage and context-sensitive indexing make the 
information in BA essential for all life sciences researchers. BA directs users 
to information on life science topics from botany to microbiology to 
pharmacology, serving to connect researchers with critical journal coverage. 
Whether the topic of study is botany, pharmacology, biochemistry, or 
evolutionary ecology, BA has the journal articles that one's research depends 
on. Total Journal Coverage BA indexes articles from over 4,000 serials each 
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year. This publication also offers Over 360,000 new citations each year, 
Nearly 90% of citations include an abstract by the author, and almost 5.8 
million archival records are available back to 1980. BA articles originate from 
journals all around the world, and cover topics in every life sciences discipline. 
If the information you need lies in the life sciences, BA should be part of your 
information solution. Plus, BIOSIS indexing, MESH® disease terminology, 
and CAS Registry Numbers® all help electronic BA users find the most 
relevant records efficiently. Subscribers can access BA on CD, through the 
Web, or in print. Electronic versions of BA are updated quarterly. Print 
versions are issued twice each month. 
 
AGRIS 

AGRIS, the international information system for the agricultural sciences and 
technology, was created by the Food and Agriculture Organization of the 
United Nations (FAO) in 1974, to facilitate information exchange and to 
identify world literature dealing with all aspects of agriculture.  AGRIS is a 
cooperative system in which participating countries input references to the 
literature produced within their boundaries and, in return, draw on the 
information provided by the other participants. 199 national, international and 
intergovernmental centres participate and submit about 14.000 items per 
month. The system collects bibliographic references (to date, about 3 million) 
to either conventional (journal articles, books) or non-conventional materials 
(sometimes called "grey literature" e.g. theses, reports, etc.), not available 
through ordinary commercial channels. One of the main reasons for AGRIS' 
existence is to encourage the exchange of information among developing 
countries, whose literature would not be covered by other international 
systems.  The AGRIS database is now on line at this site, as well as 
AGROVOC, the Multilingual Agricultural Thesaurus, which is directly 
accessible at "http://www.fao.org/agrovoc" Coming under WAICENT's 
"umbrella mechanism" will bring numerous advantages to participating 
countries such as a.) access to full text in electronic format; participant control 
of scope, coverage, description and distribution of local information; b.) faster 
access to information following elimination of centralized conversion and 
processing; and c.) greater exposure of national information and access to 
world agricultural data via the WAICENT server.  FAO's primary role will be to 
assist countries in reaching the goal of self-sufficiency in information 
management. The Organization will continue, through WAICENT, to develop 
tools and methodologies which can be used at national, regional and 
international levels, as part of the global information exchange process; 
sensitize decision-makers about the importance of investing in information 
systems; and establish training courses both at FAO and in developing 
countries. 

 
AGRICOLA 
Compiled by the National Agricultural Library of the U.S. Department of 
Agriculture, and published on the Web by Community of Science (COS), 
AGRICOLA (Agricultural Online Access) is the most comprehensive source of 
U.S. agricultural and life sciences information. AGRICOLA serves as the 
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document locator and bibliographic control system for the National Agricultural 
Library (NAL) collection. It contains over 3.3 million bibliographic records of 
journal articles, monographs, theses, patents, software, audio-visual 
materials, and technical reports related to agriculture from 1979 to the 
present. Indexers regularly scan over 1,400 journals for input into the 
database. Since 1984, the database also has included some records 
produced by cooperating institutions for documents not held by the NAL. Data 
is provided to Community of Science under contract with the National 
Technical Information Service. AGRICOLA provides comprehensive coverage 
of newly acquired worldwide publications in agriculture and related fields, 
covering the field of agriculture in the broadest sense. Records are 
catalogued using the controlled vocabulary of Library of Congress Subject 
Headings and, since 1985, of the CAB Thesaurus.  

AGRICOLA through Community of Science, enables you to:  
• Select a search interface designed for your level of search 

experience.  
• Search for abstracts in specific journals.  
• Download search results in citation formats for use with most 

citation management software packages.  
• Track your queries so that you can repeat past searches against 

current data.  
• Search by MARC record field.  

A database search produces a customized bibliography. Within seconds, the 
system provides a table of references found on a given topic. You can then 
specify which references you want to see.  
 
CAB Abstracts 
CAB ABSTRACTS® is a bibliographic database compiled by CAB (Commonwealth 
Agricultural Bureau) International. It covers the significant research and development 
literature in the fields of agriculture, forestry, aspects of human health, human nutrition, 
animal health and the management and conservation of natural resources. Over three million 
records have been added to the database since its computerization in 1973. These records 
are made available through a wide range of products and services both printed and 
electronic.  
 
CAB International's Internet Products.  
CABDirect® - A new combined CAB ABSTRACTS and CAB HEALTH database accessible 
via the Internet with links to full text via Ingenta Journals. Online Communities include i. 
Animalscience.com - A new online community for specialists in animal health and production; 
ii. Nutritiongate.com - A new online community providing access to information and facilities in 
the areas of human and animal nutrition;  iii. Leisuretourism.com - A new online community 
for the leisure, tourism and recreation sectors;  iv. organic-research.com - A new online 
community providing access to information on organic farming and worldwide research; v. 
Primary Journals - The content of CAB's  primary and review journals is available with at least 
a one year backfile at no extra cost for organizations subscribing to the printed version; vi. 
CABI Online Abstract Journals - All the abstract journals are available on the Internet as fully 
searchable archival datasets - minimum 10 year back file; vii. Agricultural Engineering on the 
Web - an online service providing access to the world's published research literature in 
agricultural engineering; viii. AgBiotechNet - provides easy access to information on subjects 
such as genetic engineering, in vitro culture, biosafety, intellectual property rights and other 
key issues in agricultural biotechnology; ix. Animal Health and Production Compendium. 

 
CABWeb®s  
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HORT CABWeb® - providing desktop access to the world's published 
scientific research literature covering all aspects of horticulture and seed 
science. PEST CABWeb® - providing desktop access to the world's literature 
on crop protection, including: entomology, nematology, weeds, biological 
control, pathology and other aspects of pest management. TREE CABWeb® - 
providing desktop access to the world's published scientific research literature 
in forest science, agroforestry and forest products.  
 
The Agricultural Information Scenario in India  
Under the auspices of the ICAR, the project "Agricultural Research 
Information System (ARIS)” is being implemented to bring information 
management culture to National Agricultural Research System (NARS) so 
that agricultural scientist can carry out research more effectively by having 
systematic access to research information available in India as well as in 
other countries, better project management of agricultural research, and 
modernization of the office tools. The basic infrastructure required for linking 
all ICAR institutes has already been created. The E-mail connectivity has 
been established to 72 out of 86 ICAR institutes by linking through dial-up 
including six institutes with VSAT connectivity using NICNET and ERNET 
services. ARIS has four information modules namely Agricultural Research 
Personnel Information System (ARPIS); Agricultural Research Financial 
Information System (ARFIS); Agricultural Research Library Information 
System (ARLIS) and Agricultural Research Management Information System 
(ARMIS). The ICAR is also running an Agricultural Research Information 
Centre (ARIC) as the Central source of information on all research projects 
and schemes financed by the ICAR. Databases on A.P. Cess Fund Schemes, 
Deputation reports and research projects of institutions were computerized 
and updating of the databases is taken up. The ARIC is the national input 
centre for the AGRIS and CARIS agricultural databases of the FAO, which is 
the largest information system of its kind in the world. The ARIC is also the 
national focal point for the SAARC Agricultural Information Centre (SAIC). It 
has published several directories in addition to a half-yearly Directory of 
conferences, seminars, symposia and workshops in agriculture. It is being 
upgraded to provide on line uplinking and downlinking facilities to the ICAR 
system, and to the agricultural information system of the entire world. 
 
Agri Informatics and India 
Agricultural Marketing Information: A key step towards globalisation of Indian Agriculture The 
availability of prompt and reliable information about what is happening in the market, what 
quantities are arriving and what prices are quoted for different commodities considerably 
improve the decision making capability of the farmers and strengthens their bargaining power. 
At present, the information is disseminated through various media like radio, newspapers, 
blackboard display and public address system at market yards. The information provided by 
these methods is stale and does not help the farmers sufficiently in taking decisions in 
marketing their produce. The farmers are also not able to know about the prices prevailing in 
other markets, as the Market Committees are able to disseminate information in respect of 
their own markets. The farmers are, therefore, left with no alternative but to dispose of their 
produce in the nearest market, even at uneconomic prices. Improvement in the present 
market information system by linking all important agricultural produce markets in the 
Country, the State Agricultural Marketing Boards & Departments, under Agricultural Marketing 
Information Network (AGMARKNET) will enable farmers to take market based decisions and 
benefit other market users as well. 
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Access to world’s scholarly literature : Electronic Journals - Direct, 
Second Party, and Aggregators  
Electronic journals are the digital equivalent of their print counterparts. 
Whereas databases may contain only some full text or links to full text, 
electronic journals are literally the entire journal. For a good catalog of 
electronic journals currently available, see the World Wide Web Virtual 
Library: Electronic Journals. An electronic journal is the whole journal, and 
libraries can subscribe to electronic journals from publishers or through a 
second party (e.g. vendors) just like they subscribe to print journals. This 
distinction between publishers and second parties is an important one, as 
these are the two ways libraries get electronic journals. Some companies 
create collections of entire journals and sell access to these collections. 
Second party electronic journal databases are different from other databases 
because in a second party electronic journal database, the entire journal is 
collected, as opposed to a full text database like “Academic Search Elite”, 
where all, some, or none of any given journal may be included. Examples of  
second party electronic journal databases include: 
1. JSTOR, which specializes in making back issues of a wide variety of 
humanities and social science journals available electronically; 2. Ingenta, the 
most appreciated journal portal, facilitates users to read, print, and email 
articles from 4,500 electronic journals from 140 publishers. Ingenta is the 
world's largest website for the search and delivery of research articles and it 
offers access to article summaries from over 25,000 publications linked to the 
full text of over 5,200 titles. Full text access is set from over 170 publisher 
partners, but typically individual subscribers, or individuals within institutions 
that subscribe, can access the full text of their publications for free. For 
libraries and information professionals, Ingenta provides an extensive range 
of free and customized online services, from enabling authenticated campus-
wide access to subscribed full text articles to creating branded library 
gateways incorporating management tools and deposit account facilities; 3. 
ProjectMUSE, which provides electronic access to journals in the fields of 
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literature and criticism, history, the visual and performing arts, cultural studies, 
education, political science, gender studies, and many others; Emerald 
Library, which contains over 140 electronic journal titles with full text articles 
published since 1994. In India, J-Gate of Informatics Ltd. is the best example 
for second party electronic journal providers. 
 
Another category is aggregators. Aggregators use to buy the copyright of the 
journals in bulk and provide access to the journals through a single interface. 
Examples of aggregators include EBSCO Online and PROQUEST. EBSCO’s 
Business Source Premier and Academic Search Elite are very popular 
services which attempt to provide management tools for full-text electronic 
journals. PROQUEST’s ABI/Inform is yet another popular full-text journals 
service. There are advantages as well as drawbacks in each case. In the case 
of electronic journals, either sourced directly from the publisher or through a 
second party, the users have the advantage of accessing the journals direct. 
The disadvantage is that in the electronic journal services, search facilities are 
kept at a low profile. Whereas in the aggregated services, search facilities are 
fairly high, with low priority for content layout, get up etc.   
 

The growing prominence of E-Journals and the swinging pricing models 
For want of brevity and focus, this paper will concentrate on the issues of “E-
journals” and aggregated scholarly literature, primarily and originally 
appearing in E-journals. About 10 years ago when Electronic Journals first 
appeared the publishers didn’t know how to sell them, nor librarians knew how 
to handle them. The technology scenario prevailing those days were entirely 
different too. Technology kept advancing and after 10 years, today the e-
journals are sold as hot cakes in the developed world. The trends in the 
developing world also are equally encouraging, especially in India. This fast 
change in mindset has taken many publishers by surprise. Earlier, 
negotiations that involved expanded access to electronic text usually began 
with print subscriptions as the bottom line of the deal. During the past couple 
of years, especially in the West, a number of consortia demanded that print 
and online be negotiated separately. They wanted online access at the core of 
pricing negotiations because their users clearly preferred online. They wanted 
an online-plus-print model, rather than print-plus-online. This is called "flip 
pricing." As a model, flip pricing is not new. Academic Press introduced the 
concept with its first e-journal package. Few publishers adopted that model, 
however, and most libraries have continued to receive print and online more 
or less as a package deal. This has resulted as a real blessing to the Indian 
libraries. The reflections of the flip pricing has started crystallizing of late and 
most of the leading publishers have started offering flip price models to Indian 
libraries too, mostly under the consortia banner.    
 
The evolution of the deeply discounted prices (DDP) model is yet another 
significant development in the journals pricing front in the recent past. As DDP 
has evolved, three models have emerged that govern the relationship 
between agents and publishers. First, the publisher requires the customer to 
place electronic orders directly with them; with the second version, customers 
may place their orders with agent or publisher, but customers are given an 
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incentive to deal direct; and in the third scenario, customers are free to order 
either way.  
 
In 2000, 75% of publishers offered online free with print, with the rest charging 
extra for online. But every year, publishers change their mind on this one 
issue, and last year the pendulum seemed to be swinging back in favor of 
charging extra for online with a print subscription. Of the 7,623 e-journals with 
set prices in EBSCO's reserve, 61% were offered free with a print subscription 
for this year (2001). The majority of major publishers still offer online "free" 
with print as a rule. The list includes Cambridge University Press, Elsevier, 
Emerald, Oxford, Routledge, Sage, Springer Verlag, and Taylor & Francis. 
Blackwell Science charges extra, but the other Blackwell imprints do not. 
University presses are split. Duke, Indiana, Johns Hopkins, and Penn State, 
charge; MIT, Chicago, and California do not. Society presses are also split, 
but the majority appear to charge for online with print. The list of STM 
publishers that charge extra include giants such as Academic, Wiley, Kluwer, 
Dekker, Nature, Plenum, and S. Karger.  

 

Copyright and IPR Issues  
Issues of copyright, intellectual property, and fair use are important to 
libraries, but librarians are struggling to make sense of all the issues in the 
new Digital Age. We need to learn a lot about the “tricks of the trade” so that 
our hands are not burnt in the process. The number of accessible electronic 
journals are fast growing steadily. Studies are going on to determine the 
trends in copyright policies among scholarly electronic journals. There are a 
number of issues which the Librarian should be highly careful while entering 
into digital subscriptions. Catches can come in multiple forms with the vague 
yet meticulously manipulated term “licensing”. The audit and accounts are to 
be amply briefed about the problems and features of digital subscriptions. 
Proper measures and back-up agreements are to be assured from the 
publishers/vendors.  
 
However, according to literature, the policies are found to be quite generous 
in the area of fair use and encouraged sharing of information. Some of the 
salient features of copyright issues of a select set of freely accessible 
electronic journals are as follows: (1) copyright policies are informal, (2) 
policies are common to print and electronic titles, (3) contributing authors 
generally retain copyright, (4) noncommercial uses permitted include 
browsing, printing personal copies, and downloading, and (5) republishing is 
not permitted. Several of these journals address library use.  
 
Access related issues 
Access to E-Journals could be arranged from the respective publishers 
against UserID/Password or through IP authentication. For a wider audience, 
IP based access is mostly preferred, as the users need not have to bother 
about the UserID and Password every time. A useful alternative is to provide 
the UserID/Password in the library’s portal / website so that users can pick 
them up during usage, and over a period of time, they also by-heart them. 
Libraries need to take care of the ‘site license’ aspects of content access, as 
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some publishers lay stringent rules on this, making the life of the Librarian 
miserable. Before jumping into such services, the Librarian should ensure 
necessary Internet bandwidth also, failing which complaints will pile up, 
resulting in a growing aversion against the electronic services in general. For 
full-text access to E-Journals and datasets published online usually non-
exclusive, non-transferable right and licenses are provided. Unlimited access 
is provided to Tables of Contents, article abstracts, chapter summaries and 
websites for other Electronic Products.   
 
Another important aspect is the local administration of access management 
by the users. Users are to be properly oriented towards effective and efficient 
use of the Net as well as the journal sites. Unnecessary and unscrupulous 
hits, revisits and downloads can result in frequent choking of the Net 
connectivity, posing unwanted problems to the entire user community on 
campus. 
 
JSTOR    
JSTOR, a Journal Archive Service, has announced the release of its new 
Ecology & Botany Collection. Developed in cooperation with the Ecological 
Society of America (ESA), the collection will enable ecologists, 
conservationists, and scholars in related fields to access research, over the 
Internet, from journals that go back 130 years and which represent 1,500 
cumulative years of academic literature in the biological sciences. The 
complete back-runs of 29 academic journals critical to researchers in the field 
have been converted by JSTOR from print to a full-text, searchable electronic 
format. In addition to serving as an important archive, the Ecology & Botany 
Collection creates a new level of access to a significant collection of valuable 
scientific literature. The historical material contained in this collection will be 
valuable to scholars and professionals around the world. 
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J-Gate: The Electronic Journal Gateway  
J-Gate is an Internet gateway set up by Informatics for integrating e-content and e-commerce 
for journal literature. It envisages providing seamless access to journal articles at publisher’s 
site, local site of the libraries, or at the J-gate archive, through a table-of-content (TOC) and 
abstract database as the search and link interface. It will also support online subscription to 
journals, and other related services. J-Gate is being implemented in a phased manner and 
when fully operational, it will offer several integrated services related to e-journals. For more 
details visit the J-Gate site j-gate. informindia.com,  or Contact J-Gate team at  j-
gate@infomindia.com. 
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iii.  Ingenta 
Ingenta is the global research gateway serving the online information needs of 
over 1.4 million visitors a month. It provides a free online search service of 
published content from reliable research sources and is one of the UK's top 
20 Web services. For publishers of professional and academic periodicals and 
journals, Ingenta provides a suite of services including data conversion, 
secure online hosting and distribution of this material to subscribers and pay-
per-view customers. As well as providing Web users with a broad based 
article search and delivery service through www.ingenta.com, Ingenta also 
develops subject-focused websites, built in conjunction with societies, 
publishers and university presses.  
 
Ingenta library services 
For libraries and information professionals, Ingenta provides an extensive 
range of free and customized online services, from enabling authenticated 
campus-wide access to subscribed full text articles to creating branded library 
gateways incorporating management tools and deposit account facilities. 
 
Ingenta.com 
The world's largest website for the search and delivery of research articles, 
ingenta.com offers you access to article summaries from over 25,000 
publications linked to the full text of over 5,200 titles. Full text access is set by 
each of our 170 publisher partners, but typically individual subscribers, or 
individuals within institutions that subscribe, can access the full text of their 
publications for free. Non-subscribers can, for the majority of articles, pay-per-
view choosing from electronic, fax or Ariel delivery. 
 
Acknowledgement  



Internet and its Services 

 

35

 
 

The author expresses his profound thanks to the Director, IIM Kozhikode for 
the encouragement and support.  
 
References  
1.  World Wide Web Consortium - See: www.w3c.org 
2.  BIOSIS - See: http://www.biosis.org.uk/free_resources/resource_guide.html 
3.  See: http://biology.usgs.gov 
4.  See: http://www.nbii.gov 
5.  See: http://www.itis.usda.gov 
6.  See: http://www.nbii.gov/datainfo/syscollect/tred 
7.  See:  http://www.nbii.gov/datainfo/syscollect/drsc/index.html 
8.  See: http://www.fao.org/agrovoc 
9.  See: http://agmarknet.nic.in/agmarknet1.htm 
10. See: http://icar.org.in/icar4.htm 
11. See: http://www.cabi-publishing.org/Products/Internet/Index.asp 
12. See: http://www.animalscience.com/ 
13. See: http://www.nutritiongate.com/ 
14. See: http://www.leisuretourism.com/ 
15. See: http://www.organic-research.com/ 
16. See: http://asae.cabweb.org/  
17. See: http://www.agbiotechnet.com/ 
18. See: http://www.cabdirect.org/ 
19. JSTOR - See: http://www.jstor.org 
20. J-Gate - See: http:// j-gate.informindia.com 
21. See: http://www.ingenta.com 



 36  Computer Skills for Biologists  

 
 

 MICROSOFT EXCEL  
 

K. N. Kurup  
Indian Institute of Spices Research, Calicut 

 
What is Excel? 
Excel is a powerful tool used to manipulate and organize data.  It can be used 
for many things including formulas, creating charts, databases and integrating 
with other Microsoft products.  Within Excel worksheets can be formatted to 
make data easy to understand.  
 
The Excel Window 

 
 

1. Title Bar  
o Displays application and workbook name  
o Control Buttons  

2. Menu Bar  
o Pull Down Menus - personalized menus (Tools \ Customize \ Options - to turn 

on and off)  
o Dimmed commands - unavailable  
o Ellipsis ( ... ) - activates a dialog box  
o Shortcut keys - [ alt, ctrl, or shift ] + letter  
o Demonstrate control buttons for workbook  

3. Standard & Formatting Toolbars  
o Shortcut tools for menu commands  
o Tip boxes - display descriptions  
o Can add/remove toolbars by selecting desired toolbar under View \ 

Toolbars.  
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4. Formula Bar  
o Name Box shows address of active cell  
o Cancel/Confirm/Function  
o Formula Bar shows contents of active cell  

5. Status Bar  
o Worksheet status (Ready, Wait, Messages)  
o NUM, CAPS  

6. Worksheets  
o Sheets: up to 255 worksheets saved under one workbook  
o Columns: 256 columns per worksheet ( A to IV)  
o Rows: 65,536 rows per worksheet  
o Active cell: dark or highlighted border, cell reference displayed in name box  
o Worksheet Tabs  

 Scroll through worksheets  
 Rename Tabs  
 Insert Worksheet  
 Delete Worksheet 

 
Tips, Tricks & Terminology 
 
Cell Contents  

1. Text = labels, left aligned within cell  
2. Numbers = value, right aligned within cell  
3. Formulas = to be discussed later  
4. After typing information into a cell:  

o Click Green Check Mark on Formula Bar OR  
o Press Enter (Enter automatically advances cell pointer down one row)  OR  
o Press Tab to insert information into cell  
o Click Red X on formula bar to cancel cell entry  
 

Undo Feature  
• reverses last command or deletes last entry typed  
• command reflects last action (e.g., Undo Cut or Undo Typing)  

• choose Edit menu, Undo command or use Undo tool  
 
 
Navigating in Excel  
   
Tab Moves to next cell 
Shift + Tab Moves to previous cell 
PgDn Moves down one worksheet screen 
PgUp Moves up one worksheet screen 
ALT + PgDn Moves right one worksheet screen 
ALT + PgUp Moves left one worksheet screen 

CTRL + End Moves to the bottom right corner of the worksheet's active area (last cell 
containing data) 

End + Directional 
Key 

Moves in the direction of the arrow to the last cell containing data OR to 
the border of the worksheet 

CTRL + Home Moves to cell A1 of current worksheet 
CTRL + PgDn Moves to the next worksheet tab 
CTRL + PgUp Moves to the previous worksheet tab 
CTRL + G Go to a specific cell address 
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Selecting  
 
Select Entire Row Click Row Heading 
Select Entire Column Click Column Heading 
Select Range of Cells Point and Drag 

Select Entire Worksheet Click Select All Button in upper left corner of Row & Column 
Headings 

Select a Range of Cells  
with Keyboard Press Shift and arrow keys 

Select a Range of Cells  
with Mouse SHFT + Click to select first and last cells of desired range 

Select Non-contiguous 
Cells  
with mouse 

CTRL - Click to select desired random cells 

 
 
Creating a Worksheet 

1. Choose File\ New or use New tool Type desired Workbook name 
2. To create a new, blank workbook, click the General tab, and then double-click the 

Workbook icon.  
 

   EXERCISE 
• Using the example below enter titles in cells A1:A4 and in cell A9  

  A B C D E 

1 Business Expenses         

2           

3 Day Meals Lodging Phone Total 

4 Monday         

5           

6           

7           

8           

9 TOTAL         

 
 
Open a workbook on your hard disk or network 

1. On the File menu, click Open. 
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2. In the Look in list, click the drive, folder, or FTP location that contains the workbook 
you want to open, and then locate and double-click the folder that contains the 
workbook.  

3. Double-click the workbook you want to open.  
 

Saving A Workbook 
1. Choose File\ Save or use Save tool Type desired Workbook name  
2. Navigate to the desired folder before saving in the Save In field  
3. Click Save  
 

Save workbooks automatically as you work 
1. On the Tools menu, click AutoSave.  

If the AutoSave command is not on the Tools menu, you must install 
the AutoSave add-in.  

2. Select the Automatic save every check box. 
3. In the Minutes box, enter how often you want Microsoft Excel to save workbooks. 
 

Select any other options you want 
 

  EXERCISE 

1. Click File \  Save    or   
2. Change the "Save In" drop down to the Desktop (note: the complete path name may 

be typed in the file name box instead of navigating in the Save In field).  
3. type "my business expenses" in the File Name: text box  
4. When a worksheet is saved, the extension .xls will be automatically added to the file 

name.  
5. Click Save (NOTE: Look for workbook name in title bar).  

It is recommended to save frequently when creating or editing a document.  Once your 
document has been saved, changes are saved over the original when you choose File \ Save 

or click .  
 

AutoFill 
Autofill is used to create a series of incremental fixed values like  January - December, 1 - 31, 
days of the week, etc.  Autofill lists are customizable by going to tools \ options \ custom 
lists.  
   

 

  EXERCISE 
 

o select cell A4  
o Position the pointer on the AutoFill handle located in the bottom right corner 

of the cell.  The pointer will change to a 
cross

 crosshair.  
o Drag the AutoFill handle to cell A8  
o Enter remaining values and headings, cells B3 through D8 & E3  

 
Auto sum 

AutoSum  creates the "=SUM" function inside the cell it is inserted.  It 
totals either cells to the left (default) or cells above.  Before calculating it 
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places a dotted line around its targeted cells. You may accept the suggested 
cells or select the desired cells to total by clicking and dragging.  

 

  EXERCISE 
 

1. Click in cell C9 to enter AutoSum function to calculate weekly total for lodging  

2. Click the  AutoSum tool  
3. Notice the selected cells and press Enter to accept  
4. Insert AutoSum in cell E4  
5. Fill Down, cells E4:E9 (automatically changes references when copied; examine each 

Total in Column E after Filling Down)  
o select cells E4:E9  
o Edit menu, Fill Down command  
o OR use AutoFill  
 

Delete sheets from a workbook 
1. Select the sheets you want to delete.   
2. On the Edit menu, click Delete Sheet.  
 

Delete a file 
1. Click Open. 
2. In the Look in box, click the drive or folder that contains the file you want to delete. 
3. In the folder list, double-click folders until you open the folder that contains the file you 

want.  
If you can't find the file in the folder list, you can search for it.  

4. Right-click the file you want to delete, and then click Delete on the shortcut menu 
 
Editing a Worksheet 
 
Column & Row Width and Height  

• Position  the pointer on the line separating the column or rows until the pointer 

changes to 
row  & column

  
• drag separator line between column heading or row  
• double-click separator line after data to determine best fit (AutoFit)  
• choose Format menu, select Column command, Width or Row Height selection OR 

Right-Click on heading  
 

Cut/Copy & Paste  
There are several ways to carry out copying or deleting text.  When text is 
copied or cut that text is held on the Windows clipboard until it is replaced by 
other information.  Some of the ways to copy or delete text include:  

1. To Move Text: Select text, then choose Edit \Copy or Cut command  
o Copy will leave the text in its original location and place a copy on the 

Windows clipboard  
o Cut will remove the text from its original location and place it on the Windows 

clipboard  
2. If you would like to place information copied to the Windows clipboard elsewhere:  

o Click in the desired targeted cell  
o Choose Edit \Paste  

3. "Drag & drop" may be used to move information by selecting the desired information 
then dragging and dropping it to the desired location.  

 
Inserting Or Deleting Rows And Columns  
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• Insert a Row or Column by selecting Rows or Columns from the Insert menu OR 
right mouse-click on the row or column heading  

• Delete a Row or Column by selecting the desired row or column then choose Delete 
from the Edit menu OR right-click on the row or column heading and choose Delete.  

• Formulas automatically adjusted to reflect change in cell references  
1. Delete rows 19 and 20  

o Select row header for rows 19 and 20 (drag across row headings to select 
more than one row)  

o Edit menu, Delete command  
 

Borders, Lines & Shading  
1. Format menu, Cells command, Border tab  
2. Borders: position (outline, inside, left, right, top, bottom between rows, between 

columns), style of line, color  
3. Format menu, Cells command, Patterns tab to add shading  
4. Add shading to Total Expenses and the amount  

o Select cells B27:C27  
o Format menu, Cells command, Patterns tab  
o Select Pattern: list and choose last shade on top row  
o Click  OK  

5. Draw a border around the worksheet  
o select cells A1:C27  
o Format menu, Cells command, Border tab  
o Select Outline  
o Click OK  

6. Type your name in cell B1  
 
 

Sorting Data In A List  
When sorting data use the Data menu and Sort command.  Any field name in 
the list can be used as a sort field for arranging the order of the list.  
 
Terminology   
Data List Collection of related information 
Record All of the information pertaining to one particular individual or entity 
Field A single piece of information about the individual or entity 
Field Names  Column headings or labels that describe the data items (up to 255 characters)

 
 
Sort rows in ascending order based on the contents of one column 
If you previously sorted a list on the same worksheet, Microsoft Excel uses 
the same sorting options unless you change them.  

1. Click a cell in the column you would like to sort by. 
2. Click Sort Ascending  
 

Sort rows in descending order based on the contents of one column 
If you previously sorted a list on the same worksheet, Microsoft Excel uses 
the same sorting options unless you change them.  

1. Click a cell in the column you would like to sort by. 
2. Click Sort Descending  
 

Sort rows based on the contents of two or more columns 
For best results, the list you sort should have column labels. 

1. Click a cell in the list you want to sort. 
2. On the Data menu, click Sort.  
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3. In the Sort by and Then by boxes, click the columns you want to sort.  
If you need to sort by more than three columns, sort by the least 
important columns first. For example, if your list contains employee 
information and you need to organize it by Department, Title, Last 
Name, and First Name, sort the list twice. First, click First Name in the 
Sort by box and sort the list. Second, click Department in the Sort by 
box, click Title in the first Then by box, and click Last Name in the 
second Then by box, and sort the list.  

4. Select any other sort options you want, and then click OK.  
Repeat steps 2 through 4 if needed, using the next most important 
columns 
 

Sort columns based on the contents of rows 
1. Click a cell in the list you want to sort. 
2. On the Data menu, click Sort.  
3. Click Options. 
4. Under Orientation, click Sort left to right, and then click OK. 
5. In the Sort by and Then by boxes, click the rows you want to sort 
 

Sort months, weekdays, or custom lists 
1. Select a cell or range in the list you want to sort. 
2. On the Data menu, click Sort.  
3. Click Options. 
4. Under First key sort order, click the custom sort order you want, and then click OK. 
5. Click any other sorting options you want.  
 

Emp.xls   

Last Name First Name SS # Department Hours Rate Reg. Pay OT Pay
Gross 

Pay

Smith Jim 098-76-5432 Marketing 30 7.50 225.00 0.00 225.00 

Alexander Aaron 123-44-5566 Accounting 40 8.75 350.00 0.00 350.00 

Evans Nancy 123-45-6789 Administration 45 8.00 320.00 60.00 380.00 

Jackson Dot 234-56-7809 Accounting 40 #### 400.00 0.00 400.00 

Jones Joe 234-56-7890 Marketing 43 7.75 310.00 34.88 344.88 

Davis Richard 321-65-9874 Administration 40 #### 400.00 0.00 400.00 

Walters John 432-18-7654 Engineering 40 #### 410.00 0.00 410.00 

Edgar Carl 456-77-9632 Administration 25 9.00 225.00 0.00 225.00 

Gates Michael 456-78-1234 Records 15 8.00 120.00 0.00 120.00 

Ford Micki 466-44-6666 Engineering 45 8.90 356.00 66.75 422.75 

Waverly Rita 616-61-6116 Administration 40 9.00 360.00 0.00 360.00 

Phillips Wesley 654-32-6547 Engineering 46 #### 440.00 99.00 539.00 

Johnson James 654-47-7666 Marketing 40 #### 400.00 0.00 400.00 

Cochran Steve 666-64-4664 Administration 40 #### 440.00 0.00 440.00 

Wilson Susan 666-77-4456 Engineering 40 9.25 370.00 0.00 370.00 

Mason Mary 678-98-8888 Records 35 8.00 280.00 0.00 280.00 

Wilson Bob 765-43-2109 Engineering 20 6.00 120.00 0.00 120.00 

Smith Joe 789-32-1649 Records 15 9.25 138.75 0.00 138.75 
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Bates Charles 789-46-8392 Administration 40 8.00 320.00 0.00 320.00 

Cox James 799-79-7979 Records 30 8.00 240.00 0.00 240.00 

Brown Sam 855-64-9874 Accounting 45 #### 440.00 82.50 522.50 

Hodges Lynne 888-22-1111 Marketing 43 #### 400.00 45.00 445.00 

Davis Susan 888-80-9876 Records 40 8.00 320.00 0.00 320.00 

Smith John 896-45-1236 Engineering 50 #### 400.00 150.00 550.00 

Sidney David 901-23-7586 Engineering 20 9.00 180.00 0.00 180.00 

Brown Rebecca 907-38-7804 Administration 46 8.75 350.00 78.75 428.75 

Brown Chris 946-12-3987 Engineering 48 9.50 380.00 114.00 494.00 

Thompson Richard 987-65-4321 Engineering 40 #### 480.00 0.00 480.00 

Wilson Wally 987-65-9876 Engineering 44 #### 480.00 72.00 552.00 

Jones Lucy 999-55-3333 Accounting 40 #### 440.00 0.00 440.00 
1. Save the above worksheet as  emp.xls 
2. Sort the list by name  

o Select cells A4:I33  
o Choose Data menu, Sort command  
o From the Sort By list, select Last Name  
o From the Then By list, select First Name  
o Verify Header Row is selected for My List Has section  
o Click OK  

 

  EXERCISE 
 

1. Move E3:E9 to Column F  
o select cells E3:E9  

 Edit \ Cut  
o select cell F3  
o Edit \ Paste  
o OR use drag and drop  

2. Enter Average Expense in cell E3  
o select cell E3  
o type: Average Expense  

3. Widen Column E  
o drag separator line between Column E & F  
o OR double-click separator line after each column for Best Fit  
o double-click separator line (for best fit)  

4. Paste AVERAGE function, cell E4  
o select cell E4  

o Function Wizard  tool  
o select Most Recently Used category and choose AVERAGE function  
o click OK  
o highlight cells B4:D4  
o select OK  

5. Copy to remaining cells  
o select cells E4:E9  
o Edit \ Fill Down  
o OR use AutoFill  
 

Formating a Worksheet 
1. Number Formatting  
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o Format \ Cells \ Number tab  
o Examples of Formats  

 currency  
 date  
 time  
 percentage  

2. Alignment Formatting  
o Format \ Cells \ Font Tab  
o Examples of Alignment  

 Horizontal  
 Left  
 Center  
 Right  
 Fill  

 Vertical  
 Top  
 Center  
 Bottom  
 Justify  

3. Font Formatting  
o Format \ Cells \ Font Tab  
o Font Features  

 Font Type  
 Font Style  
 Font Size  
 Underlining  
 Color  

4. Show formatting options on Formatting Toolbar.  
 

  EXERCISE 
 

1. Format the worksheet  
o select cells B4:F9  
o choose Format \ Cells \ Number card  
o select Currency  
o Click OK  
o Click the Bold  button to Bold selected headings  
o Click the Align Right  button to right align contents of each selected cell  

2. Enter your name in cell C1  
Quick Save your workbook (CTRL + S)  

 
More About Formatting 

1. Format numbers within the worksheet  
 Select cells D4:G8  
 Format menu, Cells command, Numbers card  
 Select Number  

 select 2 decimal places  
 use 1,000 separator  

 Click OK  
2. Enter your name in cell D1.  
3. Quick Save your worksheet (CTRL + S)  
4. Preview the worksheet  

 Print Preview tool  
 click Print and OK  

5. Close the workbook  
 

Purchase.xls  



Internet and its Services 

 

45

 
 

  A B C D E F G 

1 Discount 
Rate 

15%           

2               

3 Qty. Unit Description Unit 
Price 

Ext. 
Price 

Disc. 
Amt. 

Disc. 
Price 

4 1 Each Wall Calendar 
#SOU-130 

$     
13.25 

$     
13.25 

$      
1.99 

$    
11.26 

5 2 Boxes Pens (Blue) 
#GSM11-BE 

$       
3.60 

$      
7.20 

$      
1.08 

$      
6.12 

6 1 Box Pens (Red) 
#GSM11-RD 

 $       
3.60 

$      
3.60 

$      
0.54 

$      
3.06 

7 4 Each Hi-Liters 
#DFN2400 

$       
0.85 

$      
3.40 

$      
0.51 

$      
2.89 

8 3 boxes 3.5" Diskettes, 
DSHD  

$     
31.30 

$    
93.90 

$    
14.09 

$    
79.82 

 
 
 
Page Setup 
 
Paper Size  

1. Change the orientation and page centering  
o Select the Setup Button in Print Preview  
o Select Page tab  
o Choose Landscape for Orientation  
o Select Margins card  
o Choose Horizontally  and Vertically for Center on Page  
o Click OK  

2. Preview  the worksheet  
 

Margins  
1. Choose the Setup button in Print Preview  
2. Select the Margins Tab  
3. Set left & right margins at 0.75"  
4. Set top & bottom margins at 1"  

 
Headers & Footers  
To create a header that will display your name in the upper-left corner and the 
current date in the upper-right corner of the printed worksheet  

1. Click the Header / Footer tab  
2. Choose Custom Header... button  
3. Type Your Name in the Left Section of the Header: boxes  
4. In the Right Section box, select the Date button  
5. Click OK  
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To create a footer to display "Page" and the current page number in the lower-left corner of 
the printed worksheet  

1. Choose Custom Footer... button  
2. In the Left Section of the Footer: boxes, type "Page "  

3. Select   Page Number button  
4. Delete codes in other section if existing  
5. Click OK to close Header / Footer setup  
6. Click OK to close Page Setup  

Close Print Preview 
 

Sheet Setup  
Row and Column Headings & Gridlines:  

1. Choose File \ Page Setup \ Sheet tab  
2. Select Row to Repeat at Top (select Row 3)  
3. Select Column to Repeat at Left  (select Column A)  
4. Choose Gridlines to print gridlines between columns and rows  
5. Print Preview (Next & Previous Page)  
6. Close Print Preview  
 

Working with Page Breaks 
1. Adding Page Breaks - Manual page breaks are inserted before the pointer position.  

o To insert a manual page break :  
 Click in Row 7's Heading  
 choose Insert \ Page Break  

o Verify the page break was inserted between Pens (red) and Hi-Liters  
 Perform a Page Break Preview  

o Close Print Preview  
1. Removing Page Breaks - To remove manually inserted page breaks:  

o Position your cell pointer in a cell below the row containing the page break 
(click in Row 7)  

o Choose Insert \ Remove Page Break (remove page break in the exercise)  
o choose [ Print... ] button  
o Click OK  
o Save and Close the worksheet  
 

Print Preview & Printing 
1. Click the  Print Preview  tool  

o Zoom: button to reduce/enlarge worksheet  
o Setup: change setup options  
o Margins: change margins  
o Page Break Preview: button to view page breaks on-screen and manually 

adjust them  
o Close: to close the print preview window  
o Help: to access Microsoft Excel's help on the print previewing topic  
o Print: print the worksheet  
 

Printing  
1. Preview and print the worksheet  

o choose Print button  
o OK  

2. Save the worksheet  
o File \ Save  

o or  Save button  
3. Close the worksheet  

o File \ Close or click the Close Button  
 
Business Expenses  example 



Internet and its Services 

 

47

 
 

  A B C D E  F 

1 Business 
Expenses 

          

2            

3 Day Meals Lodging Phone Average 
Expense 

Total 

4 Monday $18.50 $58.00 $1.75 $26.08 $78.25 

5 Tuesday $17.25 $65.50 $2.00 $28.25 $84.75 

6 Wednesday $16.75 $48.00 $4.50 $23.08 $69.25 

7 Thursday $18.00 $54.00 $3.95 $25.32 $75.95 

8 Friday $16.85 $0.00 $5.00 $7.28 $21.85 

9 TOTAL $87.35 $225.50 $17.20 $110.02 $330.05 

 
Selection  
 
Active Sheets  
Entire Workbook  

1. Select desired area to print (Descriptions & Unit Prices C4:D8)  
2. Click File \ Print  
3. Choose Selection  
4. Choose Preview  
5. Close Print Preview  

 
Introduction to Formulas 
Formulas are used to calculate information in a worksheet.  Instead of 
entering a constant number, a formula can be created which allows automatic 
updating of results if the data changes.  The cell and formula bar contain the 
formula; however, the result of the formula is displayed in the cell.  
 
Rules of Creating a Formula  

1. Must begin with equal sign (=)  
2. Use cell references, rather than constants, and math operators  

o Math Operators  
 + = addition  
 - = subtraction  
 * = multiplication  
 / = division  

o Order of a Formula  
 "="  
 Cell reference  
 Math Operator  
 Cell reference  
 Example of a formula:  +C5 + D4 - D3 / H14 * R32 (Values = 10, 20, 

30, 10, 10)  
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o order of precedence within formulas is: multiplication or division calculates 
first from left to right; then, addition or subtraction.  

2. To override the order of precedence, put parentheses around the operation to be 
performed first.  Use example formula to change order of calculation.  

 

Purchase Order  example 

  
  

A B C D E F G 

1 Discount 
Rate 

15%           

2               

3 Qty. Unit Description Unit 
Price 

Ext. 
Price 

Disc. 
Amt. 

Disc. 
Price 

4 1 each Wall Calendar 
#SOU-130 

13.25       

5 2 boxes Pens (Blue) 
#GSM11-BE 

3.60       

6 1 box Pens (Red) 
#GSM11-RD 

3.60       

7 4 each Hi-Liters 
#DFN2400 

0.85       

8 3 boxes 3.5" Diskettes, 
DSHD  

31.30       

1. Create a file named purchase.xls  
2. Enter the formula to calculate Ext. Price (Qty. * Unit Price)  

 Select cell E4  
 Type: =a4*d4  
 Press Enter  

3. Copy the formula from E4 to E5:E8.  
 Select cell E4  
 Edit menu, Copy command  
 Select cells E5:E8  
 Edit menu, Paste command; ECS  
 OR use AutoFill  

4. Verify that Row cell references adjusted during copy (Relative Referencing)  
 Select cell E5  
 Formula should read =A5*D5  
 Also verify formulas in cells E6, E7, E8  

 
 
Absolute Referencing  

5. Enter the formula to calculate Disc. Amt. (Ext. Price * Discount Rate)  
 Select cell F4  
 Type: =e4*b1  
 Press Enter  
 AutoFit Column D  
 OR point to each cell to build the formula  
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6. Copy the formula from F4 to F5:F8  
 Select cell F4  
 Edit menu, Copy command  
 select cells F5:F8  
 Edit menu, Paste command  
 OR use AutoFill  

NOTE:  #VALUE! error occurs if formula should have been absolute  
   

7. Change original formula in cell F4 to include an absolute cell reference to cell 
B1  

 Select cell F4  
 Select the cell reference B1 on the formula bar  
 Press F4 OR (F4 key adds absolute reference to cell address)  
 Type "$B$1"  
 Click Enter  

8. Copy the revised formula from F4 to F5:F8 (Copy & Paste or AutoFill)  
9. Enter the formula to calculate Disc. Price (Ext. Price - Disc. Amt.)  

 Select cell G4  
 Type: =e4-f4  
 Press Enter  

10. Copy the formula from G4 to G5:G8 (Copy & Paste or AutoFill)  
11. Quick Save Workbook (CTRL + S)  
 

View Formulas 
To assist in proofing your worksheet it is helpful to have the formulas displayed in 
each cell instead of the answer to the formula.  To turn Formula Display on/off:  

o Click Tools menu  
o Options command  
o View tab  
o Select Formulas in the Window Options area.  

 
NOTE:  The columns automatically widened to display formulas within 
cells.  
   

o Turn on your formulas to be viewed and proof your worksheet  
If the worksheet is correct, turn off the display of formulas by selecting Tools 
menu, Options command, View card and deselecting Formulas. 

 
 

  EXERCISE 
 

1. Enter formula, cell B9 to calculate the total for Meals  
o select cell B9  
o you may type or point to cell references  
o type: = b4 + b5 + b6 + b7 + b8  
o Click Enter  

Create a formula together calculating an average of daily cost of meals. 
 
Introduction to Functions 

Functions are prewritten formulas available in Excel.  Functions are organized 
in several categories including Financial, Date & Time, Statistical, and 
Database.  Before creating a formula, you are encouraged to review the list of 
available Functions.  
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  EXERCISE 
 

1. Select cell D9 to enter the SUM function for the weekly phone total  

2. Click the Function Wizard   
3. Select the SUM function  
4. Insert cells C4:C8  
5. Click OK  
 

Relative Referencing  
Click on each total cell in column E and observe contents of the formula bar.  
Each formula updates based on the position of the data in the worksheet.  
 
More About Functions 
 

Exercise: Payroll.xls 

Last Name 
First 
Name SS # Department Hours Rate 

Reg. 
Pay

OT 
Pay

Gross 
Pay

Smith Jim 098-76-5432 Marketing 30 7.50    

Alexander Aaron 123-44-5566 Accounting 40 8.75    

Evans Nancy 123-45-6789 Administration 45 8.00    

Jackson Dot 234-56-7809 Accounting 40 10.00    

Jones Joe 234-56-7890 Marketing 43 7.75    

Davis Richard 321-65-9874 Administration 40 10.00    

Walters John 432-18-7654 Engineering 40 10.25    

Edgar Carl 456-77-9632 Administration 25 9.00    

Gates Michael 456-78-1234 Records 15 8.00    

Ford Micki 466-44-6666 Engineering 45 8.90    

Waverly Rita 616-61-6116 Administration 40 9.00    

Phillips Wesley 654-32-6547 Engineering 46 11.00    

Johnson James 654-47-7666 Marketing 40 10.00    

Cochran Steve 666-64-4664 Administration 40 11.00    

Wilson Susan 666-77-4456 Engineering 40 9.25    

Mason Mary 678-98-8888 Records 35 8.00    

Wilson Bob 765-43-2109 Engineering 20 6.00    

Smith Joe 789-32-1649 Records 15 9.25    

Bates Charles 789-46-8392 Administration 40 8.00    

Cox James 799-79-7979 Records 30 8.00    

Brown Sam 855-64-9874 Accounting 45 11.00    

Hodges Lynne 888-22-1111 Marketing 43 10.00    

Davis Susan 888-80-9876 Records 40 8.00    

Smith John 896-45-1236 Engineering 50 10.00    
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Sidney David 901-23-7586 Engineering 20 9.00    

Brown Rebecca 907-38-7804 Administration 46 8.75    

Brown Chris 946-12-3987 Engineering 48 9.50    

Thompson Richard 987-65-4321 Engineering 40 12.00    

Wilson Wally 987-65-9876 Engineering 44 12.00    

Jones Lucy 999-55-3333 Accounting 40 11.00    
 

1. Save the above sheet as payroll.xls  
 

Freezing Panes  
o Freezes row headings across the top of the worksheet or column headings at 

the left of the worksheet  
o Select Window menu, Freeze Panes command to set Horizontal (rows) or 

Vertical (columns)  
o Select Window menu, Unfreeze Panes command to unfreeze  

 
To Freeze the row headings and names  
   

• select cell C4  
• choose Window menu, Freeze Panes command  

 
NOTE: Freeze Pane marks do not print. 

Functions are predefined formulas including math operators.  You supply the necessary cell 
references.  

• format: equal sign, function name, cell references; e.g., =SUM(A1:A13)  
choose Insert menu, Function command to view functions available or use  

Function Wizard  tool 
• IF -- checks for True or False condition and returns a value; =IF(logical test, value if 

true, value if false)  
• MAX -- returns the highest value in a range; =MAX(range)  
• MIN -- returns the lowest value in a range; =MIN(range)  
• COUNT -- counts the number of entries in a range; =COUNT(range)  
• ROUND -- rounds a value to a specific number of decimal places; =ROUND(value, 

decimals)  
• NOW -- returns system date; =NOW( )  
1. Choose the function to use in calculating Reg. Pay  

o Select cell G4  
o Insert menu, Function command  
o Select Most Recently Used and choose IF function  
o Click OK  

2. Change the arguments within the function to formulas with cell references  
o In the "logical_test" area, enter (Hours <= 40)  
o In the "value_if_true" area, enter (Hours * Rate)  
o In the "value_if_false" area, enter (40 * Rate)  
o Select OK  

 
NOTE: Completed formula should be =IF(E4<=40,E4*F4,40*F4)  
   

3. Fill down, cells G4:G33  
o select cells G4:G33  
o Edit menu, Fill Down command  
o OR use AutoFill  

4. Choose the function to use in calculating OT Pay  
o select cell H4  
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o Click the  Function Wizard tool  
o Select Most Recently Used category and choose IF function  
o Select OK  

5. Change the arguments within the function to formulas with cell references  
o In the "logical_test" area, enter (Hours > 40)  
o In the "value_if_true" area, enter (Hours-40) * (1.5 * Rate)  
o In the "value_if_false" area, enter (0)  
o Select OK  

NOTE: Completed formula should be =IF(E4>40,(E4-40)*(1.5*F4),0)    
6. Fill down, cells H4:H33  

o Select cells H4:H33  
o Edit menu, Fill Down command  
o OR use AutoFill  

7. Calculate Gross Pay select cell I4  
o =g4+h4  
o Press Enter  

8. Fill down, cells I4:I33  
o Select cells I4:I33  
o Edit menu, Fill Down command  
o OR use AutoFill  

9. Enter your name in cell A1  
10. Quick Save your worksheet (CTRL + S)  
11. Preview the worksheet  
12. Close the worksheet  

Payroll  example 
  A B  C  D E F G H I 

3 Last 
Name 

First 
Nam
e 

SS 
# 

Department Hour
s

Rate Reg. 
Pay 

OT 
Pay 

Gross 
Pay

4 Smith Jim 098-
76-
543
2 

Marketing 30 7.50 225.0
0 

0.00 225.0
0

5 Alexande
r 

Aaron 123-
44-
556
6 

Accounting 40 8.75 350.0
0 

0.00 350.0
0

6 Evans Nanc
y 

123-
45-
678
9 

Administratio
n 

45 8.00 320.0
0 

60.0
0 

380.0
0

7 Jackson Dot 234-
56-
780
9 

Accounting 40 10.0
0

400.0
0 

0.00 400.0
0

8 Jones Joe 234-
56-
789
0 

Marketing 43 7.75 310.0
0 

34.8
8 

344.8
8

 
Excel's formatting and annotating features are extensive. However, data is 
often better displayed in a graphical form. This handout discusses how to 
create and edit graphs in Microsoft Excel. 
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Creating a Chart 
With Excel’s Chart Wizard, creating graphs is an easy point-and-click process. 
 
Selecting data 
The first step in creating a chart is to select the data you want to graph. Select 
both the numeric data and adjacent row and column labels; Excel uses the 
labels for legend and axis information. For example, in the figure below, select 
cells A4:D8 to graph the monthly figures for each city. 

 
  

If the data is not contiguous, use Excel’s multiple selection technique; select 
the first range of data, hold down the Control key then select the second 
range of data. 
 
Chart Wizard 
The Chart Wizard guides you through each of the steps necessary to 
create a professional-looking chart. After you select the data you want to 
chart, click the Chart Wizard button on the toolbar. The Chart Wizard displays 
a series of step-by-step questions and dialog boxes that prompt you for 
information about the chart. 
 
Step 1 of the Chart Wizard lets you choose the type of chart you want. Select 
the type of chart in the left column, and then choose the sub-type in the right 
column. For example, to create a Column chart, select Column and then 
choose the Column chart sub-type. 
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After you complete a step in the Chart Wizard, click the Next button to 
continue to the next step. In Step 2, specify the location and orientation of 
your data. If you selected data before clicking the Chart Wizard, those cells 
appear in the Data Range box. The Series section controls which labels 
appear on the X-axis. In the above example, if you choose Series in Rows, 
the month labels appear on the X-axis. Series in Columns creates a chart with 
the city labels appearing on the X-axis. 
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The Series Tab in Step 2 also lets you change labels for your data and axes.  
Step 3 of the Chart Wizard presents numerous options ranging from Chart 
Titles to Legends and Gridlines. To change one of these options click the tab 
at the top of the Step 3 dialog box. For example, to control where the Legend 
appears, click the Legend Tab and select the appropriate Legend placement. 
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In Step 4, the Chart Wizard prompts you for a chart location. You can create 
the chart on the same worksheet as the data or on another worksheet. Click 
Finish after you select the location for your chart. 
 

 
  
Manipulating the Chart 
An Excel chart is a worksheet object. Like other worksheet objects, you can 
move it, change its size, delete it and place borders around it. 
 
Changing the chart size  
To change the size of a chart, click on the chart to select it. Small selection 
boxes appear on each corner of the chart. Drag one of the selection handles 
to make the chart larger or smaller. 
 
Moving the chart  
To move the chart, press the mouse on the border of the chart and drag the 
mouse. 
 
Deleting a chart  
Select the chart and press Delete or Backspace to delete it. 
 
Changing charted data  
Charts are linked to the selected data. Whenever the data changes, the chart 
adjusts to reflect those changes. For example, if the January Austin numbers 
increase to 100, the January Austin bar in the chart increases.  
 
Editing and Formatting a Chart  
The figure below illustrates the major components of a column chart. To 
modify any component of an Excel chart, double-click it. For example, to 
change the font of the chart title, double-click the title to activate a font dialog 
box. Double-click the y-axis to activate the Format Axis dialog box. 
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Using the Chart toolbar  
Use the Chart toolbar (shown below) to change the chart type, add gridlines 
and a legend, or change the orientation of the chart. The Chart toolbar 
normally appears when you select a chart. If the Chart toolbar is not visible, 
use the Toolbars command on the View menu to display it. 
 

 
 

Formatting a chart  
When the chart is selected, the Selected Chart Area command on the 
Format menu  lets you place a border around the chart or shade it with 
different colors and patterns. 
 
Adding titles and labels 
To add a title to the chart or one of the axes, choose Chart Options from the 
Chart menu. Note, the Chart menu is only visible when the chart is selected. 
Click the Title tab in the Chart Options dialog box and type the chart title and 
axis labels in the appropriate boxes. 
 
Adding and deleting arrows 
Often a chart contains information that you want to highlight or emphasize. To 
create an arrow on a chart, click the Arrow tool on the Drawing toolbar and 
drag a line where you want the arrow to appear. If the Drawing toolbar is not 
visible, use the Toolbars command on the View menu to display it. After 
Excel adds the arrow, change its length by dragging the selection handles at 
either end of the arrow. To delete an existing arrow, select it and press  
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Delete. 
 
Bar patterns and colors 
You can change the color and pattern of each column to accommodate 
different situations. If you print the chart, you might wish to select black and 
white patterns more suitable than the default choices. When you double-click 
any column or pie slice, Excel activates the Format Data Series dialog box. 
Use this option to change both the color and pattern of the selection. 
 
Formatting the axes 
Excel lets you change many characteristics of a chart axis. For example, you 
can change the font used on the axis labels or the scale. To choose different 
formats for an axis, double-click it and select the appropriate options from the 
Format Axis dialog box. 
 

 
 

  
Adding new data to a chart 
To add data to a chart, select the data on the worksheet and then, using the 
border of the selected data, drag it onto the chart. The Add Data command 
on the Chart menu can also be used to add data to an existing chart. To 
remove data from a chart, select Source Data from the Chart menu, click the 
Series Tab and click the Remove button.  
 
Inserting data labels and trendlines 
Data labels identify the precise value associated with a particular point on a 
chart. Choose Chart and Chart Options. The Chart Options dialog box has 
a tab called Data Labels used to include labels in a chart.  
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A trendline is a best-fit line for a series of data. To create a best-fit line, select 
a series of data and choose Chart then Add Trendline. Choose the Linear 
Option for a best-fit regression line. 
 
Printing a Chart 
You can print a chart on a worksheet by itself, or print the chart along with its 
accompanying data from a worksheet. 
 
Printing a chart by itself  
To print a chart by itself, select the chart and choose File Print. Make sure 
Selected Chart is chosen in the Print dialog box. 
 
Printing charts with worksheet data  
You might also want to print your chart with its accompanying data. You can 
include any worksheet object (chart, text field, clip art) in your printed report 
by simply selecting the cells underneath the worksheet object. When you 
choose Print, click Selection to print the selected cells, which will include the 
chart.  
 
TOOLS 
Check spelling 

1. Select the range of cells you want to check.  
To check the entire sheet, click any cell.  

2. Click Tools  Spelling  
3.  

Protect The Worksheet 
On the Tools menu, point to Protection, and then click Protect Sheet/Protect 
Workbook and type password. 

 

  EXERCISE 
1. Create a new worksheet (Part I - Creating a Spreadsheet)  
2. Enter amounts and labels as shown in the "4th Quarter Sales" worksheet (Part I - 

Creating a Spreadsheet)  
3. Add Bold to cells A1, A2:F3, A12, A18 (Part I - Formatting the Worksheet; Font 

Formatting)  
4. Right-align cells B2:F3 and B4:B9 (Part I - Formatting the Worksheet; Alignment 

Formatting)  
5. Format cells B14:B15 for % with zero decimals (Part - I - Formatting the 

Worksheet; Number Formatting)  
6. Calculate Product Totals (Part I - Introduction to Formulas)  
7. Calculate Total Sales by Employees (Part I - AutoSum)  
8. Calculate % Total Sales as Total Sales by Employee / Total of Prod. Totals [ ABS ] 

(Part I - More About Formulas)  
9. Format cells C13:E13 for % with zero decimals (Part I - More About Formatting)  
10. Calculate Commissions as Commission % [ ABS ] * Total Sales of Employee (Part I - 

More About Formatting)  
11. Calculate Bonus as If % Total Sales >= 20%, Total Sales * Rate [ ABS ] (Part I - 

Additional Functions)  
12. Calculate Total Incentives as Commission + Bonus (Part I - Additional Functions)  
13. Copy A4:B9 to A19 (Part II - Cutting, Copying and Pasting Information)  
14. Calculate Average Amounts Sold (Part II - Exercise in Cutting, Copying and 

Pasting)  
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15. Format cells C4:F10, C14:E16, and C19:C24 as comma with two decimals (Part II - 
Reviewing Formatting)  

16. Add double lines above Row 2 and below Row 3 (Part II - Borders, Lines and 
Shading)  

17. Add single lines above and below Row 10 (Part II - Borders, Lines and Shading)  
18. Enter your name in cell E1  
19. Save as "4th Quarter Sales" (Part I - Saving the Worksheet)  
20. Preview the worksheet (Part I - Print Preview)  
21. Center the worksheet horizontally (Part I - Formatting the Worksheet)  
22. Print the worksheet (Part I - Printing)  
23. Save the worksheet (Part I - Saving the Worksheet)  
24. Close the worksheet (Part I - Printing)  
 

  A B C D E F 

1 4th Quarter Sales         

2           Product 

3 Product Product # Brown Jones Smith Totals 

4 Stationery 127-45 450.25 300.00 100.00 850.25 

5 Envelopes 138-45 300.50 150.90 75.10 526.50 

6 Forms (1) 067-34 350.10 200.78 100.25 651.13 

7 Forms (2) 238.34 275.75 125.50 75.50 476.75 

8 Staples 011-12 50.80 75.75 100.00 226.55 

9 Tape 345-12 75.30 50.00 150.00 275.30 

10 TOTAL SALES BY EMPLOYEE 1,502.70 902.93 600.85 3,006.48 

11             

12 INCENTIVES           

13 % Total Sales   50% 30% 20%   

14 Commissions 10% 150.27 90.29 60.09   

15 Bonus 18% 270.49 162.53 108.15   

16 Total Incentives 420.76 252.82 168.24   

17             

18 AVERAGE AMOUNTS SOLD         

19 Stationery 127-45 283.42       
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20 Envelopes 138-45 175.50       

21 Forms (1) 067-34 217.04       

22 Forms (2) 238.34 158.92       

23 Staples 011-12 75.52       

24 Tape 345-12 91.77       
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MS ACCESS 
 

Ms. Rekha S. 
IBM CREC Centre, Calicut 

 
 

The popularity of the MS Office suite of applications has been pretty amazing 
over the past couple of years. However, the other applications included in this 
suite can be mastered with a little motivation and some training. However, the 
Access relational database application has put the creation of relational 
databases, that had previously been mostly in the hand of programmers, into 
the hands of common computer users in all walks of life. Of course, since 
Access is installed on your computer, you are probably required to at least 
have a working knowledge of what it will do for you and/or your boss! 
The following are the specific objectives. 

• Gain knowledge about relational databases in general.  
• Understand when and why Access is useful to you.  
• Learn basic terminology in Access to facilitate learning & other communication.  
• Learn to design a database that is useful and appropriate for your needs.  
• Create, manipulate, retrieve, and output data accurately & quickly.  
• Understand the use of multiple tables.  
• Create and use forms, reports, and queries.  
• Understand a "relationship" in Access and how & why to create a "relationship".  
• Use wizards & templates included in Access to assist you in creating objects.  
• Learn how to successfully use Query & Reports in Access.  
 

Introduction 
 
What is a database? 
A database is a collection of data, which is organized in a manner that can be 
easily retrieved. They consist of fields, records, and files, much like a 
telephone book. A field is a single piece of information (your last name is one 
field); a record is one complete set of fields (your entry in the telephone book 
is a record); and a file is a collection of records (the entire telephone book). 
When you look at the phone book for someone's telephone number, you are 
the "search engine" for the telephone book database. The only difference is 
that the search engine included with database programs is probably a little 
faster than you are at retrieving information. 
 
What is a Relational Database? 
A relational database is a single database spread across multiple tables. 
Think of a database as a file cabinet and each drawer of the file cabinet is a 
table. 

Example. All of the employee 
information is kept in the first drawer; 

all of the vendor information is kept in the 
second drawer; and all of the purchase orders 
are kept in the third drawer. To connect each 
of these drawers (which is what makes it 

"relational"), a set piece of data from 
one drawer has to be present in one of the 
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other drawers. 
For instance, a purchase order will have a vendor name, address, & phone 
number on it, along with the items purchased, purchase price, and any 
discounts. If the vendor name is the "set" piece of data, it is entered in the 
purchase order table, but the address & phone number are retrieved from the 
vendor table instead of having to re-type that information each time it is 
needed in the purchase order table. 
 
When Should I Use Access to Store Data? 
Databases, like Access, are used to store large quantities of information. The 
information can be viewed, sorted, manipulated, retrieved, and printed in 
various ways. The database gives you the flexibility to obtain this data in 
multiple formats. If the information you need to store is vast, interrelated, and 
you need to retrieve it fast & accurately, Access is probably the way to go. 
 
Terms and Definitions 

Field  
The smallest piece of data in a table.  
Cell  
Where one row and one column intersect on a table.  
Record  

A collection of all fields relating to one person, place, or thing (i.e., Cindy Ireland's 
mailing address) occupying a single row of a table.  

Table  
A collection of records (i.e., all WSU employee's mailing address information) with 
one record occupying a single row with one or many fields per row. A database can 
consist of multiple tables.  
Query  
Asks specific questions about the data in the database.  
Forms  
A method of entering, displaying, and searching data in other than the spreadsheet-
like environment of tables and queries (a graphical user interface).  
Reports  
Summarizes and formats data in the "look" that you want for either table or query 
data.  
Object  
Components that make up a database (i.e., tables, forms, queries, reports, macros, & 
modules).  

 
 
Let's Look At Access  
The Access database window is the initial screen you are given. This is where 

all objects can be 
manipulated. As with all 
Windows 95 programs, 
you can close, maximize, 
and minimize your 
program window by 
clicking on the icons in 
the far upper right corner 
of the window (the X 
closes). The Title Bar is 
the area where the 
program name is 
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displayed - in this case, MS Access. The menu bar is between the Title Bar 
and the Tool Bar. You can select functions by selecting the options from the 
various menus. 
 
Object Tabs allow you to select the object area you wish to work with (i.e., 
tables, forms, queries). Mode Buttons include Open, Design, and New -- 
these allow you to create new objects or edit existing ones. The window 
where the objects are located is also call the Database Window. 
 
TIP: Place your pointer on any area of the Access database window and a 
text box will be displayed describing what that area is called. This is called a 
screen tip. 
 
Naming Conventions 
Consistency when naming the objects in your database is important. The LNC 
(Leszynski Naming Convention) is the most widely recognized. It states that 
one should precede each object name with a three letter tag to indicate the 
type of object. The object name should begin with a capital letter, no 
underscores or spaces are used. 
 
The logic behind this type of naming convention is ease of use. Also, if you 
left your current job to accept another job that pays way more money, better 
benefits, brand new office furniture & computer, and your new boss is 
absolutely the most wonderful person to work for.....Well, you get the picture, 
you need to have your Access database setup so anyone could easily use it. 
Thus, the need to use this naming convention. 
 
However, you may wish to continue using these conventions for your personal 
or business use. 
 

 Object Name Access Tag 
Table tbl 
Form frm 
Query qry 
Report rpt 
Macro mcr 

 
As an example, if we create several forms to aid in data entry, we might name 
the forms: frmEmployee, frmPhone, frmDepts, etc. 
 
Designing a Database 
 
Objectives 

• Learn to sketch out your database prior to opening Access.  
• Learn to create a new Access database.  
• Understand the use of multiple tables in your database.  
• Create multiple tables.  
•  

 Designing Your Database 
There are specific steps you should follow when designing your database: 
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1. Determine the purpose of your database. This will help you decide what data you 

want your Access database to store.  
2. Determine the tables you will need. Once you have a clear purpose for your 

database, you can divide your information into separate subjects, such as 
"Employee" or "Orders". Each subject will be a table in your database.  

3. Determine the fields that you will need in your tables. Decide what specific pieces 
of information you want to store in each table. Each category of information in table is 
called a field and is displayed as a column in the table. For example, one field in an 
Employee table should be Last Name; another could be Hire Date.  

4. Determine the relationships. Look at each table and decide how the data in one 
table is related to the data in other tables. Add fields to tables or create new tables to 
clarify the relationships, as necessary.  

5. Refine your design. Analyze your design for errors. Create the tables and add a few 
records of sample data. See if you can get the results you want from your tables. 
Make adjustments to the design as needed.  

 
Complete these steps using a piece of paper and a pencil or a whiteboard - 
anything erasable. You will probably revise these many times before you have 
a final design. Experiment with sample data and models of your forms and 
reports. Make sure the database design stores the data in the manner you 
need, retrieves the data correctly, and gives you the output (printed 
document) that you require. It is much more difficult to make changes to the 
tables, forms, and reports after real data is entered. Double-check your design 
to make sure it contains all the data you will require BEFORE entering the real 
data. 
 
 
 
 
Common Design Problems 
There are several common pitfalls to keep in mind as you design your 
database. These problems can cause your data to be harder to use, maintain, 
and retrieve. The following are signs that you should reevaluate your 
database design: 
 

• You have one table with a large number of fields that don't all relate to the same 
subject. For example, one table might contain fields pertaining to your customers as 
well as fields that contain sales information. Each table should contain data about 
only one subject.  

• You have fields that are intentionally left blank in many records because they aren't 
applicable to those records. This usually means that the fields belong in another 
table.  

• You have a large number of tables, many of which contain the same fields. For 
example, you have separate tables for January sales and February sales, or for local 
customers and remote customer, in which you store the same type of information. Try 
consolidating all the information pertaining to a single subject in one table. You may 
also need to add an extra field, for example, to identify the sales date.  

 
Creating a Database Part I 
Open your Access  program. Click the Start button - highlight Programs - find 
your reference to Microsoft Access and click on it. The Access  program will 
start. 
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Select Blank Database from the window that appears. Select the folder or 
directory that you want your database saved to and give it a filename. Click 
Create. 
 
A database window will be displayed. You can also use the Access wizards to 
create a new database if you wish; The Database Wizard creates all objects 
needed for your database as well as other objects that we will not be using in 
this workshop.  
 

Exercise 1: Create a new Blank Database now. Use the 
directions in the above paragraph to complete. 
 

 Creating Multiple Tables 
 

Exercise 2: Create a table named tblStudents. 
To create a table in a new database, click on the Tables tab in 
the database window. Click on the New button on the right side 
of the window. A "New Table" window is displayed. Select Table 
Wizard from this list and click OK. [NOTE: the wizard is a quick 
and easy way to create new objects.] 
Select Students from Sample Tables list and then each of the 
following fields (highlight field and click the arrow that points to 
the right): StudentID, LastName, FirstName, Major, 
PhoneNumber, EmailName, and StudentNumber. Highlight 
StudentNumber and click the RenameField button at the bottom 
of the field list. Rename it to AdvisorNumber and click OK. Click 
the Next button to go on. 
 
Rename this table to tblStudents and leave the "Yes, sets the 
primary key for me." from the center of the window. Click Next to 
proceed. StudentID will be the field that is unique on each 
record and let Access automatically number this field (is much 
easier). Click Next. 
 
The final screen of this wizard allows you to begin entering data 
immediately, make design changes to the table, or enter data 
using a form that the wizard will automatically create. Select 
"Enter the data into the table using a form the wizard creates for 
me" and click Finish. Exit the form when it is displayed. 
 
Click on the Form tab, highlight the form that was automatically 
created, right click on the form name, select Rename from the 
menu, and rename it frmStudent. 
 

Navigating Tables 
There are numerous ways to maneuver through an Access table. If you want 
to just look through the table without moving the cursor/highlight, use the 
scroll bar on the right side of the table. However, if you want to move the 
highlight as you move down the table, you can use the down arrow <Dn> or 
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the page down <PgDn> keys. The same is true if you are moving up the table 
- use the up arrow <Up> or the page up <PgUp> keys. 
 
If you want to move the highlight to the very first cell of the table (A1), press 
<Ctrl-Home>. Conversely, if you want to move the highlight to the very last 
cell of the table, press <Ctrl-End>. To move the highlight from field to field, 
use either the <Tab> or <Enter> keys. 
 
Additional keystrokes & navigation tips will be discussed when first mentioned 
in the documentation. 
 
Defining Relationships 
 
Primary Key 
Relationships between tables is a vital part of what makes Access  work so 
well. This one point makes a difference between having a bunch of data and 
having a relational database that helps you be more efficient and effective at 
your job. 
 
Let's use an example to help clarify the relationship issue. We have 
information regarding both Students and Advisors in the College of Agriculture 
& Home Economics. There is related data in these pieces of information 
because each advisor has students to advise and every student has an 
advisor. Of course, this database could be one massive table that might 
contain all the necessary fields: 
Student Last Name 
Student First Name 
Student Major 
Student Phone 
Student Email 
Advisor Last Name 
Advisor First Name 
Advisor Building/Rm 
Advisor Phone 
Advisor Email 
 
The difficulties of this approach are fairly obvious. Suppose one advisor works 
with 20 students. As information on each student is entered, the information 
for the advisor must also be entered. Entering the exact same information is 
tedious work to say the least. Remember: You should only enter any one 
piece of data ONCE. So, instead of entering the same advisor information for 
each of the 20 students, let's separate the data into two different tables with a 
relationship established. 
 
Advisor Table 
Last Name 
First Name 
Building/Rm 
Phone 
Email 
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Student Table 
Last Name 
First Name 
Major 
Phone 
Email 
 
So, how do we identify which students belong to which advisor? We would 
use a Primary Key. A Primary Key is a unique record identifier in each table. 
In our Advisor/Student database example above, there is no field that can be 
used as a Primary Key. Last name for either table is not a good choice - we 
could have duplicates for different individuals. First name in either table is not 
a possibility for the same reason - duplicates are possible. Address, phone, 
and email are not good choices because there can be duplicates but more 
importantly, they can change. Any field that can change is not a good choice 
for the Primary Key. The Primary Key should stay the same from the very 
beginning. 
 

A standard, traditional database practice is to assign an ID number to 
each record. Access  provides us with AutoNumber. This is an integer that is 
incremented with each new record; the first record has an ID of 1, the next 
has an ID of 2, etc. Our ID field in each table becomes the Primary Key, the 
unique identifier for each record. This number stays the same regardless of 
how it is sorted or queried or printed. It is a static field. 
 
Relationships 
Now we need to look at how these two tables are related, how exactly 
advisors are related to students. Each student has one advisor but each 
advisor can have many students. This is called One-To-Many Relationship. 
Wow, something that makes sense! 
 
The basic rule for establishing a One-To-Many Relationship is: make the table 
with the many point to the table with the one. In our example, Student is the 
table with many (remember, one advisor has many students) so we want to 
add a field to the Student table that points to the Advisor table. The new field 
we create needs to point to the Primary Key (ID) of the Advisor table. The 
Advisor ID field in the Student table, since it refers to the Primary Key of 
another table, is known as a Foreign Key. The Foreign Key must be the 
same field type (Number) as the Primary Key. 

The easiest way to set a primary key is to let Access set it for you in 
the Table Wizard. 
 
Designing a Database (Part II) 
 
Objectives 

• Learn to create a table from scratch.  
• Learn to a create a form.  
• Become familiar with entering data into a table and a form.  
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• Create a logical relationship between tblStudent and tblAdvisor.  
• Set Primary Keys & Foreign Key in tables. 
•   

Creating a Table from Scratch 
In order to gain much more control over the development of a database table, 
you can create it from scratch using Design View. In Design View, you enter 
your own field names, descriptions, and choose your own data type to 
associate with each field. You also set your own Primary Key. 
 
Before creating a table entirely from scratch, you should write down your 
basic table structure on paper, focusing particularly on field names and data 
types. Access fields can have one of the following data types: 
 

 Data Types  Definition 

 Text Stores text or combinations of text and numbers (i.e., 
addresses) up to 255 characters. 

 Memo Stores text and numbers with up to 64,000 characters; 
used for detailed, descriptive fields. 

 Number Stores numeric data that you can use in calculations. 
 Date/Time Stores a field in date or time format. 
 Currency Stores currency data that you can use in calculations. 
 AutoNumber Stores a sequential number for each record. 

 Yes/No Stores only one of two values such as Yes/No, 
True/False, or On/Off. 

 OLE Object 
Stores objects created in another application, such as 
Word  or Excel , that you can link to or embed in an 
Access table. 

Hyperlink Stores a link to a URL. 

Lookup Wizard Stores a lookup column that you can use as a lookup in 
another table. 

 
While it will not be necessary for you to know all of these data types it is a 
good idea to have a general knowledge of the possibilities in defining the data 
fields. 
 

Exercise 1: Create a new table from scratch. 
Click on the Tables tab in the Database Window. Click on the 
New button; a New Table dialog box opens. Click on the Design 
View option and click OK. A blank table will open in  Design 
View. 
 
Type ID in the first Field Name column, press <Tab> to go to the 
Data Type column. [Text automatically appears in the Data 
Type field as soon as you press the <Tab> key but you can 
select from any of the 11 options on the list.] Click the down 
arrow to the right of the field & select AutoNumber from the list. 
<Tab> to the Description column & type in a brief description of 
this field (i.e., Advisor Last Name, Advisor Office Phone). 
 
Repeat the steps in the above paragraph for each of the 
following field names, all are Text data types: LastName, 
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FirstName, Address, PhoneNumber, and EmailName. When you 
are finished, your screen should look similar to this picture. 
 
Exercise 2: Set a Primary Key 
Click on the ID field. [Remember, Primary Key is a field that is 
unique in each record of the table.] An arrow will appear in the 
field selector column (far left). Click the Primary Key button on 
the menu bar. [See screen capture to identify exact location.] 
The arrow in the field selector column will turn into a key symbol. 
This is a toggle field so if you need to remove the primary key 
from this field, select the primary key field and click the Primary 
Key button on the toolbar again. 
 
Exercise 3: Set Format Properties 
Access  always sets each field with the default format for its data 
type. This format defines how the field displays in tables, forms, 
and reports. You may want to change this format to one of the 
other options. For example, a date/time data type can be 
changed to display long (Tuesday, July 7, 1998) or short 
(7/7/98). 
 
In Design View, add a new field (Date) to the existing table. The 
Data Type should be Date/Time. Make sure this field name is 
selected (the arrow should be displayed in the field selector 
column). The General tab should be displayed below. Click on 
the Format field. A down arrow is displayed at the right edge of 
that field, click on the arrow. A list of possible formats is 
displayed. Select the format of your choosing. A diagram might 
help. 
 
Exercise 4: Set Field Size Properties for Text Fields 
The default field size for a text field is 50 characters. You can 
change this size to any amount from 0 to 255 characters. 
Click the field selector column of the field name you wish to 
change. Click the General tab in the Field Properties. Enter the 
new field size in the Field Size text box. A picture is worth 1,000 
words! 
 
Save your table [File-Save] as tblAdvisors. 
 

Entering Data 
There are a couple of notes of interest before you begin the next group of 
exercises. Telephone number fields will include the area code parentheses 
when using the wizard - not a huge deal. 
 

Exercise 5: Enter Advisor Data 
Enter the following information directly into the tblAdvisor 
previously created. Notice that you can use the <Tab> or 
<Enter> keys to move from field to field. Use the arrow keys to 
move around the table fields as well. 
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Joe Smith, 423 Hulbert, 335-1111, joe_smith@xwsu.edu 
Jane Zane, 211 Food Science, 335-7777, jane_zane@xwsu.edu 
Bryan Brown, 333 Clark, 335-6666, bryan_brown@xwsu.edu 
Access will create an ID number automatically for each of these 
records as you create them. Do NOT type a number in the ID 
field, it contains the words (AutoNumber). After you have 
entered the above data, close the table. Save and close the 
table. 
 

  Exercise 6: Enter Student Data 
Now enter the following data using the form, frmStudent. Find 
the Advisor number from the table above and enter that, not the 
advisor's name, in the Advisor ID field. 
 
Shawna Davis, 335-7676, Ag Econ, sdavis@stu.wsu.edu, Joe 
Smith (advisor) 
 
Jerry Turner, 333-2222, Food Science, jturner@stu.wsu.edu, 
Bryan Brown (advisor) 
 
Sherry Vineyard, 333-1111, Natural Resources, 
vineyard@stu.wsu.edu, Jane Zane (advisor) 
Deke Einstein, 335-7799, Ag Econ, einstein@stu.wsu.edu, Joe 
Smith (advisor) 
 
Jay Terry, 333-0000, Natural Resources, jterry@stu.wsu.edu, 
Jane Zane (advisor) 
 
Save and close the table. 
 

Creating a Relationship 
In order to create the relationship between the two tables in our example, you 
need to identify the primary key and the foreign key. 
 

Exercise 7: Set the Foreign Key 
You have allowed Access to set your Primary Key and you have 
set the Primary Key on your own . 
 
The Foreign Key in the tblStudent table must be the same data 
type (Number) as the Primary Key in the tblAdvisor because that 
is the link between the two tables. To check this, from the 
database window, highlight tblAdvisor and click the Design 
button. 
 
The ID field is highlighted. The data type is "AutoNumber" and 
the Field Size is "long integer". Find those two fields. Close this 
window. 
 
Highlight the tblStudents from the database window and click 
the Design button. Highlight the AdvisorNumber field. Click the 



 72  Computer Skills for Biologists  

 
 

Data Type in the AdvisorNumber field and a pull-down arrow 
appears. Click on that arrow and select "number" from the list; 
"long integer" should appear in the Field Size field automatically. 
This step MUST be completed before progressing to Exercise 8. 
 

In some database programs, this is sufficient - defining the Primary and 
Foreign Keys. But with Access, we have to specifically define the relation 
between these tables. 
 

Exercise 8: Create a relationship between tblStudent and 
tblAdvisor 
From the Tools menu, select Relationship. A "Show Table" 
window is displayed. Add the tblAdvisor and tblStudent to the 
Relationships screen and close the window. Two lists are 
displayed - each containing the field names in each of the 
tables. 
To actually join the two tables, use the mouse and click the ID 
field in the Advisory table (our Primary Key). While holding down 
the mouse button, move the cursor over to the Advisory Number 
field (our Foreign Key) in the Student table list. 
 
A "Relationships" window is displayed (NOTE: If you click on the 
"Tables aren't related" option, you can undo a table relationship 
you previously made.)You'll notice that under Relationship Type 
that One-To-Many is already selected. Also, check the Enforce 
Referential Integrity to insure that data entered in the Student 
Advisor ID field can not be a value that does not exist in the 
Advisor table. Click the Create button. 
 
After the relationship is created, the Relationships screen shows 
a connection between the Primary Key and Foreign Key fields. 
Notice that the Advisor table has a 1 while the Student table has 
an infinity sign. Together, this signifies the One-To-Many 
relationship. 
 
Save and Close. Exit the database. 
 

Now that the relationships are defined, it is easy to begin creating queries, 
forms, and reports. 
 
Wizards & Templates 
 
Objectives 

• Learn how wizards can make quick work of designing objects.  
• Learn to modify the wizards' work.  
• Learn how to change the default template.  
•  

Using the Wizards 
You have already used the wizards to create Tables and Forms. Most of the 
wizards are fairly similar in their operation with some obvious differences in 
regards to specific information. The Wizards will walk you through the basic 
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process of creating an object without you having to know the exact steps. 
They can make working with Access  much easier, especially for the novice. 
Suppose we want to build a form so we see the advisor information listed 
once along with information on each of the students assigned to that advisor. 
 

Exercise 1: Create a form & subform. 
1. To create a new form, click the Form tab in the Database window, then click 

the New mode button.  
2. Since we have already designed the tables and defined their relationship, we 

can run the Form Wizard and let Access do most of our work for us. You can 
select the Advisor table from the field designated or leave it blank.  

3. The first question the Wizard asks is: Which fields do you want on your form? 
For this example, let's select all the fields from both the Advisor table and the 
Student table. [A quick tip: the double arrows take everything from one side 
to the side where the arrows are pointing.] Click the Next button to continue 
with the Wizard.  

4. The next question the Wizard asks is: How do you want to view your data? 
The default view is a form with a subform. This is the best option for what we 
want in this exercise. The advisor will be listed once in the main part of the 
form and all students advised by the advisor will be listed in a subform 
underneath.  

5. For the layout option of the subform, the choice is an aesthetic one between 
the datasheet and tabular options.  

6. Finally, the Wizard asks us for a style (again a purely aesthetic choice) and 
then asks us what we want to name our forms.  

7. Change the Form name to frmAdvisors and the Subform name to 
frmStudtsSub. Click the Finish button to complete the Wizard.  

8. When the Wizard does its work, a very nice looking form is generated. Notice 
that the advisor is listed once at the top of the form, and all his advisees are 
listed below in the inset window.  

9.  
Access has a great feature at the bottom of the form screen, it is a record 
number bar that allows you go to the next record, the first record, the last 
record, or any specific record you choose. The arrow keys take you to (from 
left to right) the first record, the previous record, the number field where you 
can type in a specific record number & press <Enter> to move to that record 
above, the next record, the last record, & the * creates a new record. 
 
Making Changes 
After creating an object using a wizard, you may find that you need to make a 
change, either minor or major. Access allows us to edit the objects that are 
created with the Wizard. 
 

Exercise 2: Modify Object 
Part A: Change the name of the form we just created to 
frmAdv/Stu and change the name of the Student subform to 
frmStuSubform. [To rename an object, right click on the object 
name, and select Rename from the pop-up menu.] Now when 
you open the Adv/Stu form you get an error that says it can't 
find the old form name -- major problem! 
 
First thing you have to do is to edit the part of the frmAdv/Stu 
that points to the old student subform name. To do this, highlight 
the frmAdv/Stu from the database window, Form tab. Click the 
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Design mode button on the right. The same error about not 
finding the student subform is displayed - click the button to 
continue. Inside the inset subform is the name of the subform 
form. Click the cursor on that name and change it to the correct 
form name (frmStuSubform). Click File - Save. 
Part B: While still in Design mode, you can also change the field 
labels (aka captions). Click once on the field label to select it, 
right click to access the pop-up menu, and select Properties. 
The Caption field is the second item, double-click on it and 
change it to a caption of your choice. Click the X in the upper 
right corner of the dialog box to close. Your change will 
immediately be displayed on your form. 
 

Using Templates 
When you create a form or report without using a wizard, Microsoft Access 
uses a template to define the default characteristics of the form or report. The 
template determines which sections a form or report will have and defines 
each section's dimensions. The template also contains all the default property 
settings for the form or report and its sections and controls. 
The default templates for forms and reports are called Normal. However, you 
can use any existing form or report as a template. You can also create a form 
or report to use only as a template. 
 
Specify a new template for forms and reports: 

1. On the Tools menu, click Options.  
2. Click the Forms/Reports tab.  
3. Type the name of the new template in the Form Template or Report Template box. 

Note: You can use an existing form or report as a template, or you can create a form 
or report specifically for use as a template.  

4. Click OK.  
 

Notes 
• Changing the template doesn't have any effect on existing forms or reports.  
• A template doesn't create controls on a new form or report.  
• Microsoft Access saves the settings for the Form Template and Report Template 

options in your Microsoft Access workgroup information file, not in your user database 
(the .mdb file). When you change an option setting, the change applies to any 
database you open or create. To see the name of the template that is currently used 
for new forms or reports, click Options on the Tools menu, and then click the 
Forms/Reports tab.  

• To use your templates in other databases, copy or export the templates to them. If 
your templates are not in a database, Microsoft Access uses the Normal template for 
any new forms and reports you create. However, the names of your templates appear 
in the Form Template and Report Template options in every database in your 
database system, even if the templates are not in every database.  

 
Query and Reports 
 
Objectives 

• Create a query from scratch (no wizards).  
• Learn the importance and usefulness of the Datasheet View.  
• Revise existing queries.  
• Create and revise a report.  
 

What Is A Query? 
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A query is the question you ask, such as "Who are the students that Bryan 
Brown advises?", not the results (i.e., Jerry Turner). You may have several 
queries created as they may ask different specific questions. Once you have 
created a query, you can run it as often as needed because the results will 
change each time the table data is changed. 
When you begin to design your queries, ask yourself: 

• What specific question do I want to answer?  
• What pieces of data (fields) do I need displayed?  
• What sort order will help me the most?  
 

Datasheet View Explained 
The Datasheet View is where you design and revise your queries. It allows 
you to select which tables and/or queries you will use in the Query (upper 
pane). You can also select the fields to use in the results or in filtering specific 
records to include or exclude, and how the results are sorted (by which field). 
 

Exercise 1: Create a New Query 
1. From the Query tab of the Database Window, click the New button.  
2. From the New Query dialog box, select Design View and click OK.  
3. From the Show Table dialog box, select the table (tab), query (tab), or the 

both (tab). Then select the object(s) you wish to use in this query - you will 
select tblAdvisors from the Table tab, click Add button. Select tblStudents 
and click Add button again. Then click Close button.  

4. Select the following fields to include in the query. Remember that the fields 
appear in the same order in the design grid as they will in the result. Drag 
field name from upper pane to lower pane or click in blank field box (lower 
pane), click the drop-down arrow to see all possibilities, select appropriate 
field. 

*Advisor First & Last Name 
*Advisor Email 
*Student First & Last Name 
*Student Major  

5. Decide to include all field in results (click Show box to display).  
6. Select File - Save and name it qryClass - click OK.  
7. Run (click the ! button in the toolbar). Results are displayed in Datasheet 

View.  
8. You can print the results at this point. Click the X in the upper right corner of 

the results screen to exit.  
 
 
 

Controlling the Order of Records (Sorting) 
Sorting records based on the contents of one or more fields can make 
reviewing and editing easier (i.e., alphabetical order by student name). By 
controlling the order that records are displayed and/or printed, you can create 
a document that would be helpful to you, your boss, or your clients. 
 

Exercise 2: Sorting 
1. To add a sort to your query, click the Query tab from the Database Window, 

highlight the query you wish to add the sort to, and click the Design mode 
button on the right.  

2. In the lower pane, click on the sort box of the field (Advisor Last Name) you 
wish to sort by.  

3. Click the drop-down arrow to see the list of sort options. Select Ascending 
from the list.  
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4. Run the query (click the ! in the toolbar). Note the differences in how the data 
is displayed.  

 
Include Only Specific Records 
"Criteria" acts like a filter - it filters out certain records and lets others through 
(the ones that meet the criteria stipulations). If you want to limit the results of 
your query, you can set up a specific criteria. If the record meets that criteria, 
it is included in the results. For example, if you only wanted the records for the 
advisor, Jane Zane, you can set the Criteria on the Advisor Last Name 
column to Zane. Only the records with Jane Zane will be displayed in the 
results. 
 

Exercise 3: Using Criteria to Select Records 
1. Return to the Design View of your query.  
2. In the Advisor Last Name column, click on the Criteria field & type 

Brown.  
3. Run the query.  
4. Save this query.  
 

Save the Query 
Remember that when you save a query, you are saving the question, NOT the 
answer (or result). While in the Design View of your query, click the File menu 
option. Select Save from the menu. OR, click the diskette icon on the toolbar 
to save. 
 
Creating & Revising Reports 
You can create new reports based on one or more queries or tables. A report 
is a way for you to display data from a query and/or table in an appealing way 
(i.e., for a presentation). Using the Report Wizard is a great way to create a 
basic report but to revise it, let's walk through an example. 
 

Exercise 4: Create New Report 
1. From the Report tab, click the New mode button.  
2. Select Report Wizard, select tblAdvisors (click the down arrow on the 

right of the blank field), and click OK.  
3. Select all fields from the tblAdvisors and the tblStudents tables 

(remember to use the double arrows to move all the fields over at 
once). Click Next.  

4. Answer the question "How do you want to view your data" by leaving 
it at the default and just clicking the Next button.  

5. Answer the question "Do you want to add any grouping levels" by 
leaving this dialog box at its defaults. Click Next.  

6. Sort by student last name. Click Next.  
7. Leave layout dialog at its defaults but change it to Landscape instead 

of Portrait & click Next to continue.  
8. Select Casual for the title style and click Next.  
9. Change the report name to rptStuAdv and click Finish.  

Don't worry about how your report displays at this point. It 
contains a lot more information than you would probably include 
in any one report. 
 
Exercise 5: Revising an Existing Report 

1. Click on the Report tab and highlight the rptStuAdv report.  
2. Click the Design mode button on the right.  
3. The Design View of the existing report will be displayed.  
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4. Highlight the text in the Report Header and replace it with Students 
and Advisors '98. Right click on the Report Header field and select 
Properties from the list. (If right click doesn't give you a menu, click 
off of the Report Header and then try again.)  

5. Take the slider and move it to the bottom of the Label property dialog 
box. Under Text Align, click your cursor, click on the pull-down arrow, 
and select Center from the choices.  

6. Select the Report Header field (black boxes along edge show it is 
selected) and drag the box, using the right center box, to the right 
edge of the design, and let go of the mouse button. Your title should 
be centered over the text fields now.  

7. Select File-Save and save the report under the same name 
(rptStuAdv).  
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MICROSOFT POWERPOINT 
 

Ms. Rekha S. 
IBM CREC Centre, Calicut 

 
 
Overview of Microsoft PowerPoint  
Presentation software programs, like PowerPoint, have become quite popular 
in the last several years, because they are relatively easy programs to learn 
and people can create attractive materials for giving talks. Keep in mind, that 
there are various ways to use Microsoft PowerPoint:  
 

• To create a "slide show" on the computer that can either run on a stand alone 
computer, like at a general meeting or open house display, or can be projected if you 
have a computer and some type of projection device (like an LCD panel and 
overhead).  

• To create a set of overheads that can be projected using a normal overhead. These 
overheads, however, have more pizzazz then just a Word document using large 
fonts, since there can be a common color scheme throughout the overheads, and a 
consistent use of particular font styles and sizes. If you have access to a color printer 
and can make color overheads, your overheads can be quite impressive. Even if you 
do not have a color printer, if you select your background carefully, the overheads will 
look nicer than if you used Word, and creating them will take less time.  

• To create traditional 35mm slides by printing slides to a film recorder (you print to this 
special device and then take the 35mm film to a developer). Since this film recorder is 
fairly expensive, and you may not own one or have access to one, you can elect to 
take your slide file to a company that provides this service A third alternative is to run 
your slide show on your computer and photograph the screen with a good camera. 
However, this requires experimenting with lens openings and room light settings.  

 
To take advantage of all of the features offered by PowerPoint, like transitions 
and sounds, you need to be giving a "live" talk using a computer equipped 
with special hardware. Even if you don't have the necessary hardware, 
PowerPoint offers features to help you create great looking overheads and 
handouts. 
 
With this background information in mind, you are now ready to move on to 
creating a presentation. 
 
A First Look at the PowerPoint Window  

 Double-click the PowerPoint icon to open PowerPoint. 
 Click Blank Presentation; click OK.  
 Click the Blank Slide layout; click OK.  

 
 

Note the following components.  
           Menu bar - access to menu and commands.  
           Toolbars - icons for frequently used commands.  
                    right-mouse click to add or remove toolbars.  
           New slide button - adds new slides.  
           Slide Changer (move from slide to slide) - vertical scroll box or  
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Previous/Next  slide buttons or Page Up/Page Down buttons on 
the keyboard.  

View buttons - access to different views.  
 

A Closer Look at Views  

 
 

     a.  Examine the Normal View.  
          Displays three panes:  outline pane, slide pane, and notes pane.  
          View and work with one slide at a time.  
          Can add titles and body text, graphs, clip art, pictures, and draw  

shapes.  
          Access to all tools and buttons.  
   
     b.  Examine the Outline View.  
          Information created and organized for all slides in an outline format.  
          Displays all titles and body text.  
          Access to tools and buttons.  
   
     c.  Examine the Slide View.  
          View and work with one slide at a time.  
          Can add titles and body text, graphs, clip art, pictures, and drawn  

shapes.  
          Access to all tools and buttons.  
   
     d.  Examine the Slide Sorter View.  
          Displays organization of all slides in miniature.  
          Can rearrange order of slides, copy slides, and delete slides.  
          Add transitions, build effects and timings.  
   
     e.  Examine the Slide Show View.  
          Displays slides as an electronic presentation on the full screen.  
          Allows you to see the effect of transitions, timings, and animations.  
   
     f.  Examine the Notes View.  
          Select Notes Page from the View menu.  
          Can create speaker notes.  
          Displays page containing an image of the slide and a place to add   
         notes. 
 
View an Existing Slide Show  

 Double-click the PowerPoint folder on the Desktop.  
 Double-click the file named demo.ppt.  
 Choose Slide Show from View menu.  
 Left mouse click to advance to the next slide OR press the space bar.  
 Right-mouse click and choose previous slide OR press P to return to 

previous slide.  
 F1 to see more options.  
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 Examine these features of the slide show:  
                              Animated text  
                              Picture that appears on each slide (Master   

Slide)  
                              How bullet points "fly in from the top"  
                              Esc to leave slide show.  

 
Creating a New Slide Show  
The "New Presentation" dialog box appears. There are three tabs in this 
dialog box. Select the "presentation design" tab to select a template for the 
presentation. By clicking on the various icons that appear as choices, it is 
possible to preview the templates in the box to the right. Select the template 
you wish to use and click the [OK] button to continue. 
 
Design Template Options 
The templates are background patterns created by a graphic artist. After 
picking one of the backgrounds, all the elements in a slide "fit" into the colors 
for that background. That is, the colors for titles and bullets and charts "relate" 
to the color scheme for that template. Typically, the design template also has 
some graphic element that is repeated on all slides, to further help the slide 
set look like a related unit. The template feature is one of the appealing 
aspects of using PowerPoint. You do not have to be an artist to create 
attractive slides. Once you have identified a design template that you would 
like to use, with it selected click the [OK] button. 
 
Layout Options 
The next screen that appears is the "New Slide" dialog box, for selecting a 
layout. Slide layouts are pre-created formats for a slide. There are twenty four 
layouts with the 7.0 release. Two of the most commonly used layouts are title 
slide and bulleted list. Just keep in mind that the layout for a slide has existing 
placeholders for information. 
 

Exercise 1 
Start the Presentations program. When the "PowerPoint" dialog 
box appears, select the option of creating a new presentation 
using a template. Select the "Presentations Designs" tab in the 
"New Presentation" dialog box and click on the template called 
"Side Bar". This is a template in blue with a pink line separating 
the title of each slide from the text below. When you click on the 
design, its appearance is displayed in the preview window to the 
right. After you select your design template, click the [OK] 
button.  
 
The "New Side" dialog box will appear next. Change the auto 
layout to Bulleted List for now (the second from the left on the 
first row of options), and click the [OK] button to go on to the 
next display 
 

More About Slide Templates 
When you are creating a new presentation, in the "New Slide" dialog box you 
select an auto layout before typing in any text. In Exercise 2 you picked a 
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bulleted list, which has a title and a bulleted text area. When you look at your 
slides in Slide View, you can see placeholders for the parts of the slides even 
if they are not in use. When the slide is printed or played, empty placeholders 
are not displayed.  
 
There are twenty four slide layouts that you can use in PowerPoint 7.0. They 
are:  

• Title Slide  
• Text & Object  
• Bulleted List  
• Object & Text  
• 2 Column Text  
• Large Object  
• Table  
• Object  
• Text & Graph  
• Text & Media Clip  
• Graph & Text  
• Media Clip & Text  
• Organization Chart  
• Object over Text  
• Graph  
• Text over Object  
• Text & Clip Art  
• Text & 2 Objects  
• Clip Art & Text  
• 2 Objects & Text  
• Title Only  
• Text over 2 Objects  
• Blank  
• 4 Objects  
 

Even after entering text in Outline View, you can change the slide layout. You 
do this by selecting the slide, and then clicking on the [Slide Layout] button on 
the Status bar, located near the bottom of the display. Select the slide layout 
you would like to use, and then click the [Apply] button to accept the changes. 
Changing the slide layout will not cause you to lose any information on your 
slide, but additional editing may be required. 
 

Exercise 2 
Change the view to Slide View for your "newsletter tips" slide 
show. Use the buttons on the vertical scroll bar to move to Slide  
  
Click on the [Slide Layout] button on the Status bar and change 
the template for Slide 1 to Title Slide. Take a look at the result 
on the screen. You could leave the new sub-title area blank, but 
instead, add the text "Building Blocks for a Newsletter" to that 
area. Do this by following the instructions displayed on the slide; 
click in the sub-title box, and enter the text. Save this version of 
"newsletter tips." 
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Changing Layouts in the Slide Sorter View 
If you have several slides you want to change as a group, this can be done 
easily from the Slide Sorter View. This view lets you see several slides at 
once, and allows you reorganize, select and change attributes of multiple 
slides. 
 
While holding the <Shift> key, select each slide that you want to change to a 
similar layout. If all slides are to be changed, you can use EDIT, Select All 
from the menu bar. Next click the [Slide Layout] button on the Status bar, and 
select a different layout, or use FORMAT, Slide Layout from the menu bar. 
The layout you choose will be applied to all selected slides. When you add a 
new slide to your presentation, it will use the layout of the previous slide, by 
default. 
 
Changing The Design Template 
In the "PowerPoint" dialog box when you begin creating a file, you pick out a 
design template for the slide background. However, you can apply another 
design template at any point. You will probably want to be using Slide View so 
you can see the effect. There are several ways to change the design 
template. The design template currently in use is displayed on the Status bar. 
By double-clicking on this area, you are taken to the "Apply Design Template" 
dialog box, where you can select a different template. As you select different 
templates, you can preview them in the box to the right. When you find a 
template you like, simply click on the [Apply] button. Two other ways to reach 
the "Apply Design Template" dialog box are by clicking the [Apply Design 
Template] button on the Standard toolbar, or by selecting FORMAT, Apply 
Design Template from the menu bar. Keep in mind that you cannot apply 
more than one background to a slide show. 
 

Exercise 3 
Using your "newsletter tips" slide show, click on the [Apply 
Design Template] button on the Standard toolbar. Select the 
"Multiple Bars" template and click on [Apply]. Using the buttons 
on the vertical scroll bar, move through the slides and look at the 
effect. 
 
Change the template to "Color Boxes" and view your slide show 
again. Finally, change the template to "Soaring" and view your 
slide show. Feel free to try other templates, if you wish. 
 
What is your reaction to these various backgrounds? When 
would you want to use one and not another? 
 
You do not need to save this new version of "newsletter tips." 
Close the screen display by clicking on FILE, then Close. 
 

The steps for creating a presentation is : 

     a.  Click on New button.   
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          Choose the Title Slide layout.  
          Click the Apply Design button from the Common Tasks button on the 
          formatting toolbar.  
   

 
          Select a design (template).  
          Click Apply.  
   
     b.  Complete the Title Slide  
          Type your Title text (The Truth about Cats and Dogs).  
          Type your name in the Sub-Title box.  
          Add Bold to Title, if necessary.  
          Move and Resize sub-title box up to make room for clip art in lower right 
          corner.  
   
     c.  Complete a Bulleted List Slide  

          Click on the New Slide button.   
               Select the Bulleted List layout.  
               Type your Title text (The Truth about Cats).  
               Type your list of "truths" about cats in the Bulleted List box.  
               Press enter to insert additional bullet  
               Press enter two times to double-space bullets  
               Backspace to delete extra bullets  
               Tab to increase indent  
               Shift + Tab to decrease indent  
   
     d.  Duplicate and Edit Your Bulleted List Slide  
          Click on the Slide Sorter View.  
          Click on the second slide.  
          Select Duplicate from the Edit menu.  
          Double-click on your new slide (#3).  
          Double-click the word Cats.  
          Type Dogs.  
          Type your list of "truths" about dogs in the Bulleted List box.  
 
Creating Data Charts 
Three important slide layouts are Graph, Text & Graph, and Graph & Text. 
Graph layout has a title area with a graph area that nearly fills up the slide. 
The Text & Graph layout has a bulleted list to the left side of the graph, and 
the Graph & Text layout has a bulleted list to the right side of the graph. The 
more complex the data chart, the more likely you would need to use the "full 
size" chart for your audience to read the chart. 
 



 84  Computer Skills for Biologists  

 
 

Starting a Column Chart 
An easy way to begin creating column charts is in the Slide View. Add a new 
slide, selecting the Graph layout. Next add a title to the slide, and then 
double-click on the graph "placeholder" to start Microsoft Graph. The 
"Datasheet" dialog box will appear. Move it out of the way, to the upper-left 
corner of the window, by clicking and dragging on the title bar. 
With Microsoft Graph running, VIEW, INSERT, FORMAT, and TOOLS on the 
menu bar will have different options. DATA also appears on the menu bar, 
and is unique to Microsoft Graph, as well as the Microsoft Graph toolbar. 

 
While the default chart type is a column chart, under FORMAT, Chart Type 
on the menu bar, or the [Chart Type] button on the Microsoft Graph 
toolbar, there are eight options in the "Chart Type" dialog box for 2-D charts, 
and six options for 3-D charts. A sample for each type of chart is displayed. 
It is easy to accidentally exit the "Datasheet" dialog box and return to Slide 
View, by clicking on the slide outside of the chart area. If you have done this, 
simply double-click on the chart to reopen Microsoft Graph. If you still don't 

see the datasheet, click the [View Datasheet] button on the Microsoft 
Graph toolbar, or select VIEW, Datasheet from the menu bar. 
 
Working with the datasheet area is similar to working in a spreadsheet 
program. You can highlight the current data in the datasheet and press 
<Delete> to clear the data, or click the corner control box--in the upper-left 
corner of the datasheet--to delete all of the data at once. The datasheet will 
be blank and the resulting chart will disappear, since there is no data to create 
the chart. 
 
You can enter text labels and numbers in the datasheet just as you would in a 
spreadsheet. Use the arrow keys to move around. Once the data is entered, 
you can close the display of the datasheet in a variety of ways. Perhaps the 
easiest is clicking the [Close] button (X) in the "Datasheet" dialog box, but you 
can also click on the [View Datasheet] button on the Microsoft Graph toolbar, 
or select VIEW, Datasheet from the menu bar to toggle the datasheet display 
off. 
 

Exercise 4 
In order for you to practice creating a chart for your presentation, 
we will assume you have conducted a survey of users in your 
organization, finding out what type of images they use in their 
newsletters now, versus what they were using five years ago. 
 
Use Slide View and move to Slide 10 on "Graphic accents." 
Click the [New slide] button and select a Graph layout. For the 
title of the slide type: Types of images used. 
 
Double-click on the chart placeholder and pick the a 2-D Bar 
format by selecting FORMAT, Chart Type, Bar from the menu 
bar. Keep in mind that Bar is a 2-D chart. Take a look at the 
resulting datasheet that appears and how the data is entered. 
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Notice there is a column for legend labels and a row for labels 
(text to explain the X-axis). 
 
Click the corner control box in the upper-left corner of the 
datasheet to delete all of the data at once. Replace it with the 
information provided below: 
 

            A      B         C            D 
         Photos Clip art Illustrations No images 
 1 1996    15     20        20            3     
 2 1991     5     35         3            8  
 3 
 4 

As you type in data, you can see the resulting chart being 
created. As you type "Illustrations," you see that the column is 
not wide enough, but the entire text item appears on the chart. 
You can drag the vertical line between columns in the header 
area (where the column letters appears) to make the column 
wider. 
 
When you are through entering data, click on VIEW, Datasheet 
and close this window, or close it by clicking the [Close] button. 
To complete the chart and return to the Slide View, click twice 
(once to return to Slide View, and the second time to deselect 
the graph) anywhere on the slide outside the chart area. The 
Microsoft Graph toolbar disappears and the normal toolbars 
reappear. 
 
The Datasheet and resulting graph should look like  
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Save this version of "newsletter tips." There are now 12 slides in 
your set. 
 
With the chart slide showing and using Slide View, change the 
layout to Text & Graph or Graph & Text by using the [Slide 
Layout] button on the status bar, or FORMAT, Slide Layout on 
the menu bar. What do you think of these slides as compared to 
the Graph layout? Change the layout back to Graph.  
 

Adding a Picture to the Master Slide  
          Hold down Shift and click the Slide View button.  
          Select the Insert Menu, Picture, Clip Art command.  
          Click once on the picture to select it, then click on the Insert Clip   

button. 
          Close Clip Art Box.  
   

 
 

          Resize the picture if necessary (by dragging with the two-headed 
resize           arrows).  
          Move the picture to the bottom right (by dragging with the four-headed 
          arrows).  
 

Exercise 5 
Move to the "Clip art" slide. Using the Slide View, click on the 
[Insert Clip Art] button on the standard toolbar. Select the 
Tortoise Slow image from the Animals category and click on the 
[Insert] button in the dialog box to place that image in your slide. 
Practice moving the image around on the slide, and then move it 
to the bottom on the left side of the slide by clicking and 
dragging anywhere within the box area (but not on a handle). 
Use INSERT, Clip Art from the menu bar to place another 
animal image--Hare Fast--on the bottom right side of the slide.  
 
Both of these images are vector images. 
Save your revised presentation. 
 

  Adding Speaker Notes  
 Open the View menu.  
 Choose Notes Page.  
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 Add comments to yourself.  
 

   Adding Custom Animation  
 Double-click the chart slide.  
 Right-mouse click the chart. 
 Select Custom Animation. 
 Click the Order & Timing tab.  
 Check mark Chart 2.  
 Select On Mouse Click in the Start Animation area.  
 Click OK.  
 If necessary, add animation to the arrow and text box.  

Rearrange the animation order.  
 

 Saving Your File  
 Click on the Save button.  
 Save to your (C:) directory, Temp subdirectory.  
 Name your file catdog.ppt.  

 
 Saving Your File as a HTML document  

 Select the File, Save as Web Page.  
 Upload the file to your web page.  

 
  Viewing Your Slide Show  

 Go to or Select the first slide.  
 Click on the Slide Show View button.  
 Click the left mouse button to advance to the next slide.  

 
 
 
 

Printing Options 
What Can Be Printed? 
Before looking at the "Print" dialog box, you need to know that there are 
various items that can be printed through PowerPoint: 
Slides (with builds)  For slides with a build effect turned on, adds a bulleted item 

(beginning with the slide title) on each subsequent page until the 
entire slide is printed.  

Slides (without builds)  Prints one page per slide, with all the bulleted items present, even if 
a build effect is in place. This is the default setting.  

Handouts 
(2, 3 or 6 slides per 
page) 

Prints "thumbnail" or smaller versions of the slides with multiple 
slides per page. You may select the number of slides per page; 
choices are 2, 3, and 6 slides per page.  

Notes Pages  Prints the Notes Pages to be used as speaker notes, or as a 
reference for the audience.  

Outline View  Prints an outline just as it appears on your screen.  

 
The option you select when printing depends on your situation and 
preference. 
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Printing Basics 
You can bring up the "Print" dialog box by selecting FILE on the menu bar, 
then Print, or by pressing the <Ctrl> and <P> keys together. Clicking the 
[Print] button on the standard toolbar prints the entire presentation using 
the default settings, without taking you to the "Print" dialog box first. 
 
There are various options in the "Print" dialog box. The "Printer" box lets you 
select from the various Windows 95 printers installed for your computer. The 
"Print range" box allows you to print all of the slides in your presentation 
(default), just the current slide, or a specific range of slides. For a range of 
slides, use a "," separator to specify individual slides, and a "-" separator to 
indicate a range of slides. If you have selected slides in the Slide Sorter View, 
you may also indicate that you wish to print this selection. The third box--
"Copies"--allows you to indicate the number of copies, and for multiple copies, 
if they should be collated. 
 
At the bottom of the "Print" dialog box you can select, from the choices 
described above, what it is you wish to print in the "Print what:" drop-down 
box.  

 
If you check the "Black & White" option, then all of the slides in the 
presentation will be printed in black ink on a white background. If you have a 
color printer, this is a quick way to print a draft copy of your presentation. The 
"Scale to Fit Paper" option automatically sizes slides to fit the paper loaded in 
the printer, and the "Frame Slides" option adds a thin frame around the border 
of everything except the Outline View. If you have created a presentation with 
hidden slides, an option to "Print Hidden Slides" will also appear.  
 

Exercise 6 
Open the "demo.ppt"  or a presentation you have created. 
Experiment with options under the "Print" dialog box. Change 
the print item to "Handouts (6 slides per page)," and print your 
presentation using your regular printer. Change the number of 
slides to "3 per page" and print your presentation again. 
 
Print a single full page slide using your regular printer. Try 
printing a second and third slide, experimenting with the "Black 
& White" and "Frame Slides" options. 

Command Summary 
FILE, New  To create a new presentation  

FILE, Open  To open an existing presentation file  

FILE, Close  To close a presentation file  

FILE, Exit  To exit from PowerPoint  

FILE, Save presentation  To save a new or existing under the same name  
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FILE, Save As  To change the name of a presentation or save in another 
folder or drive  

FORMAT, Apply Design Template  One way to pick another design template  

FORMAT, Slide Layout  One way to change the layout for one slide, or to apply a 
layout to a group of contiguous slides  

VIEW, Slide Show  One way to play the slide show as it will appear, without 
placeholders  

VIEW, Slides 
VIEW, Outline  

One way to change the view mode on the screen  

DRAW, Scale  One way to resize clip art  

EDIT, Delete Slide  One way to delete the active slide or selected slides  

FORMAT, Chart Type  One way to select the chart type in Microsoft Graph  

INSERT, Clip Art  Use to draw an area on a slide where an existing image or 
clip art is placed  

INSERT, Picture  Use to place images or pictures not found in the Clip Art 
Gallery  

INSERT, New Slide  One way to add slides  

TOOLS, Crop Picture  Use to trim a clip art object  

VIEW, Datasheet  One way to toggle the datasheet on and off in Microsoft 
Graph  

VIEW, Notes Pages  Bring up a special box for entering notes about a particular 
slide  

VIEW, Slide Sorter  One way to display thumbnail versions of multiple slides  

FILE, Print  To bring up the dialog box for selecting what should be 
printed and other options  

FILE, Slide Setup  Use to change slide size, orientation, and numbering  

FORMAT, Alignment  Use this to change justification in an object, like a title or 
bulleted area  

FORMAT, Bullet  Use to format bullets  

FORMAT, Custom Background  Use to create a custom background for one or more slides  

FORMAT, Font  One way to bring up the dialog box to pick font traits  

FORMAT, Slide Color Scheme  To make changes in the color scheme of one or more slides  

TOOLS, Build Slide Text  To select the build effect for a bulleted list on one or more 
slides  

TOOLS, Hide Slide  To prevent a slide from being displayed during a 
presentation  

TOOLS, Slide Transition  To bring up the dialog box to apply transitions to one or 
more slides  

INSERT, Sound  To bring up the dialog box to apply a sound file to the active 
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slide or selected slides  

VIEW, Slide Sorter  To see the transitions and sounds associated with each slide 

VIEW, Master  Use to view and change masters  

VIEW, Ruler  Use to view ruler for adjusting bullet indents  

VIEW, Slides  Use to select Slide View  
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Computer Networking Basics & Maintenance 
 

S. D. Madhukumar,  
Lecturer, NIT, Calicut 

 
Introduction 
 
The computer revolution is said to be the next big thing, which is going to 
downsize the achievements of the earlier revolution.  
 
Computer revolution has arrived in part and parcels in the 21st century and it 
is just going to grow bigger by the minute. Every minute at least a hundred 
PC's are bought all around the world, and majority of them are nowadays 
connected to the Internet. When its all about connecting two or more 
computer systems, in different parts of the world, bang comes the need for 
networking. 
 
Networking allows various intelligent devices like computers, PDA, mobile 
phones to communicate with each other either through physical wires or 
wireless signals. This is nothing but the much used word "convergence" of 
technology.  
 
We all send emails, don't we? But have we ever wondered how this email 
knows where to go? Well devices like routers act like postmen, who look at 
the IP address the email address originated from and they then forward it to 
the destination IP address, who is the actually intended recipient of the email. 
Networking basically explains one how this sequence of occurs happens in 
real time world and as to how the data packets reach where they have to. 
 
Software and Networking are inter-dependant. A Client Server application 
created by the tireless programmer can run only on a network, formed by your 
hardware guy, whose majority of the time goes into tripping about CAT5 
cables and sorting them out. The operating system (network operating 
system) used by the system administrator is actually the successful execution 
of the code of a software programmer, at runtime. 
 
Networking is all about troubleshooting in real life situations. No matter how 
badly one messes up with a computer system, the networking guy has to get 
the machine up and running ASAP. 
 
In the forthcoming section, you will get to know more about the standard 
models over which the internet was built, a preview on the various devices 
that make a network work, like your hub, router, repeater, switch and also 
about the various networking operating systems. Useful tips regarding 
cracking certifications like CCNA, MCSE will also be given. 
 
So watch out for this space, where you can quench your thirst for technical 
knowledge, with a cherry of philosophy and real life examples on top.    
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Computer Network– Basics 
 
An Internet work is a collection of individual networks, connected by 
intermediate networking devices, those functions as a single large network. 
The networking devices are the vital tools for communication.  Whenever you 
have a set of computers or networking devices to be connected, you make the 
connections, depending on the physical layout and your requirements 
Depending on the physical layout or topology of the network, there are three 
types of networks. 
 
LAN 
LAN stands for Local Area Network. These networks evolved around the PC 
revolution. LANs enabled multiple users in a relatively small geographical 
area to exchange files and messages, as well as access shared resources 
such as file servers.  
 
WAN  
WAN stands for Wide Area Network. The interconnection of various LAN’s 
through telephone network, which unites geographically distributed users is 
achieved through WAN. In short when we log on to the Internet, we become a 
part of a WAN. 
 
MAN 
MAN stands for Metropolitan Area Network. It is usually the interconnection 
between various LAN’s in a particular geographical area like a metropolitan 
city like Bombay. Hence the name. 
 
Internetworking evolved as a solution to three key problems: isolated LANs, 
duplication of resources, and a lack of network management. Isolated LANS 
made electronic communication between different offices or departments 
impossible. Duplication of resources meant that the same hardware and 
software had to be supplied to each office or department, as did a separate 
support staff. This lack of network management meant that no centralized 
method of managing and troubleshooting networks existed. 
 
Open Systems Interconnection Model  
The OSI model is the basic model describing the data movement through a 
network. The Open Systems Interconnection (OSI) reference model describes 
how information from a software application in one computer moves through a 
network medium to a software application in another computer. The OSI 
reference model is a conceptual model composed of seven layers, each 
specifying particular network functions. The OSI model divides the tasks 
involved with moving information between networked computers into seven 
smaller, more manageable task groups. A task or group of tasks is then 
assigned to each of the seven OSI layers. 
 
The following list details the seven layers of the Open System Interconnection 
(OSI) reference model: 

• Layer 7—Application layer (A)  
• Layer 6—Presentation layer (P)  
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• Layer 5—Session layer (S)  
• Layer 4—Transport layer (T)  
• Layer 3—Network layer (N)  
• Layer 2—Data Link layer (D)  
• Layer 1—Physical layer (P)  

 
Tip To Remember 
People Do Need To Send Packets Away.  
The first letter of each word is related to the alphabet associated with the 
name of the OSI layer. P of People stands for Physical Layer of the OSI 
model and so on. 
 
Protocol 
The OSI model provides a conceptual framework for communication between 
computers, but the model itself is not a method of communication. Actual 
communication is made possible by using communication protocols. In the 
context of data networking, a protocol is a formal set of rules and conventions 
that governs how computers exchange information over a network medium. A 
protocol implements the functions of one or more of the OSI layers. A wide 
variety of communication protocols exist, but all tend to fall into one of the 
following groups: LAN protocols, WAN protocols, network protocols, and 
routing protocols. LAN protocols operate at the network and data link layers of 
the OSI model and define communication over the various LAN media. WAN 
protocols operate at the lowest three layers of the OSI model and define 
communication over the various wide-area media. Routing protocols are 
network-layer protocols that are responsible for path determination and traffic 
switching. Finally, network protocols are the various upper-layer protocols that 
exist in a given protocol suite. 
 
This being the beginning session, I haven’t dwelled into the details. Lets start 
small and end big! So till then get these fundamentals ingrained in your mind.  
 
OSI Model and TCP/IP Mode 
The OSI model by IBM is the biggest boon that systems developer can have 
had for their karma in the past life. 
 
What exactly is the OSI model?  
As I had mentioned it is actually a layered stack, with 7 layers. Each of these 
7 layers are implemented by different protocols for each layer. But keep in 
mind, its not necessary that all these layers have to be used, when trying to 
device a system. A system can also make away with any of the 7 layers like 
say the Session Layer or the Application Layer. 
 
Consider a Router for example. A Router is a device, which works in the 
Network Layer of the OSI Model. Its main function is to route packets that 
arrive at its ports. Router takes a routing decision for each of the packet that 
arrives at its port, on the basis of Routing Tables.  
 
Routing Tables are somewhat similar to the Time Table we follow while 
attending our courses in college. Depending on the subject scheduled in the 
timetable for a particular day, we decide whether to attend the lecture or not. 
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In a similar way the Router looks at the destination address (which is the IP 
address) of the packet that is to be routed.  
 
Now remember that an IP address is made up of a Host ID and a Network ID 
(I will cover IP addresses in depth in the future articles). The Router looks at 
the Network ID and compares it with the other Network ID’s present in its 
Routing Tables. If the particular Network ID is found to be present in the 
Router’s Table, the packet is routed to the appropriate destination 
successfully. If the Network ID of the packet is not present in the Router’s 
Routing Table, then the router forwards the packet to the next nearest router 
and this process continues till the packet reaches its intended destination. 
 
This is very similar to what you do when you are asked where someone stays, 
while walking on the road. You are shown the address by the person, who 
wants to reach a place (Consider this Address as the Destination IP address). 
Now what you do is directly look at the name of the street. This is because the 
name of the building is not something you will be immediately familiar with, as 
a building with the same name will surely exist in thousand different streets.  
 
If you are very well aware of the geography of the place, then by looking at 
the Street (Network ID) you tell the person where the street is. ( similar to a 
Router finding that the Network ID field of the IP address of the packet is 
present in its Routing Table). If you don’t know the street or the address, you 
tell the person to ask some one else ( that is you forward him to the next 
nearest Router).  
 
OSI model doesn’t say you do things this way. It just tells you “ Hey keep in 
mind that these things should be covered while designing a feasible network 
solution “. 
 
TCP/IP Model 
The TCP/ IP model superseded the OSI model. This is the model that is 
currently most widely used. The various layers in the TCP/IP model are : 

5) Application 
4) Transport 
3) Internet work 
2) Data Link 
1) Physical 

Note that the Sessions and Application Layer present in the OSI Model are 
absent in the TCP/IP Model.  
 
In the 1990’s, TCP/IP has become firmly established as the dominant 
commercial architecture and as the protocol suite upon which the bulk of new 
protocol development is to be done. 
 
There are a number of reasons for the success of the TCP/IP model over the 
OSI model: 

1. Internet is built on the foundation of the TCP/IP suite. The tentacles of the Internet 
and the World Wide Web have spread throughout the world and that is the main 
reason for the success of TCP/IP model over the OSI model.  
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2. TCP/IP protocols were initially researched under a project in the Department of 
Defense (DOD). DOD was committed to international standards and most of its 
operational requirements couldn’t be met by the OSI model. So it started to develop 
the TCP/IP. Since the DOD is the largest consumer of software products in the world, 
the vendors were encouraged to develop TCP/IP based products.  

In the next article I will cover more about the various layers in the OSI Model 
and the TCP/IP Model.   
 
TECHNICAL GLOSSARY 
 
Ethernet  
A local-area network (LAN) protocol developed in 1976. Ethernet supports data transfer rates 
of 10 Mbps. Ethernet is one of the most widely implemented LAN standards.  
A newer version of Ethernet, called 100Base-T supports data transfer rates of 
100 Mbps. The newest version, Gigabit Ethernet supports data rates of 1 
gigabit (1,000 megabits) per second. 
 
LAN  
Local Area Network (LAN) A local area network is a number of devices, 
typically PC's, fileservers and printers, connected to one or more "segments" 
of cable. 
 
Matrix Switching  
Network management tools, which provide access to data circuits in the wide 
area network to allow fault detection, monitoring and reconfigurations. 
 
Spoofing  
Many network and server operating systems send "keepalive" packets to 
check the state of connected clients, to ensure that they really are still 
connected. During periods of inactivity this can result in unnecessary calls 
being made. For this reason, ISDN routers are normally configured to spoof 
these connections, and reply to keep alive packets on behalf of the remote 
client. 
 
Structured Cabling  
A very versatile and cost effective cabling system which can be used (with 
adapters where appropriate) for a number of different services. 
 
Voice over IP  
Voice transport over IP networks, such as the Internet. This could allow your 
company to make enormous savings on telecomm costs by sending voice 
traffic anywhere around the world via your internet connection. 
 
Virtual Private Network  
Your own VPN can be created between two sites which are connected only 
via the Internet. This is far more secure than sending your traffic as IP over 
the Internet as it is encrypted, and can only be decrypted by the partner 
device the other end.  
 
Wide Area Network  
A computer network that spans a relatively large geographical area.  
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Typically, a WAN consists of two or more local-area networks (LANs). 
Computers connected to a wide-area network are often connected through 
public networks, such as the telephone system. They can also be connected 
through leased lines or satellites. The largest WAN in existence is the 
Internet. 
 
X.25  
X.25 is a layer 3, packet based protocol typically run over a LAPB (Link 
Access Procedure Balanced) layer 2 protocol. It is generally a wide area 
protocol. The protocol has a large amount of built in resilience, and as such 
can guarantee delivery and integrity of data from one node to another.  
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GLOSSARY 
 

AACE  
The Association for the Advancement of Computing in Education (founded in 
1981) is an international, education, and professional organization dedicated 
to the advancement of the knowledge, theory, and quality of learning and 
teaching at all levels with information technology:  
AAHE  
The American Association for Higher Education (AAHE) envisions a higher 
education enterprise that helps all Americans achieve the deep, lifelong 
learning they need to grow as individuals, participate in the democratic 
process, and succeed in a global economy:  
Absolute Path  
Absolute paths spell out the location of a file by starting at the highest level 
and listing each directory needed to find the file itself. Example: 
C:\Windows\Profiles\jdoe1\Desktop\myfile.doc  
Academic Systems  
Department of IS which operates the Training Center, houses the Web Group, 
and provides instructional and research technology consulting:  
Address  
Either (1) an induvidual's e-mail address, or (2) an organization's address on 
the Internet and World Wide Web. Usually indicated by an uninterrupted 
series of numbers and/or letters, punctuated by periods, slashes and @'s.  
ADMIN1  
A node of the VMS cluster reserved for administrative use. Allows authorized 
users to access SIS+, FRS, and HRS. This node is a Digital OpenVMS V6.2 
VAX 7620: ADMIN2  
A node of the VMS cluster reserved for administrative use. Allows authorized 
users to access SIS+, FRS, and HRS. This node is a Digital OpenVMS V6.2 
VAX 7620: ADMIN3  
A node of the VMS cluster reserved for administrative use. Allows authorized 
users to access SIS+, FRS, and HRS. This node is a Digital OpenVMS V6.2 
AlphaServer 4000: Administrative Systems  
Department of IS which maintains, develops, administers, and programs the 
University's administrative computing systems:  
ADNET  
The name of a Windows NT Server used by university administrators and IS 
staff. Some have selected username@adnet.memphis.eduas their preferred 
e-mail address. However, e-mail sent to username@memphis.edu will still 
reach them.  
ADS  
Alumni Development System. One of the databases available from the 
administrative nodes of the VMS cluster. It is used by Advancement to track 
essential information about University alumni constituents.  
Adobe Acrobat  
Adobe's suite of softwares that allow you to convert a file created in a variety 
of softwares into a PDF file. PDF files can be read by anyone with the free 
Acrobat Reader. Adobe Acrobat includes Distiller, Exchange, and Reader:  
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Adobe Acrobat Capture  
Adobe's software that allows you to scan books and other materials, make 
them searchable, and save them as PDF files. PDF files can be read by 
anyone with the free Acrobat Reader:  
Adobe Acrobat Distiller  
Adobe's software that converts a file created in a variety of softwares into a 
PDF file. PDF files can be read by anyone with the free Acrobat Reader. 
Adobe Acrobat Distiller PE comes with Adobe Pagemaker:  
Adobe Acrobat Reader  
Adobe's free reader for PDF files:  
Adobe Pagemaker  
Adobe's desktop publishing software. It is a technology standard. The current 
version for both the PC and the Macintosh is 6.5:  
Adobe Photoshop  
Adobe's photo design and production software. It is not a technology 
standard. The current version for both the PC and the Macintosh is 5.0:  
Analog  
A signal that is continuously variable, a flowing line or wave. Analog signals 
must be translated into digital signals before a computer can process them.  
Anchor  
Text and graphics can link to places within the same document. These links 
require two parts: the anchor and the link. The anchor identifies the place to 
jump to.  
Anonymous FTP  
FTP transactions that do not require a unique login name or password. Use 
the name anonymous to login and use your e-mail address as a password:  
Applet  
A program designed to be executed from within another application. Unlike an 
application, applets cannot be executed directly from the operating system.  
ArcInfo  
A GIS database: 
ArcView  
A GIS software that The U of M has a site license for.  
Argument  
Words or numbers you can enter as part of an HTML tag to expand or modify 
how that tag operates.  
ARS  
Action Request System by Remedy Corporation. The university uses this 
software to keep track of service calls routed through the Helpdesk or through 
Local Service Providers (LSPs). ARS provides an efficient way to filter 
information to people that work on the service calls.  
ARWeb  
The web interface for ARS. Anyone can use ARWeb to enter a service call or 
track progress on a call:  
ASCII  
Acronym for American Standard Code for Information Interchange. ASCII 
(Pronounced as-kee) is a standard that says which computer-readable 
number is associated with each letter, digit, and punctuation mark. An ASCII 
file is a text file that can be read by almost any program. Most computers use 
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ASCII codes to represent text, which makes it possible to transfer data from 
one computer to another.  
Asynchronous  
Communication in which interaction betwen parties does not take place 
simultaneously (e.g. electronic mail and voice mail).  
Attachment  
A computer file electronically stapled to an e-mail message and sent along 
with it.  
Authoring Software  
Computer programs that aid in creating HTML documents by inserting the 
code for tags. Netscape Composer and Microsoft FrontPage are two of the 
authoring softwares used on campus.  
Backbone  
A primary communication path connecting multiple users.  
Bandwidth  
A measure of the capacity of a communications channel. The higher a 
channel's bandwidth the more information it can carry.  
BASIC  
(Beginners All-Purpose Symbolic Instruction Code) A language that employs 
familiar English phrases to direct the operation of a computer.  
Batch Processing  
A mode of processing in which a file containing a program, data, and certain 
command lines is submitted to the system, and execution proceeds without 
any user interaction.  
Better Telnet  
The terminal emulation software which is the standard for the Macintosh at 
the university.  
Binary Digit  
A digit, 0 or 1, in the binary number system.  
Binary Number System  
A number system, using only the binary digits 0 and 1, that is commonly used 
for internal computer representation.  
Bit  
A binary digit. The unit of information that can take one of two values, such as 
true or false; zero or one.  
Body  
HTML tag used to enclose the body (all the text and tags) of the HTML 
document.  
Bookmark  
The address of a Web page to which you may want to return. Netscape lets 
you maintain a list of bookmarks to make it easy to go back to your favorite  
Web pages.  
Boolean Logic  
Term used to describe certain operations that combine or limit search options.  
Browser  
Software that allows you to find and view information on the Internet(e.g 
Internet Explorer, Netscape). Browsers are often referred to as "client 
software."  
Bug  
A program error.  
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Button  
A small screen object, labeled with text or icon or both, used to initiate 
instantaneous action, such as completing an operation.  
Byte  
The smallest addressable unit of digital storage larger than a bit and smaller 
than a word. A byte now consists of eight bits.  
Cache Memory  
A small area in RAM (Random Access Memory) used for temporary storage.  
Calendar Express  
A web interface for calendar.memphis.edu which allows the calendar account 
user to view his or her calendar from any web browser 
Calendar.memphis.edu  
Web server providing Netscape Calendar services (scheduling, collaboration) 
to U of M faculty and staff members. Faculty or staff interested in acquiring a 
calendar account should contact their Local Service Provider:  
Campus Pipeline  
Campus Pipeline is a web based Enterprise Information Portal (EIP) for the 
higher ed community that creates a campus that never closes. It provides 
students, faculty, staff and alumni convenient access to campus resources 
through a personalized user interface. In addition to bringing new applications, 
Campus Pipeline is designed to be the framework for existing applications. 
The U of M is currently a pilot school for this new software solution.  
Card-Swipe  
A machine used to build VMS, PH, and TigerLAN accounts and to reset 
passwords on those accounts. A faculty member, staff member, or student 
swipes his/her student ID card through the machine and follow the directions 
on the screen. Card swipe machines are located in AD124, SM110/112, 
SM414, McWherter Library 100, ET236, LW114, RB102, DH230/232, BB385, 
FH162, RT118, RA100, ED314/316, CL219, and PT229.  
CashNet  
New bursar system  
C++  
This is an extension of the C programming language. It is more advanced 
than C.  
CBT  
Computer based training. Usually CBT training uses a CD-ROM or a web 
browser.  
CBTWeb  
SmartForce (formerly CBT Systems) provides this web interface product for 
its CBT training. The university's contract with Smart Force allows anyone 
with a PH account to access 300 training titles 
cc.memphis.edu  
A generic name for the VMS cluster. Mail sent to cc.memphis.edu may 
actually come to any of the five clustered machines - admin1.memphis.edu, 
admin2.memphis.edu, admin3.memphis.edu, latte.memphis.edu, 
mocha.memphis.edu. IS recommends that you give your e-mail address to 
others as uuid@memphis.edu. If the VMS cluster is where you receive mail, 
all mail sent to uuid@memphis.edu will be routed to uuid@cc.memphis.edu .  
CD Burner  
A device used to record data on CD-R or CD-RW disks.  
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CD-ROM  
A high capacity compact disc used to hold graphics, text and audio.  
CD-R  
A recordable CD. CD-R disks are available through the University Bookstore. 
To create a CD, the user must use a CD-writable drive. CD-R disks can be 
recorded only once. CDs created from CD-R disks can be played on any CD 
drive.  
CD-RW  
A rewritable CD. CD-RW disks can only be used on CD-writable drives. They 
can be recorded multiple times.  
Central Processing Unit (CPU)  
Controls the operation of the entire computer system, performs 
arithmetic/logic operations, stores, and retrieves instructions and data.  
Character  
Any symbol including letters, both uppercase and lowercase, digits, and 
various special symbols.  
Chat  
To type live to other network users from any and all parts of the world. To chat 
on the Internet, you use an Internet Relay chat (IRC) program like mIRC or 
Microsoft Chat. America Online and CompuServe have similar services.  
Check Boxes  
Used in forms to make it possible to select one or more non-exclusive options 
in a list.  
Circe  
A server used to test software at The University of Memphis.  
Clementine  
SPSS's datamining software. The university has a site license that allows 
installation home and office computers for faculty and staff. Clementine is 
available on TigerLAN PC computers.  
Client  
The client part of a client-server architecture. Typically, a client is an 
application that runs on a personal computer or workstation and relies on a 
server to perform some operations. For example, an e-mail client is an 
application that enables you to send and receive e-mail.  
Client Services  
An area of Information Systems which includes Computer Systems Support, 
Academic Systems, Client Support Services, and Administrative Systems.  
Client Support Services  
This department of IS operates the Helpdesk, manages the student labs, and 
coordinates software licensing 
Coding  
Writing a program or subprogram in a high level language.  
.com  
A type of Internet domain assigned to business or commercial entities.  
Compiler  
A compiler translates a computer program from one language into another, 
catching any errors in syntax along the way. Most commonly, you translate 
some high level language, such as C++ into optimized machine language. 
This form of compilation puts your programs into a form that your computer 
can understand.  
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Compression  
The shrinking of digital image and video information to achieve smaller file 
size and so make possible, for instance, the computerized transmission of a 
two-hour feature film that would require 158 gigabytes of storage without 
compression. The best compression ratios currently hover around 200:1  
Computer  
A device that performs computations automatically, accurately and at high 
speed.  
Computer Conferencing  
Interactive sessions between networked computers whereby data, 
documents, and/or video and audio are shared.  
Computer-Mediated Communication (CMC)  
Transmission and reception of messages using computers as input, storage, 
output and routing devices. CMC includes information retrieval, electronic 
mail, bulletin boards, and computer conferencing.  
Computer Systems Support  
Department of IS which services lab hardware, offers hardware training and 
support to Local Service Providers (LSPs), and coordinates hardware 
purchase:  
Connected Education  
A vision of education in which learners and teachers are better connected to 
information, ideas and each other via effective combinations of pedagogy and 
technology – both old and new. Educational purposes and techniques are 
made more visible to all participants,and everyone has more options for 
contributing to the improvement of teaching and learning.  
Cookie  
A "cookie" is a small amount of information that a web site copies to your hard 
disk. A cookie can help a web site identify you the next time you visit. For 
instance, if you shop for books online, the bookstore's web site might use a 
cookie to store information about your favorite subjects, and later use that 
information to recommend particular books.  
Coordinates  
Pairs of numbers used to define the edges of the clickable areas in clickable 
image maps.  
Corel WordPerfect  
Corel's word processing software. It is not the university's technology 
standard. However, it is used in several areas of the university (e.g., the law 
school): CourseInfo  
A course development tool by Blackboard. Faculty can fill-in-the-blanks to 
create an online course with many interactive features such as a chat and a 
discussion board. Many UofM faculty are currently using version 4.09:  
Courseinfo.memphis.edu  
The name of the server running CourseInfo 4.09 
CREN  
Corporation for Research and Educational Networking; CREN's strategic 
mission is to support low-cost access to worldwide electronic networking and 
its use for the benefit of education and research communities.  
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Cryptography  
The conversion of data into code for transmission over a network. The original 
data is converted into code using an envryption algorithm, and is decoded 
(decrypted) at the receiving end.  
Cursor  
Computer position indicator; either(1) a symbol on the screen, or (2) a 
handheld device for entering coordinates.  
Cyberspace  
The nebulous "place" where humans interact over computer networks, same 
as virtual space. Coined by William Gibson in Neuromancer.  
Database  
A large collection of data organized for search and retrieval by computers.  
Database Application  
Programs that allow collection and organization of data for easy access and 
retrieval. Microsoft Access is the standard for PCs at The U Of M, while 
Filemaker Pro is the standard for the Macintosh.  
Data Infrastructure and Internet2  
A new area within IS which focuses on the university's networking capability 
for new Internet technologies.  
DataNET  
A major IS project to provide every office, meeting room, and conference 
room, approximately 40% of all classrooms, and approximately 40% of all  
residence hall rooms with a connection to the campus network. DataNET is 
now completed.  
Data Warehouse  
A collection of data designed to support management decision making. Data 
warehouses contain a wide variety of data that present a coherent picture of 
business conditions at a single point in time.  
DBA  
Data Base Administration.  
DCL ($ prompt)  
Digital Command Language. It is used to issue commands to VMS.  
Debug  
To locate and correct errors (bugs) in a program.  
Default  
The initial value of any input type (text field, check box, radio button, selection 
list) used in a form.  
Defragment  
To optimize a disk by unfragmenting files. See  
Desktop  
A metaphor used to portray file systems. A desktop consists of pictures, called 
icons, that show cabinets, files, folders, and various types of documents. You 
can arrange the icons on the electronic desktop just as you can arrange real 
objects on a real desktop -- moving them around, putting one on top of 
another, reshuffling them, and throwing them away.  
Desktop Publishing Software  
Applications used o produce high quality printed documents. A desktop 
publishing system allows you to use different typefaces, specify various 
margins and justifications, and embed illustrations and graphs directly into the 
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text. Adobe Pagemaker is the standard at The U of M, both for the PC and the 
Mac.  
DialUM  
DialUM is the Direct Internet Access Link to The University of Memphis 
provided through campusCWIX. DialUM guarantees access to the Internet 
and The University of Memphis, allowing users to avoid busy signals 24 hours 
a day. DialUM provides the user with appropriate software for Windows 3.1, 
Windows 95, and Macintosh: Dial-Up Access  
Connecting to another computer or network using a modem over a regular 
telephone line.  
Dial-Up Connections  
Accessing the Internet by means of a modem and communication software.  
Digital  
An electrical signal that varies in discrete steps in voltage, frequency, 
amplitude, locations, etc. Digital signals can be transmitted faster and more 
accurately than analog signals.  
Digital Camera  
A camera that produces photographs that can be saved as files on your PC. 
No film is required 
Digital Certificate  
The electronic equivalent of an ID card, used in conjunction with a public key 
envcyption system. Also called digital IDs, digital passports, X.509 certificates, 
or public key certificates.  
Digital Signatures  
Digital signatures work just like paper-and-ink signatures, allowing document 
recipients to confirm the source of a document. Digital signatures are 
generated by digital certificates  
Directory  
A major division on the hard drive or server used to divide and organize files.  
Discussion Board  
An interactive feature to a web site. Unlike newsgroups, it allows separate 
discussions on specific topics. At the UofM, currently most active discussion 
boards were created using CourseInfo 
Disk  
A round plate on which data can be encoded. There are two basic types of 
disks: magnetic disks (e.g., floppy drive or hard drive) and optical disks (e.g., 
CD-ROM).  
Distance Learning  
A type of education where students work on their own at home or at the office 
and communicate with faculty and other students via e-mail, electronic 
forums, videoconferencing and other forms of computer-based  
communication.  
DNS (Domain Name System)  
When you send email or point a browser to an Internet domain such as 
cnet.com, the domain name system translates the names into Internet 
addresses ( a series of numbers looking something like this: 123.123.23.2). 
The term refers to two things: the conventions for naming hosts and the way 
the names are handled across the Internet.  
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Document Camera  
Also called a visual presenter or a video visualizer. This equipment offers the 
functionality of an overhead projector but also allows you to display 
nontransparent objects. Several classrooms on campus have document 
cameras.  
Domain  
The name for a company, organization, or individual's Internet connection. 
Individual computers within this domain all end with the domain as a part of 
their host name.  
Domain Name  
The internet address of the computer where a Web page is located.  
Download  
To obtain an electronic file from another computer.  
ds.memphis.edu  
The LDAP server for the University of Memphis. It contains the same 
information as the PH (phonebook) database, but it is easier to use with e-
mail packages such as Netscape Messenger 
Dynamic HTML (DHTML)  
Refers to new HTML extensions that will enable a Web page to react to user 
input without sending requests to the Webserver. Microsoft and Netscape 
have submitted competing Dynamic HTML proposals to W3C, which is 
producing the final specification. There are many technologies for producing 
dynamic HTML, including CGI scripts, cookies, Java, JavaScript, and ActiveX.  
.edu  
A type of Internet domain assigned to educational entities.  
EASI  
Equal Access to Software and Information. Using information technology to 
enable people with disabilities to participate fully and effectively in educational 
activities.  
Encryption  
A method of encoding data for security purposes. Some methods of 
encrypting , such as 128-bit encryption, are so difficult to break that U.S. 
export laws permit them to be used only within the United States. Netscape 
Communicator provides the option of securing U.S.documents using 128-bit 
encyption.  
Educause  
"Transforming education through information technology"  
EduCart (also known as WebLearner)  
 A complete, portable system with all the basic technology needed for 
classroom and web-based learning developed by Tegrity.  Enables virtual 
touch panel navigation, streaming display of whiteboard writing and 3D 
images, virtual pointing, audio and video of the instructor and automatic 
indexing.  
EIP  
Enterprise Information Portal  
E-Mail (Electronic Mail)  
A communication system that allows you to send an electronic 
"letter"(message) from one computer user  to one or more users. At the UofM, 
Netscape Messenger is the supported e-mail client. 
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Electronic Phone Book  
The University of Memphis electronic phone book is a computerized database 
that contains information about all of the UofM faculty, staff, and students. 
Embedding  
To insert information (an object) that was created in one document (the 
source) into another document (the destination).  
EUIT  
Educational Uses of Information Technology.  A useful acronym with a broad 
definition.  
EVE  
A VMS text editor. It is the default editor on the VMS cluster.  
Extension  
In DOS or Windows, a short abbreviation (often 3 letters) after the file name, 
separated from the file name by a period. The extension corresponds to a file 
type, helping the computer determine which program to use to open the file. 
Example: Letter.doc corresponds to a Microsoft Word file called "Letter".  
External Files  
Any files that are not directly loadable by a browser such as some image 
formats, sounds, videos, or even program files.  
FAQ  
Frequently Asked Questions  
FAM  
Financial Aid Management  
Favorites  
A list of files or Web pages you plan to use frequently. Microsoft Interner 
Explorer lets you maintain a list of your favorite items to make it easy to see 
them again.  
FDDI (Fiber Distributed Data Interface)  
A type of high-speed dedicated connection to the Internet with a speed of 45 
MB per second.  
Fetch  
The FTP software which is the standard for Mac-users at the university  
Fiber Optic  
A cable technology used for telecommunication and computer networks with 
very high capacity, allowing high-speed transmission of data and non-voice 
information like video.  
File  
A collection of data items kept in a storage medium such as a floppy or hard 
disk. Files may contain programs, data, text, images, or other information.  
File Extensions  
In DOS and some other operating systems, one or several letters at the end 
of a filename. Filename extensions usually follow a period (dot) and indicate 
the type of information stored in the file. For example, in the filename 
EDIT.TXT, the extension is TXT, which indicates that the file is a text file.  
File Formats  
The patterns and standards used to store a program on a disk. Example: 
PHOTO.GIF.  
Filemaker Pro  
A relational database software. It is the technology standard for the 
Macintosh. It is also available for the PC; however, it is not the university's 
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technology standard for the PC. The IS Training Center has a CBT training 
CD-ROM on Filemaker 4.1, the current version. 
File Transfer  
A process to send electronic files from one computer to another.  
Filter  
Hardware or sofware designed to restrict access to certain areas on the 
Internet.  
Firewall  
A network security barrier designed to protect a local network from being 
accessed by unauthorized persons vis the Internet.  
Flame  
An inflammatory e-mail usually directed against the poster of a message.  
Form  
A part of HTML documents that contains fill-in text boxes, lists of options, and 
other elements that allow the user of the form to send information back to the 
Web server.  
Fragmentation  
Refers to the condition of a disk in which files are divided into pieces scattered 
around the disk. Fragmentation occurs naturally when you use a disk 
frequently, creating, deleting, and modifying files.  
Freeware  
Software that is distributed at no cost to the user (the author maintains the 
copyright).  
Frequently Asked Questions(FAQ)  
A collection of information on the basics of any given subject, often used on 
the WWW.  
FRC  
Faculty Resource Center. An area within the IS Training Center where faculty 
can use computers, a scanner, video conferencing equipment, a CD burner, 
and other equipment. 
FRS  
Financial Records System. FRS is one of the databases available on the 
administrative nodes of the VMS cluster. Access is restricted.  
FTP (File Transfer Protocol)  
The standard method of transferring files from one computer to another via 
the Internet. Some Internet sites specialize in just this kind of transfer. Users 
can sign on to this type of server and copy files to their own computers. FTP 
can require user ID's and passwords, or it can be open to all via "anonymous 
FTP".  
Gateway  
A computer system that links two networks, allowing information to pass from 
one to the other.  
Gateway Script  
A program that is run on a Web server that processes the input from forms.  
GIF(Graphics Interchange Format)  
A popular type of image file format for compression of images. . Images on 
webpages are commonly stored in the GIF or JPEG formats. GIFs can be 
transparent.  
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GIS  
Geographic (or Geographical) Information Systems are an extremely 
important area of applied computing, representing a multi-billion dollar 
industry worldwide. Seen originally as computer mapping and display tools 
(automated cartography, CAD, etc.), they are much more than that today. GIS 
have become indispensable tools in environmental management and 
planning, infrastructure development, resource extraction industries, and 
more. Geographic Information Systems (GIS) is an organised collection of 
computer hardware, software, geographic data, and personnel designed to 
efficiently capture, store, update, manipulate, analyse, and display all forms of 
geographically referenced data.  
Gopher  
A text-only menu-based tool for finding, accessing, and organizing Internet 
resources. Any Internet address that begins with "gopher:" points to such a 
site. Gopher predates the WWW. The university no longer offers a main 
gopher site. However, other gopher sites can be accessed through Netscape.  
.gov  
A type of Internet domain assigned to government entities.  
Graphical Browser  
A program used to view formatted HTML documents and navigate the World 
Wide Web. Graphical browsers can display inline images and display text in 
various type styles. Example: Netscape Navigator and Internet Explorer.  
Groupware  
A type of software designed to allow users on a network to use the software 
and work on the same project at the same time.  
GUI  
Graphical User Interface- The use of graphics, menus and icons to carry out 
computer functions.  Before this was available, specific command lines had to 
be used.  
Hardware  
The actual physical components of a computer system such as disk drives, 
printers, central processing unit, memory, and so on.  
Head  
The HTML tag used to enclose the beginning elements in the HTML 
document, including the title.  
Helper Application  
A program whose purpose it is to extend the capabilities of another program, 
such as plugins for Web browsers.  
Help Desk  
The university's "One-Stop-Shop" for technology help.  
Hertz  
Standard measuring unit for frequency measured in cycles per second. 
Abbreviation : Hz  
Home Page  
The first HTML document that you intend people to see at your Web site is 
known as a home page.  
Host  
A network computer that can receive information from other computers.  
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Host Name  
The name of a computer on the Internet, used to identify it in the URL naming 
scheme.  
HRS  
Human Resource System. HRS is one of the databases available on the 
administrative nodes of the VMS cluster. Access is tightly restricted.  
HTML (Hypertext Markup Language)  
The code used to create a home page and to access documents over the 
World Wide Web.  
HTTP (Hypertext Transport Protocol)  
The transmission standard used to send HTML documents across the World 
Wide Web. It signifies that an Internet site is a WWW site, i.e, HTTP is a 
WWW address.  
Hypertext  
The text and images that enable users to "jump" from one Web site or Web 
document to another. Hypertext usually is underlined and displayed in blue, 
while hypertext images are sometimes surrounded by a blue border. Also 
known as a hot link or link.  
Icon  
A picture used on a computer screen to convey a purpose or a function.  
ils.memphis.edu  
The university's NetMeeting server. Microsoft Netmeeting is a free 
videoconferencing tool for PC users. NetMeeting is available in SM110. 
Information Systems (IS)  
A division of the university which provides information technology leadership 
for the campus. It coordinates a campus-wide IT planning process to 
complement the institution's strategic plan. 
Interactive  
Any computer-based system in which the user's input directly affects the 
system's behavior and the resulting output is directly communicated to the 
user.  
Internet  
The general term used to describe the worldwide network of computers and 
services encompassing well over 50 million computer users and dozens of 
information systems including e-mail, Gopher, FTP, and World Wide Web .  
Internet2  
A collaborative effort to develop advanced Internet technology and 
applications vital to the research and education missions of higher education. 
Over 140 U.S. universities (including the University of Memphis) are working 
with partners in industry and government. Internet2 is working to enable 
applications, such as telemedicine, digital libraries and virtual laboratories that 
are not possible with the technology underlying today's Internet. As a project 
of  the University. Corporation for Advanced Internet Development (UCAID), 
the Internet2 project is not a single separate network, but rather joins member 
network application and engineering development efforts together with many 
advanced campus, regional, and national networks 
Internet Explorer  
An example of browser software that allows you to design a home page and 
to browse links on the WWW.  
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Internet Protocol(IP)  
The international standard for addressing and sending data via the Internet.  
Interoperability  
The ability of software and hardware on different machines from different 
vendors to share data.  
Intranet  
A private version of the Internet that lets people within an organization 
exchange data by using popular Internet tools, such as browsers.  
I/O Room ( Input/Output )  
Computer Operation's I/O Room is an area within IS located in the 
Administration Building, Room 112. They provide the following services: 
report distribution, data entry services, test scoring/scanning services, tape/ 
cartridge library services, shipping and receiving services, receptionist 
functions.  
IP Address  
An identifier for a computer or device on a TCP/IP network. Networks using 
the TCP/IP protocol route messages based on the IP address of the 
destination. The format of an IP address is a 32-bit numeric address written 
as four numbers separated by periods. Each number can be zero to 255. For 
example, 1.160.10.240 could be an IP address.  
ISDN (Intergrated Digital Services Network)  
A high-speed dialable, digital service available to most residences and 
businesses, offering much higher bandwidth than plain old telephone service 
when connecting to the Internet. ISDN lines come in two basic capabilities: 
128K bandwidth and 1472K bandwidth.  
ISIR  
Information Systems Impact Report- electronic messages sent to all IS staff 
and other relevant university personnel. Reports any pertinent problems that 
affect our clients.  
ISP (Internet Service Provider)  
A network, commercial or otherwise, trough whih a client machine can 
connect to the Internet. For a monthly fee, the service provider gives you a 
software package, username, password and access phone number. Equipped 
with a modem, you can then log on to the Internet, browse the World Wide 
Web, and send and receive e-mail. The university offers a free service but 
also encourages faculty, staff, and students to take advantage of DialUM, a 
low-cost solution through campusCWIX. CWIX is the ISP for users of DialUM.  
IT Strategic Plan  
A supplement to the university's strategic plan. Its goal is to "Take the lead in 
using computing and telecommunications in higher education and the 
community." It sets forth general guidelines, strategies, goals, and objectives 
for the operation of the Division of Information Systems (IS), the technological 
elements of the University Libraries, Extended Education, and the other 
academic and administrative units of the university 
IVR  
Interactive Voice Response  
Java  
A programming language that has the distinction of being a cross-platform 
language, meaning that it can be used to write programs on any Java capable 
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operating system, such as Windows 95 or the Mac OS. Java is often used to 
add fancy additions to Web pages.  
JavaScript  
A scripting language, distinct from the Java programming language, that is 
embedded in HTML Web pages, allowing greater interactivity with the user 
than HTML alone is capable of.  
JPEG(Joint Photograhic Experts Group)  
A popular type of image file format for compression of images. Images on 
webpages are commonly stored in the  JPEG or GIF formats. Named after the 
group who developed the JPEG. 
Keyboard  
A device used to enter data into the CPU by means of typing. 
Lab Monitor  
IS personnel that supply help and support to clients for computer labs 
throughtout the U of M campus community.  
LAN (Local Area Network)  
Two or more local computers that are physically connected within one office 
or department that typically share printers, servers, and the ability to send e-
mail within the group.  
Latte  
A node of the VMS cluster available to faculty, staff, and students. Menu 
system offers e-mail, text-based Internet access, McWherter Library catalog 
access, and other services. Programming packages and editors are also 
available. Access to disk space for personal WWW pages. This node is a 
Digital OpenVMS V6.2 AlphaServer 2100: LDAP (Lightweight Directory 
Access Protocol)  
A way to access information directories. The university's LDAP server is 
ds.memphis.edu. When properly configured with information about the LDAP 
server, Netscape's address book can let you search the university's LDAP 
directory and quickly address e-mails or add users into the address book:  
libaccess.memphis.edu  
The university's proxy server which allows authenticated users (people who 
have entered their user name and PH password) to access materials which 
otherwise can only be accessed by machines that have an on-campus IP 
address. Anyone using an ISP other than the university's modem pool needs 
to configure their browser with proxy information in order to access the 
library's electronic databases:  
Link  
Image, icon, or on-screen text(usually colored and underlined) that when you 
click on it, leads from one page to another on the World Wide Web.  
Listserv  
A e-mail program that allows multiple computer users to connect onto a single 
system, creating an on-line discussion.  
Load time  
The amount of time it takes a user to retrieve a Web page and view it in a 
browser on their computer.  
Localtalk  
A local area network standard used by Macintosh computers.  
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LSP (Local Service Provider)  
The primary contact for computing support and technology issues for an 
individual college or department. The LSP is an employee of that college or 
department. All trouble reports or service requests should go through the 
Information Systems Helpdesk. The report is then forwarded to the 
appropriate LSP for resolution:  
Lurk  
To read, without posting, message to a news group or a discussion list. 
Recommended behavior for people new to a list or group.  
Lynx  
A non-graphical browser for UNIX and DOS systems. It is available from the 
VMS cluster (select Internet Resources and World Wide Web)  
Mac OS  
The operating system used by the Apple Macintosh computer. The current 
version is 8.1. 
Macintosh  
A brand of personal computers manufactured by Apple Computer. Most users 
on campus use IBM-compatible machines (also called PCs). However, 
Macintosh is the preferred platform for several departments (e.g., English, Art, 
and Nursing).  
Macro  
A series of commands recorded and later carried out at the request of the 
user, used primarily to automate repetitive tasks. Unfortunately, macros also 
can serve as carriers and transmitters of computer viruses.  
Magnetic Disk  
A secondary mass storage medium that stores information on rotating disks 
coated with a substance that can be magnetized.  
Mailing List  
Allows people to join a group that sends and receives e-mail on a given topic. 
Members receive every message that is posted to the group.  
Mathematica  
An interactive system for doing mathematical computation. It handles 
numeric, symbolic, and graphical calculations and incorporates a high-level 
programming language. Mathematica reads lines of input, waiting until a 
syntactically complete expression has been entered, then evaluates the 
expression and prints the result. Mathematica is accessed from the VMS 
cluster. It is also available for a Windows environment. The university has a 
site license for Mathematica, and consulting is available. 
Menu  
A on-screen display that lists available choices.  
Merlot  
Is a collection of high quality interactive online learning materials, 
assignments, reviews, and people.  
Microsoft Access  
Microsoft's relational database software. A part of Microsoft Office 
Professional, it is a technology standard at the university and it is included in 
the Microsoft Campus Agreement. The current version for the PC is Access 
97. There is no version for the Macintosh. 
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Microsoft Campus Agreement  
An agreement between The University of Memphis and Microsoft which 
allows faculty and staff to use a number of Microsoft products on their office 
and home computer. 
Microsoft Excel  
Microsoft's spreadsheet software. A part of Microsoft Office Professional, it is 
a technology standard at the university and it is included in the Microsoft 
Campus Agreement. The current version for the PC is Excel 97. The current 
version for the Macintosh is Excel 98. 
Microsoft FrontPage  
Microsoft's HTML authoring software. It is not the technology standard at the 
university; however, it is included in the Microsoft Campus Agreement. The 
current version for the PC is FrontPage 98. The current version for the 
Macintosh is Frontpage 1.0. 
Microsoft Outlook  
Microsoft's calendaring and e-mail software. It is not the technology standard 
at the university; however, it is included in the Microsoft Campus Agreement. 
The current version for the PC is Outlook 97. The comparable product for the 
Macintosh is Exchange Client. 
Microsoft PowerPoint  
Microsoft's presentation software. A part of Microsoft Office Professional, it is 
a technology standard at the university and it is included in the Microsoft 
Campus Agreement. The current version for the PC is PowerPoint 97. The 
current version for the Macintosh is PowerPoint 98. 
Microsoft Project  
Microsoft's project management software. It is not included in Microsoft 
Campus Agreement and it is not a technology standard. 
Microsoft Publisher  
Microsoft's tool to help small businesses create professional-looking 
publications, including newsletters, fliers, web pages and brochures. It is part 
of Microsoft Office - Small Business Edition. It is not the desktop publishing 
software standard for the university. 
Microsoft VisualStudio  
Microsoft's suite of development tools - Microsoft Visual Studio: Visual Basic 
6.0, Visual C++ 6.0, Visual J++ 6.0, Visual InterDev 6.0, and Visual FoxPro 
6.0. It is not a technology standard at the university; however, it is included in 
the Microsoft Campus Agreement.  
Microsoft Windows  
A family of operating systems for personal computers. It is supported as a 
technology standard. Installations on university-owned machines are included 
in the Microsoft Campus Agreement. Like the Macintosh operating 
environment, Windows provides a graphical user interface (GUI), virtual 
memory management, multitasking, and support for many peripheral devices. 
In addition to Windows 3.x and Windows 95, which run on Intel -based 
machines, Microsoft also sells Windows NT, a more advanced operating 
system that runs on a variety of hardware platforms. 
Microsoft Word  
Microsoft's word processing software. A part of Microsoft Office Professional, 
it is a technology standard at the university and it is included in the Microsoft 
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Campus Agreement. The current version for the PC is Word 97. The current 
version for the Macintosh is Word 98. 
MIDI (Musical Instrument Digital Interface)  
The standard protocol between musical instruments and computers.  
Mocha  
A node of the VMS cluster available to faculty, staff, and students. Menu 
system offers e-mail, text-based Internet access, McWherter Library catalog 
access, and other services. Programming packages and editors are also 
available. Access to disk space for personal WWW pages. This node is a 
Digital OpenVMS V6.2 AlphaServer 2100. 
Modem  
A piece of equipment that allows computers to interact with each other via 
telephone lines by converting digital information from a computer to analog 
information that can be sent over telephone lines.  
Modem Pool  
For those who do not wish to use DialUM, the University maintains a small 
modem pool for remote access.  

96 28.8 modem lines for use by Students, Faculty, and Staff. Dial 678-3600.  
28 14.4 modem lines for use by Faculty and Staff only. Dial 678-4600. 

Mosaic  
The first graphical browser. Developed by the NCSA, this browser helped 
fueled the growth of the Web, but was later eclipsed by Netscape and Internet 
Explorer. It is still available in versions for Windows, Mac, and Unix.  
MPEG (Motion Picture Experts Group)  
A standard  file format for motion video on computers.  
Multimedia  
Applications that use graphics, video, and audio in addition to text.  
mx.memphis.edu  
The name of the outgoing mail server (SMTP) for most university e-mail 
accounts. Unless your LSP has told you otherwise, your Netscape mail 
settings must specify mx.memphis.edu as the outgoing mail server. Any other 
entry will cause your e-mail to be undeliverable.  
NLII  
Its mission is to create new collegiate learning environments that harness the 
power of information technology to improve the quality of teaching and 
learning, contain or reduce rising costs, and provide greater access to 
American higher education. EDUCAUSE's role is to serve as a catalyst to 
bring together the affected parties to create joint solutions to the problems 
inhibiting the creation of a National Learning Infrastructure. 
.net  
A type of Internet domain assigned to network organizations.  
Netiquette  
Network etiquette- a proper way to behave on the Internet.  
NetMeeting  
Proprietary software that allows participants to communicate synchronously 
via the computer and to view the same file while doing so. It is used in IWU's 
online MBA courses for class discussions and group project accomplishment. 
Software is available from Microsoft, via the Internet, at no cost.  
Netscape Calendar  
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A scheduling collaboration tool used by U of M faculty and staff members. 
Faculty or staff interested in acquiring a calendar account should contact their 
Local Service Provider. 
Netscape or Netscape Navigator  
An example of browser software that allows you to design a home page and 
to browse links on the WWW.  
Netscape Communicator  
A suite of internet communication tools (Navigator, Messenger, Composer, 
and Calendar). It is currently free. It is the university's standard. 
Netscape Composer  
An HTML authoring software which allows you to create and upload web 
pages without knowing HTML.  
Netscape Messenger  
An e-mail client software that can be configured so that you can read your 
university e-mail. 
Netscape Messenger Express (not included in Communicator but another 
Netscape product)  
The U of M's Web-based e-mail express systems designed to access your u 
of M e-mail account from off campus. There are actually two systems:  
        1. Postoffice users 
        2. VMS cluster users 
It is currently free and is the university's standard.  
Netscape Navigator  
A popular commercial graphical browser. It is the university's technology 
standard: Network  
A series of points connected by communication channels in different 
locations.  
Network Places  
Network Places displays all of the shared computers, printers, and other 
resources on the network to which your  
computer is connected. You can use the Add Network Place wizard to create 
shortcuts to network, Web, and FTP  
servers.  
Network Services  
A department of Information Systems that has the task of keeping the 
University's voice, data, and video networks running and secure. 
Telecommunications is part of Network Services/ 
Newsgroup  
An electronic bulletin board that facilitates communication.  
Node  

• In networks, a processing location. A node can be a computer or some other device, 
such as a printer. Every node has a unique network address, sometimes called a 
DataLink Control (DLC) address or Media Access Control (MAC) adress.  

• In tree structures, a point where two or more lines meet.  
Non-graphical browser  
A program used to view HTML documents and navigate the World Wide Web. 
Non-graphical browsers do not display inline images and do not display 
formatted text. An example is Lynx.  
Non-linear document  
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A type of organization for HTML documents in which one HTML file contains 
links to more than one other HTML file. The person browsing the files 
determines the order in which the information is presented.  
nsweb.memphis.edu  
A web server that contains information about IS Network Services:  
OCR  
Optical character recognition refers to the branch of computer science that 
involves reading text from paper and translating the images into a form that 
the computer can manipulate (for example, into ASCII codes). An OCR 
system enables you to take a book or a magazine article, feed it directly into 
an electronic computer file, and then edit the file using a word processor. 
OCR software is available for faculty use in the Faculty Resource Center. 
Opeartions  
A division within IS that includes Computer Operations, Technical Support 
and Database Administration. Services provided include: cluster availability, 
centralized printing services, report distribution, data entry services, test 
scoring/scanning services, file backup and restore services and administartive 
form creation and maintenance.  
Operating system  
A master control program for a computer. Examples are DOS, UNIX, and the 
MacOS.(Technically speaking, Microsoft Windows 3.x is an operating 
environment as it still requires the separate DOS operating system to run. 
Microsoft's Windows95 is a true operating system as DOS is built-in to it.)  
.org  
A type of Internet domain assigned to organization,usually nonprofit. 
Path Name  
The place where a file is stored on a computer program for a computer, 
indicated by the drive or volume name and the subdirectories needed to find 
the file.  
PC  
Personal computer. Generally refers to an IBM-compatible computer.  
PDF  
Portable Document Format, a file format developed by Adobe Systems. PDF 
captures formatting information from a variety of desktop publishing 
applications, making it possible to send formatted documents and have them 
appear on the recipient's monitor or printer as they were intended. To view a 
file in PDF format, you need Adobe Acrobat Reader, a free application 
distributed by Adobe Systems.  
Peripherals  
System hardware devices such as monitors, modems, network cards, sound 
cards, graphics cards and CD-ROM drives.  
Ph  
The Ph database can be used to look up information on faculty, staff, and 
students at the University of Memphis. You can access Ph through your VAX 
account. 
Ph Password  
Password for an entry in the Ph (phonebook) database. The Ph database is 
used to authenticate users trying to make a dialup connection to the UofM 
dialup server. It is also used for authentication with Postoffice e-mail 
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accounts, Campus Pipeline, Netscape Calendar accounts, the library's proxy 
server, and CBT access. 
Post  
To place an HTML file on the Web server to make it available for browsing.  
postoffice.memphis.edu  
The university's Netscape mail server. 
Preference Setting  
Program options in browsers that allow the user to determine such things as 
which fonts are used for various HTML styles, whether or not inline images 
are displayed, what other applications are used to view movies, and so on.  
Presentation Software  
Software that simplifies the process of creating a visual presentation. 
Microsoft PowerPoint is the presentation standard at UofM.  
ProfWeb  
Another facility that includes the Faculty Resource Center.  
Protocol  
A formal set of standars, rules, or formats for exchanging data that assures 
uniformity between computers and applications.  
Proxy Server  
A server that sits between a client application, such as a Web browser, and a 
real server. It intercepts all requests to the real server to see if it can fulfill the 
requests itself. If not, it forwards the request to the real server. The UofM 
operates a proxy server that enables users using other ISPs (such as 
Compuserv or AOL) to access web pages which otherwise would only be 
available from computers with an on-campus IP address. The university's 
proxy server is ds.memphis.edu. 
RAM (Random Access Memory)  
The computer's primary working memory in which program instructions and 
data are stored.  
Relational Database  
A type of database management system (DBMS) that stores data in the form 
of related tables. Relational databases are powerful because they require few 
assumptions about how data is related or how it will be extracted from the 
database. As a result, the same database can be viewed in many different 
ways. At the UofM, Access is the standard relational database for the PC and 
Filemaker Pro is the standard relational database for the Mac.  
Relative Path  
Relative paths spell out the location of the file based on the current document 
location.  
Resolution  
Refers to the sharpness and clarity of an image. The term is most often used 
to describe monitors, printers, and bit-mapped graphic images. In the case of 
dot-matrix and laser printers, the resolution indicates the number of dots per 
inch. For example, a 300-dpi (dots per inch) printer is one that is capable of 
printing 300 distinct dots in a line 1inch long. This means it can print 90,000 
dots per square inch. The higher the number of dots per inch, the more clarity 
of the image on the screen.  
RGB Monitors  
Short for red, green, blue monitor, a monitor that requires separate signals for 
each of the three colors. This differs from color televisions, for example, which 
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use composite video signals, in which all the colors are mixed together. All 
color computer monitors are RGB monitors.  
Root Domains  
The main domain names assigned by the root domain of the Internet. The 
main root domains in the U.S. are .com, .edu, .gov, .mil, .org, and .us. The 
other root domains are the two-letter country codes, such as .ca (for Canada) 
and .jp (for Japan).  
Router  
A device connecting a LAN to the Internet that routes transmissions between 
the two. 
SAS  
A family of software that provides the tools, procedures and commands for 
comprehensive statistical and data analysis.  The SAS command language is 
easy to use for simple problems, yet flexible and powerful enough for complex 
applications. SAS is available on the VMS cluster. The university also owns a 
site license for SAS for Windows. Consulting is available. 
Scanner  
A device that can read text or illustrations printed on paper and translate the 
information into a form the computer can use. A scanner works by digitizing 
an image -- dividing it into a grid of boxes and representing each box with 
either a zero or a one, depending on whether the box is filled in. Scanners are 
available in SM112 and the McWherter Library lab. A scanner is available in 
the FRC (SM416) for faculty use.  
SCT  
System & Computer Technology- The Tennessee Board of Regents' 
approved company that supplies administrative software to the University.  
SDRAM  
Short for Synchronous DRAM, a new type of DRAM that can run at much 
higher clock speeds than conventional memory. SDRAM actually 
synchronizes itself with the CPU's bus and is capable of running at 133 MHz.  
Searchable Index  
Indexes of World Wide Web documents that you can submit a query to and 
the Index will search to find pages matching your specification.  
Search Engines  
An automated Web site that uses advanced searching software to locate 
other Web sites and Internet files based on search criteria entered by the 
user. Examples of such sites include AltaVista, Infoseek, Lycos, Yahoo! and 
HotBot, though there are many others. The software relies on Boolean logic to 
deliver search results based on the occurence of words or search terms 
entered by the user.  
Server  
A computer with a special service function on a network, generally receiving 
and connecting incoming information traffic. It manages the network 
resources. For example, a file server is a computer and storage device 
dedicated to storing files. Any user on the network can store files on the 
server. A print server is a computer that manages one or more printers, and a 
network server is a computer that manages network traffic. A database server 
is a computer system that processes database queries. Most servers on 
campus are maintained by IS. However, departmental servers are maintained 
by Local Service Providers.  



Internet and its Services 

 

119

 
 

SGML  
Abbreviation of Standard Generalized Markup Language, a system for 
organizing and tagging elements of a document. SGML was developed and 
standardized by the International Organization for Standards (ISO) in  1986. 
SGML itself does not specify any particular formatting; rather, it specifies the 
rules for tagging elements. These tags can then be interpreted to format 
elements in different ways. Because it is a large and complex system, it is not 
yet widely used on personal computers. However, the growth of Internet, and 
especially the World Wide Web, is creating renewed interest in SGML 
because the World Wide Web uses HTML, which is one way of defining and 
interpreting tags according to SGML rules.  
Shareware  
Software that you can obtain for free (often by downloading from the Internet) 
on a trial basis but that may require some payment or registration for 
continued use.  
Shortcut  
An icon that contains a direct route to a special object; an arrow located in the 
lower-left corner of the icon can identify the icon.  
SIS  
Sudent Information Services. One of the databases on the administrative 
nodes of the VMS cluster, it is only available to approved faculty and staff. 
SmartBoard  
A brand of interactive whiteboard used at the UofM. It can be used as a 
whiteboard or as a projection screen. However, it has additional capabilities. 
Professors can project the computer image onto the Smartboard and then use 
their finger to follow hyperlinks in the computer file. They can use 
SmartMarkers to add comments to the image. Images can be printed or saved 
as web documents. 
Smart Classroom  
The university's term for a classroom that has an instructor computer, a 
projection system, other equipment, and computers for students. 
Smart Lecture Hall  
The university's term for a large classroom that has an instructor computer, a 
projection system, other equipment, but no computers for students. 
Sound Card  
Hardware used to play sound files on computers.  
Spam  
Unrequested e-mail sent to many recipients.  
Spreadsheet Software  
Computer programs that let you create and manipulate spreadsheets 
electronically. A spreadsheet is a table of values arranged in rows and 
columns. In a spreadsheet application, each value sits in a cell. You can 
define what type of data is in each cell and how different cells depend on one 
another. The relationships between cells are called formulas, and the names 
of the cells are called labels. Microsoft Excel is the university's standard for 
both the PC and the Mac.  
SPSS  
A family of software that provides the tools, procedures and commands for 
comprehensive statistical and data analysis. SPSS is available on the VMS 



 120  Computer Skills for Biologists  

 
 

cluster. The university also owns a site license for SPSS for Windows. 
Consulting is available. 
SSL (Secure Sockets Layer)  
The leading security protocol for the Internet, developed by Netscape. When a 
user navigates to a secure site on the Web, his or her broowser sends its 
public key to the site so the site's server can securely send a secret key to the 
browser. The browser and server are then able to exchange data using secret 
key encryption. SSL has been combined with other protocols and 
authentication methods into a new protocol known as Transport Layer 
Security.  
Standards  
Also called technology standards. Software and hardware which have been 
selected to receive support at the university. Standard Level 1 software are 
the softwares for which training and support are available. Level 2 softwares 
have limited support. Level 3 softwares are acceptable for individual use. 
Level 4 softwares are unacceptable. 
 Streaming  
Playing video or sound in real time as it is downloaded over the Internet. Data 
is decompressed and played (by use of a web browser plug-in) as it is 
transferred to your computer over the WWW. Streaming requires a powerful 
computer and fast connection since the file is not stored on your computer.  
Stripes  
Student Telephone Registration Information Procession Exchange - Avaialble 
at 901-324-7000, provides registration functions from any touch tone 
telephone.  
Submit  
To send a completed form to a Web server.  
Surfing  
Exploring the Internet without a definite goal in mind, but ready to investigate 
anything interesting that happens to come along.  
Symantec Anti-Virus  
The university's technology standard for anti-virus software. 
Synchronous  
Communication in which interaction between participants is simultaneous. 
T-1(DS-1)  
A high-speed dedicated connection to the Internet which is a digital data 
channel that is a high volume carrier of voice and/or data. It provides data 
transmission rates of 1.5 MB per second. Often compressed video 
teleconferencing T-1 has 24 voice channels.  
T-3(DS-3)  
A digital channel that communicates at a significantly faster rate than T-1.  
TAF  
Technology Access Fee. This component of the General Access Fee is 
included in the Maintenance Fee which is paid by each student based on the 
course level and the number of hours enrolled. This fee provides certain 
services for all students. It is administered by IS, in conjunction with the 
Provost's office. 
 TAF Grants  
Grants awarded to recipients selected by the IT Academic Advisory 
Committee. These grants are funded through TAF. 
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Tag  
The HTML codes used to specify text styles, links, graphics, and other HTML 
elements.  
Technical Support  
A department of IS which works with Network Services to manage central 
computing resources (including OpenVMS, UNIX, Windows NT, and NetWare 
platforms). It also coordinates networking protocols in use on campus 
(including TCP/IP, DECnet, LAT, IPX, and others). 
Technology Standards  
Software and hardware which have been selected to receive support at the 
university. Standard Level 1 software are the softwares for which training and 
support are available. Level 2 softwares have limited support. Level 3 
softwares are acceptable for individual use. Level 4 softwares are 
unacceptable. 
Tegrity  
Developer of the EduCarts.. 
Telecommunication  
The science of information transport using wire, radio, optical or 
electromagnetic channels to transmit and receive signals for voice or data 
communications using electrical means.  
Telnet  
 Is an Internet protocol that allows a local (or client) user to log on to a remote 
server or host as if it were just another terminal to that server (terminal 
emulation).  
Terminal Emulation Software  
Terminal emulation programs allow  you to access a mainframe computer or 
bulletin board  service with a personal computer. On the PC platform, 
QVTTerm is used at the university. On the Mac platform, Better Telnet is 
used.  
Text Fields  
Form elements that allow users to insert a single line text.  
Tiger-LAN  
A network of computer labs which provide access to software, hardware, and 
information for University of Memphis faculty and students. Tiger-LAN 
includes software for Windows 3.1 and Macintosh, such as: word-processing, 
spreadsheet, database, publication/presentation, internet, and statistical 
software.  
TigerLine  
A code provided for Universit of Memphis employees to use for making long 
distance calls and tracking for billing purpose.  
TigerWeb  
Provides registration functions over the web.  
Title  
The HTML tag used to give each HTML document a title.  
TLT Group  
The TLT Group's mission is to motivate and enable institutions and individuals 
to improve teaching and learning with technology, while helping them cope 
with continual change. The TLT Group's products and services support 
individuals and organizations in their efforts to understand, envision, and 
direct the transformation of education and society. Begun in 1995 as AAHE's 
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Technology Projects, the TLT Group is now an independent, nonprofit 
organization affiliated with AAHE. Transmission Line  
The physical connection from your computer to the Internet such as a 
telephone line or a T1.  
Transparent Graphics  
Graphic images that have a clear background, which makes the graphic 
appear to float in the browser screen.  
Trojan Horse  
A program that appears valid, but when activated performs unauthorized 
activity. Such a program can be used to locate a person's password, or make 
a computer vulnerable to future illicit entry. A Trojan horse can also simply 
destroy programs or data on the person's computer. A Trojan horse is similar 
to a virus, except that it does not replicate itself. 
UM Virtual  
The nickname of a web server that is available to TAF grant recipients: 
umvirtual2.memphis.edu  
Also known as http://cbt.memphis.edu, the web server that serves up over 
250 free computer-based training titles to UofM faculty, staff, and students.  
Universal UserID (UUID)  
The Universal UserID is a common username shared among the VMS cluster, 
Tiger-LAN, and Ph directory at The University of Memphis, as well as certain 
other systems. 
UNIX  
An operating system used on a variety of computers from personal computers 
to mainframe. Many computers and servers connected to the Internet use 
UNIX.  
upload  
To transfer a file from your computer to an FTP, gopher or World Wide Web 
site. For example, if you use a personal computer to log on to a network and 
you want to send files across the network, you must upload the files from your 
PC to the network.  
URL (Uniform Resource Locator)  
The standard used to identify files on the Internet and World Wide Web using 
the type of server, the host name of the computer the file is on, and the 
complete path to the file i.e. an address on the WWW. For example the URL 
for Indiana Wesleyan University is http://www.indwes.edu/.  
USENET  
A distributed electronic bulletin board system that allows users to post and 
read articles thereon. It is international in scope and is probably the largest 
decentralized information utility in existence. Newsgroups, postings on 
Usenet, provide a mechanism for class collaboration and communication.  
USENET newsgroups  
Discussion groups devoted to talking about specific topics.  
USR  
User Service Request- Request to process production jobs, (batch jobs) for 
university administrative users. 
VAX  
Virtual Address Extension. It's a machine that supports VMS. Consists of 
numerous tasks such as e-mail, ftp, telnet, Gopher, Lynx or text based 
internet access, McWherter Library catalog access, programming packages, 
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editors and more.(Also referred to mistakenly with VMS). Access to disk 
space for personal webpages (LATTE). This node is a Digital OpenVMS V6.2 
AlphaServer 2100.  
Ventana  
Maker of a groupware software in use in the College of Business. 
GroupSystems is a suite of team-based, decision support software tools that 
shorten the cycle time for strategic planning, product development, problem 
solving, and other business processes.  
Video Conferencing  
Conducting a conference between two or more participants at different sites 
by using computer networks to transmit audio and video data. For example, a 
point-to-point (two-person) video conferencing system works much like a 
video telephone. Each participant has a video camera, microphone, and 
speakers mounted on his or her computer. As the two participants speak to 
one another, their voices are carried over the network and delivered to the 
other's speakers, and whatever images appear in front of the video camera 
appear in a window on the other participant's monitor. Video conferencing 
using NetMeeting can be set up by special request in SM110 or SM414: 
Video Player  
Hardware used to play movie files on computers, such as QuickTime.  
Video visualizer  
Also called a visual presenter or document camera. This equipment offers the 
functionality of an overhead projector but also allows you to display 
nontransparent objects. Several classrooms on campus have document 
cameras  
Virtual  
Not real. The term virtual is used in a wide variety of situations. For example, 
virtual learning might refer to learning at a distance and not in the traditional 
classroom.  
Virus  
A program or piece of code that is loaded onto your computer without your 
knowledge and runs against your wishes. Most viruses can also replicate 
themselves. All computer viruses are manmade. A simple virus that can make 
a copy of itself over and over again is relatively easy to produce. Even such a 
simple virus is dangerous because it will quickly use all available memory and 
bring the system to a halt. An even more dangerous type of virus is one 
capable of transmitting itself across networks and bypassing security systems. 
IS recommends the use of Symantec's Norton Anti-Virus. 
Visual Presenter  
Also called a document camera or a video visualizer. This equipment offers 
the functionality of an overhead projector but also allows you to display 
nontransparent objects. Several classrooms on campus have document 
cameras.  
VMS Cluster  
VMS stands for Virtual Memory System. It is the operating system used to 
communicate with the mainframe computers which serve as the central 
academic and administrative systems at the University of Memphis. There are 
five mainframe computers in the university's VMS cluster, ADMIN1, ADMIN2, 
ADMIN3, MOCHA, and LATTE. 
 



 124  Computer Skills for Biologists  

 
 

WAV  
A popular sound file format used primarily by Windows-based computers.  
WebBoard  
Proprietary software that allows participants to communicate either 
synchronously or asynchronously via the computer. IWU purchased the 
software and integrated it in all their online courses for class discussions.  
WebLearner  
Please see EduCart.  
Web Server  
The hardware and software used to store and deliver HTML documents for 
use on the World Wide Web.  
Web Site  
A person or company's collection of HTML documents on the Web server. A 
single Web server may contain one or more Web sites.  
Whiteboard  
An area on a display screen that multiple users can  write or draw on. 
Whiteboards are a principal component of teleconferencing applications 
because they enable visual as well as audio communication.  
Windows  
An operating system for the IBM PC-compatible platform that allows multiple 
programs to run at once and utilizes icons and menus for program control.  
Windows NT  
A version of Windows specially designed for use on networked computers.  
Word Processor  
A program used to create and edit text documents, such as Microsoft Word or 
Corel WordPerfect.  
World Wide Web (WWW)  
A graphical hypertext-based Internet tool that provides access to home pages 
created by induviduals, business and other organizations.  
WS-FTP  
The FTP software which is the standard for PC-users at the university. It is 
free to educational institutions.  
XML  
Abbreviation for eXtensible Markup Language, a specification developed by 
the W3C. XML is a pared-down version  of SGML, designed especially for 
Web documents. It allows designers to create their own customized tags, 
enabling the definition, transmission, validation, and interpretation of data 
between applications and between organizations. Whether XML eventually 
supplants HTML as the standard Web formatting specification depends a lot 
on whether it is supported by future Web browsers. Microsoft Internet Explorer 
version 5 handles XML, but renders it as CSS, and Netscape (Mozilla) is still 
in experimenting with XML support. 
Y2K  
Year 2000 problem or bug which does not differentiate between 20th century 
and 21st century dates. Affecting primarily spreadsheets and databases, this 
problem can in most cases be fixed.  
 

 


